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1. Purpose of the document
This manual contains information on the implementation of the data collection phase
for aerial triangulation workflow.

Aerial triangulation includes interior orientation of block images, measurement of tie
points coordinates on images, relative orientation of block images, as well as input of
ground control points (GCP) coordinates to catalogue and measurement of these points
coordinates images or their import and using exterior orientation data.

After data collection to form a block for aerial triangulation the block adjustment is per-
formed (see the “Block adjustment” User Manual). The ultimate goal of work on aerial
triangulation and block adjustment is defining of exterior orientation parameters, that
allow to proceed to block processing step, which includes stereo vectorization, creation
of DEM, orthomosaic and 3D models (see the “Vectorization” User Manual).

Exterior orientation parameters of image are geometric parameters of image, that specify its
position and orientation in relation to object of photogrammetric survey in a moment of the survey.
There are linear and angular exterior orientation parameters of image.

Linear exterior orientation parameters of image – coordinates of center of optical image projection
in coordinate system of photogrammetric survey object.

Angular exterior orientation parameters of image – parameters that define image angular orient-
ation in coordinate system of photogrammetric survey object, slope and rotation angles of image.

2. Aerial triangulation data

2.1. The “Orientation” menu

To perform work on data collection for aerial triangulation serves theOrientationmenu,
and also buttons of the main toolbar and of the AT additional toolbar.

Table 1. Brief description of the “Orientation” menu

FunctionsButtons
allows to input/edit parameters of project cameras,
and also to assign cameras to project images (see
the Section 4.3)

Manage projects cameras (Ctrl+Alt+I)

contains menu items used to perform interior orient-
ation of central projection images (see the Sec-
tion 4.1)

Interior orientation

contains menu items used to perform quick ties in
order to use the data for block layout creation (see
the Section 3.4)

Quick Ties

allows to open catalogue of all measured triangula-
tion points (GCP, check, tie) with their measure-
ments (see the Section 6.2)

Tie points list (Ctrl+Alt+T)
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FunctionsButtons
allows to open catalogue of all ground control points,
including non-measured on block images (see the
Section 7.3)

GCP list (Ctrl+Alt+G)

allows to choose types of triangulation points to be
deleted and delete them

Delete point measurements

allows to remove the whole list of triangulation points
(GCP, check, tie) from triangulation points catalogue

Clear point catalogue

allows to measure tie points coordinates in automat-
ic mode (see the Section 6.3)

Automatic tie points measurements
(Ctrl+Alt+A)

allows to open the report with results of images rel-
ative orientation in order to perform analysis and

Report on relative orientation (Ctrl+Alt+R)

removal of errors in tie points measurements (see
the Section 6.9)
allows to loadmeasured coordinates of triangulation
points to 2D-window with possibility to setup of dis-
play of certain type of points (see the Section 8.3)

Load triangulation points

allows to measure tie points coordinates in automat-
ic mode for UAS images (see the UAS data pro-
cessing User Manual)

Automatic UAS triangulation

allows to open the Points measurement module
used tomeasure points coordinates in manual mode
on images selected in 2D-window

Open selected images for measurements

allows to open the Points measurement module
used tomeasure points coordinates in manual mode

Open images containing marker (Ctrl+Alt+K)

on images, that contain marker position in 2D-win-
dow
allows to open the Points measurement module
used tomeasure points coordinates in manual mode
on selected in-strip stereopair in 2D-window

Open in-strip stereopair

allows to open the Points measurement module
used tomeasure points coordinates in manual mode
on selected in 2D-window inter-strip stereopair

Open inter-strip stereopair

allows to open the Exterior orientation data listExterior orientation data list
allows to load projection centers data as vector point
objects and to open them in 2D-window to perform

Load projection centers as vectors

analysis, at that an image name is saved to the Name
point attribute
allows to select part of block images to perform ad-
justment

Select subblock

allows to show the Adjustment toolbar, which is
used to perform adjustment, to view its results and

Block adjustment (Ctrl+Alt+S)

errors correction (see the “Block adjustment” User
Manual)
allows to specify adjustment parameters and to
perform block adjustment without using the the Ad-

Adjustment in batch mode

justment toolbar (see the “Block adjustment” User
Manual)
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FunctionsButtons
allows to perform adjustment using imported exterior
orientation parameters

Direct georeferecing

allows to delete adjustment data (see the “Block
adjustment” User Manual)

Delete adjustment results

allows to perform import of exterior orientation res-
ults

Import exterior orientation

allows to perform import metadata to a projectImport orientation from metadata
allows to perform export of georeference data after
preliminary block exterior orientation and adjustment

Create images georeferencing files

(to files of ArcInfo World File and MapInfo TAB
formats)
contains menu items used to import of triangulation
points measurements from files of PAT-B, X-Points

Import

formats from PHOTOMOD 4.x (XPT) projects, as
well as data import from flight path file
contains menu items used to export of triangulation
points measurements to files of PAT-B and X-Points

Export

formats, and for export of ties or GCP for further
use them in Geomosaic module

2.2. Source data

In order to create and adjust photogrammetric network the following source data is
used:

• data acquired on step of network creation - aerial triangulation:

○ parameters of interior orientation – data that specify position and orientation of
coordinate system of each block image in relation to coordinate system of digital
image; set of surveying camera parameters, that includes coordinates of image
principal point, camera focal length and objective distortion, defined during camera
calibration and used for interior orientation. Interior orientation parameters of images
allow to find out a position of projection center in relation to image, in other words
to restore set of projecting beams (using method of pyramid), existed in a moment
of photographing.

It is necessary to perform interior orientation for central projection images acquired by film
or digital camera. Interior orientation of scanner images – space borne images or ADS
40(80) data – are not available in the system, since those images are delivered along with
metadata files which contain interior orientation parameters (see information about types
of data/projects in the “Project creation” User Manual).

○ parameters of relative orientation – data of relative orientation acquired after
measurement of in-strip and inter-strip tie points coordinates on block images;
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○ results of measurements of ground control points (GCP) coordinates on block im-
ages (see the Section 7.1).

• data of interior and/or exterior orientation obtained from the data provider;

Delivery set of central projection images may include exterior orientation parameters, calcu-
lated by on-board GPS/IMU systems, or metadata with exterior orientation parameters for
UltraCam camera. For space borne scanner images – metadata with interior/exterior orient-
ation parameters or RPC-coefficients. For ADS 40(80) images – also metadata with interi-
or/exterior orientation parameters.

If high precision exterior orientation parameters are available for central projection images it
is possible to exclude steps of measurement of tie and GCP coordinates, as well as block
adjustment step and to proceed to project processing right away (see the “Vectorization” and
“DEM” User Manuals). In this case on a step of data collection for aerial triangulation it is
necessary to perform exterior orientation parameters import, and then perform adjustment
using imported data (see the Section 7.8).

• auxiliary data: overlap size of block images, quick ties data, ground sample distance
(GSD) or data about elevation difference on terrain.

Main and additional data for aerial triangulation is used to create block layout, that is
used for visual control of block scheme during the data collection. Created block layout
may be considered for initial adjustment (see the “Block adjustment User Manual).

Block layout – approximate scheme of terrain, obtained using projecting of matched images of
a block on specified surface (Earth surface) considering images overlaps, relative position, ro-
tation by angles in a space.

2.3. Aerial triangulation workflow

This chapter contains recommended aerial triangulation workflow, depending on available
source data.

During all steps of aerial triangulation procedure it is recommended to perform data
accuracy control (see the Section 2.4).
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Fig. 1. Aerial triangulation workflow

2.4. Data quality control

The system provides the following tools to perform quality control of collected data for
aerial triangulation operation:

1. Project state report allows to estimate current state of the project in whole.
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Choose Project › Project state or click the button of the main toolbar. The
Project state window opens, which displays what kind of works was performed
and contains a toolbar which allows to perform/adjust results of each processing
step.

Buttons of the Project state window toolbar are the same as buttons of the AT additional
toolbar and some of them duplicate items of the Orientation menu.

Completed aerial triangulation is marked by the symbol, partly performed – ,
not performed – .

Fig. 2. Project state report

The Project state window shows a project state on the following processing steps:

• block forming – number of strips and images (see the “Project creation” User
Manual);

• interior orientation;

• relative orientation;

• exterior orientation (see the “Block adjustment” User Manual).

For refreshing data about project state after changes the Refresh button is used.

2. Interior orientation report.

3. Relative orientation report.

4. Block layout allows to perform visual control using block scheme, created considering
source or collected data for aerial triangulation: overlap areas size, quick ties data,
results of ties/GCP measurement, interior orientation data, etc.

3. Block layout

3.1. Data for block layout creation

Block layout – approximate terrain scheme (further on – block scheme), obtained by
coinciding images on adjacent overlapping areas.
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Depending on data set block layout is divided into primary, rough and final. With the
accumulation of information block scheme contains more accurate data than the initial
scheme. As a result, after a correctly performed adjustment block layout represents the
final form of block scheme.

Block layout is used for visual estimation of images position. Moreover, primary block
layout is an obligatory condition for automatic measurement of tie points coordinates.

For block layout creation it is necessary to have the following data available (the data
are listed in increasing order of block layout accuracy):

• size of images overlap areas in strip and between strips – this value is known or is
estimated using quick ties of the same points on terrain on block images. Size of
images overlap areas are used to create primary block layout;

• quick ties data, that are obtained using approximately specified points of terrain on
adjacent images of block scheme in 2D-window. Quick ties data is used to create
primary block layout and significantly refine block scheme created “by overlaps”;

• tie points coordinates are obtained using measurement of coordinates of the same
points on terrain on images with specified accuracy manually or in automatic mode;

Block layout accuracy depends on measurements accuracy and tie points number. For ex-
ample, for primary block layout it is enough to measure coordinates of coordinates of a small
number of tie points between images and use this data instead of quick ties data. With the
accumulation of “qualitatively measured” tie points coordinates a block layout accuracy in-
creases (see the Section 6.3, Section 6.4).

• GCP coordinates (if any) – are used to create block layout. As a result, block layout
created by GCP shows a block scheme in real coordinate system;

• exterior orientation results (if any) – are imported to a project and are used for block
layout creation;

block layout, created by exterior orientation parameters is a projection of images considering
real coordinates of projection centers and images rotation by interior orientation angles (see
the Section 7.8).

• adjustment results – are used as imported adjustment results or after performing of
block adjustment (if there are adjustment data enough). Block layout, created by ad-
justment results is a final kind of a block scheme (see the “Block adjustment” User
Manual);

• ground sample distance (GSD) (if any) – are specified manually or calculated auto-
matically using digital elevation model (DEM) data.
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GSD parameter influences on a size of images during block layout creation (see the Sec-
tion 3.3).

3.2. Block layout creation

To create block layout perform the following actions:

1. Collect data for block layout creation.

If exterior orientation parameters are available it is recommended to use first of all imported
data to create block layout. Creating block layout considering exterior orientation parameters
significantly reduces processing time during aerial triangulation step, and if the parameters
are quite accurate it is possible even to skip the step.

It is recommended to create block layout once more after adding new images to a project.

2. Choose Window › Block layout (Ctrl+Alt+L) or click the button of the main
toolbar. The Block layout window opens.

Fig. 3. Parameters of block layout creation

3. In the Mode section select one of three modes of block layout creation or choose
to skip block layout creation step:

• By ties – used to create block layout by tie point coordinates or by other data,
selected by checkboxes in the Block layout window;

• W/o layout – used to cancel block layout creation, returns a block scheme to its
initial state after images loading;

• By ext. or. – used to create block layout by imported exterior orientation paramet-
ers only, other data is out of scope.
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This mode allows just images scaling and DEM considering.

• By centers – used to create block layout by coordinates of images projection
centers and is intended for creation of UAS images block scheme.

This mode allows just images scaling and DEM considering.

As other data is accumulated and becomes available, a block layout, created by projection
centers coordinates is automatically adjusting using theBlock › Block layout › Refresh
menu item.

4. [optional] To create block layout by part of images block, set the Use subblock
checkbox on and click the Select subblock button. Choose images to define con-
tains of a subblock with standard images selection tools and click OK.

5. Setup parameters of selected mode.

In the By ties mode set the following checkboxes:

• Initial approximation: overlap – allows to specify size of overlap area between
interstrip in strip images (in percent), if size of the overlaps are constant within a
block. This data is necessary for creation of primary block layout. In other case,
for layout creation different data is used – quick ties, for instance;

• QuickTies – allows to use manual linking lines between the same points of terrain
roughly specified on adjacent images (with accuracy of several hundreds of
pixels). It is recommended to set at least two “links” for each stereopair and two
“links” between strips of a block;

The Edit button allows to proceed to create/edit data mode on the QuickTies layer.

• Tie points – allows to use tie points coordinates measured in manual or automatic
modes;

For primary block layout it is possible to measure a small amount of tie points on in-strip
and inter-strip images instead of quick ties, that provides more accurate “ties” between
images on a block scheme.

• GC points – allows to use coordinates of measured GCP;

Block layout created by GCP displays block scheme in real coordinate system.
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• Imported exterior orientation – allows to use preliminary imported exterior ori-
entation parameters. Select theProjection centers and angles or theProjection
centers only option. Block layout, created by projection centers coordinates and
exterior orientation angles, is projection of images considering real coordinates
of projection centers and rotation angles;

This parameter allows to consider exterior orientation data for creation of block layout
along with other data, in contrast to the By ext. or. mode, which considers only exterior
orientation parameters.

• Adjustment results – allows to use adjustment results that were imported or
obtained during block adjustment. Block layout, created by adjustment results is
a final version of a block scheme.

For block layout creation it is more preferable to use adjustment results in contrast to
other data. It means that if there are no adjustment results available for block images,
so during block layout creation for these images the system considers other data specified
in the Block layout window. Otherwise, just adjustment results are considered.

The button allows to clear all selected checkboxes.

In the By ties, By ext. or., By centers modes setup the following parameters:

• the Image scaling slider allows to display images zoom in 2D-window (for ex-
ample, X4.00 – leads to zoom in an image 4 times); it is used for visual control
of images position without overlaps;

• the Account for DEM button allows to use ground sample distance (GSD),
specified manually or calculated automatically by DEM data during block layout
creation (see Section 3.3);

In order to use GSD value during block layout creation it is necessary to have interior
and exterior orientation parameters (projection centers coordinates, at least).

When using tie and GCP coordinates or adjustment results (appropriate options should
be selected in the Block layout window) GSD value is not considered during block
layout creation.

• if image GSD is unavailable, relief elevation data specified in project properties
is considered for block layout creation (see the “Project creation” User Manual).

Relief elevation is considered during block layout creation only if GSD data is unavailable.

6. [optional] In order to resolve specific problems caused by incorrect data input click
the More button. The Block layout (additional) window opens.
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Fig. 4. The Block layout (additional) window

Setup the following parameters:

• Scale difference – parameter proportional to scale difference between adjacent
images in a strip;

• Curving – parameter proportional to rotation angle between adjacent images in
a strip;

• Images deformation – parameter proportional to difference of images boundaries
shapes on a block scheme;

• Point rejection percent – percent of tie points which coordinates are not con-
sidered during block layout creation;

• Rotate all block by – angle of a block scheme rotation in degrees.

7. Click the Apply button. As a result, the block scheme in 2D-window is rebuild con-
sidering specified parameters (the Block layout window is opened meanwhile).

If the Use subblock checkbox is set on and images contain subblock are chosen,
the block scheme in 2D-window is rebuild considering parameters of chosen images.
All images are not included in the subblock is no longer displayed.

In order to create a block layout without parameters setup, double click the name of block layout
mode in the Mode section of the Block layout window.

The system provides possibility to create a block scheme by UAS images if angular
exterior orientation parameters of block images are specified with low accuracy or are
unavailable. For this operation it is necessary to use the button on the Exterior ori-
entation parameterswindow toolbox. For each highlighted image the system calculates
the direction from previous to next center in a strip (for utmost images of a strip – from
adjacent image to the current one) and kappa angle is setup from this direction.

If the survey time is available the correct images order is checked, otherwise images in strips
should be located in chronological order only.
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For quick access to functions of block layout creation it is used the additional Block
layout toolbox which buttons partly duplicate the Block › Block layoutmenu. To open
the Block layout toolbox selectWindow › Toolbars › Block layout.

The Block layoutmenu contains menu items used to perform the following operations:

• Refresh – allows to rebuild a block layout after some changes (equivalent to the
action of the Apply button in the Block layout window);

Block layout mode is not change when the Refresh button or menu item is used.

• W/o layout – allows to cancel block layout creation, and reverts a block scheme
to its initial state after images load (equivalent to theW/o layout mode in the Block
layout window);

• By exterior orientation – allows to create a block layout using only imported ex-
terior orientation parameters (equivalent to the By ext. or.mode in the Block layout
window);

• Load... – allows to load previously saved block layout from file with *.x-ini extension
from active profile resources;

• Save... – allows to save current block layout to file with *.x-ini extension in active
profile resources;

• Automatic block layout... – allows to create a block layout by UAS images in auto-
matic mode;

• Delete auto block layout results – allows to delete results of block layout created
by UAS images in automatic mode, including the ImageTransforms.x-ini file with
matching results.

3.3. DEM use for block layout creation

During block layout creation the system allows to consider GSD value, specified
manually or calculated automatically by DEM. GSD value is influenced on a size of
block image.

In order to use GSD value during block layout creation it is necessary to have interior and exter-
ior orientation parameters (projection centers coordinates, at least).

When using tie and GCP coordinates or adjustment results (appropriate options should be se-
lected in the Block layout window) GSD value is not considered during block layout creation.

To create block layout considering GSD value perform the following actions:
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1. Choose Window › Block layout (Ctrl+Alt+L) or click the button of the main
toolbar. The Block layout window opens.

2. Click the Account for DEM button. The Ground sample distance (GSD) window
opens.

Fig. 5. Specifying of GSD by DEM or manually

3. Choose block images in the table in order to setup GSD value for them.

There is a possibility to specify GSD value of project images in advance – on step of block
forming using the Block › Set GSD menu item (see the “Project creation” User Manual).

4. Choose one of the following ways of GSD value defining:

• to specify image GSD value manually input this value to the GSD field in the Set
GSD value section and click the Set button. Specified GSD value will be shown
in the table;

• to calculate image GSD value using calculator perform the following actions:

1. In the Image pixel size, um field input a pixel size in micrometers or click
the From project button for automatic detecting of pixel size.

2. In the Survey scale field specify a survey scale.

3. Click the Set button. Calculated GSD value will be shown in the table.
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• to calculate image GSD value using DEM data perform the following actions:

To calculate imageGSD value using DEM data during block layout creation it is necessary
to have interior and exterior orientation parameters (projection centers coordinates, at
least).

1. In theCompute by DEM section in theDEM filed click the button, specify
file name and its location in active profile resources.

2. [optional] To fill in blank cells of DEM by specified elevation values, set the
In null DEM cells use Z checkbox and specify Z coordinate value.

3. [optional] If a DEM does not cover images block completely, set the Use
image points out of DEM extents checkbox.

4. Click the Compute button. Calculated GSD value is displayed in the table.

5. [optional] To cancel input or calculated GSD values, select images in the table and
click the Unset GSD button. As a result in the GSD, m column of the table for se-
lected image the sign is displayed for selected images.

6. To save input or calculated GSD values, click the Apply button.

7. To create block layout considering GSD values, click OK in the Ground sample
distance (GSD) window then click the Apply button in the Block layout window.
If during block layout creation tie or GCP coordinates are not used, a block scheme
is rebuild considering input or calculated GSD values.

3.4. Manual images linking (quick ties)

Quick ties between images are used to create primary block layout. Quick ties include
setting of “links” between images using approximately specified (up to several hundred
pixels) same points of terrain on adjacent images in 2D-window.

It is necessary to consider the following recommendations for manual images linking:

1. It is recommended to link together all the images in strips first, and then to link the
strips.

2. It is recommended to set at least two “links” for each stereopair and two “links”
between adjacent strips.

3. A pair of identical terrain points should be selected in different parts of the strip
images.

At sufficiently precise and stable overlaps size within the entire block it is necessary to have a
bit of quick ties data to improve a block scheme. Thus, if the size of in-strip overlap (between
stereo pairs) in all strips is fixed, then link only strips.
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Fig. 6. Manual images linking (quick ties)

To create quick ties between images perform the following actions:

1. ChooseOrientation › QuickTies › Edit or click the Edit button in the Block layout
window. The Quickties active layer is created in the Manager.

2. Draw/edit quick tie lines between block images in the following way:

• to add a link place marker to selected terrain point on one image and press the
Insert key, then place marker to corresponding terrain point on another image
(appeared rubber line is stick to the first selected point) and press the Insert key.
Set “links” are displayed in 2D-window by turquoise lines;

• to cancel link line when the first point is already specified, press the Esc key and
the rubber line will disappear;

• to delete link line select it by double click or place marker in the neighborhood of
the link line and press the S key (link line becomes yellow) and press the Delete
key. To delete multiple link lines press and hold the Shift key, while dragging a
rectangular by mouse over the area where lines are located (rectangular selection
mode should be on (more details see in the Vector objects selection chapter in
the “Vectorization” User Manual));

• to delete all quick ties choose Orientation › QuickTies › Clear.
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3. Choose Orientation › QuickTies › Save to save quick ties data.

Quick ties data are saved automatically during block layout creation and during completing
of work session in the system.

3.5. Automatic block layout creation

The system provides possibility to create block layout for UAS projects automatically.

In order to create a block layout automatically, perform the following actions:

1. Perform preliminary creation of a block layout – by exterior orientation, for instance.
Perform visual estimation of the block layout, by comparing it with real location of
images in a block.

2. Choose Block › Block layout › Automatic block layout.... The Automatic block
layout window opens.

Fig. 7. Parameters of automatic block layout creation

3. Set the Block quality using the appropriate slider.

If there are project images with a rotation angles up to 10 degrees, move the slider
to the Better side.

If there are project images with a rotation angles from 10 to 60 degrees, move the
slider to theWorse side. This increases the likelihood of incorrect data.

4. [optional] Both Instrip and Interstrip stereopairs are processed in the system by
default. Clear one of the checkboxes to exclude appropriate stereopairs from pro-
cessing.

5. [optional] In order to use distributed processing during automatic creation of block
layout, perform the following actions:

1. Click theDistributed processing button. TheAutomatic block layoutwindow
opens.
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Fig. 8. Parameters of distributed processing of automatic block layout creation

2. Specify Tasks number, which are processed by one computer. Description of
distributed processing setup see in the General User Manual.

It is recommended to specify not more than one task per computer.

Both Instrip and Interstrip stereopairs are used during distributed processing, re-
gardless of settings.

3. Click OK to go back to previous window.

6. Click OK. After that the system will measure tie points created artificially specially
to consider them for adjustment (coordinates of the points are not saved). Creation
results are saved to ImageTransforms.x-ini file in the project resources.

File with results of automatic block layout creation is used for automatic measurement of
tie points.

If the operation of automatic block layout creation was interrupted, its results will be also
saved in the system.

4. Images interior orientation

4.1. The “Interior orientation” menu

To determine project cameras and to perform interior orientation of central projection
images the system provides the following interface elements:

• theOrientation › Manage camerasmenu item allows to create cameras of a project;

• theOrientation › Interior orientationmenu items allow to perform interior orientation
and accuracy control;

• buttons of additional AT toolbar duplicate menu items and are used for quick access
to the items. In order to open the AT toolbar, chooseWindow › Toolbars › AT.
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Table 2. Brief description of the “Interior orientation” menu

FunctionsButtons
allows to open a report about interior orientation
results (see the Section 4.4.6)

Report on interior orientation

[only for film camera images] allows to measure
manually coordinates of fiducial marks on images

Manual interior orientation

[only for film camera images] allows to perform
semiautomatic interior orientation, which is to use

Semiautomatic interior orientation

image-standard with template of fiducial marks pos-
ition used to search the same fiducial marks on
other project images
[only for film camera images] is used to perform
automatic interior orientation, which is the automatic

Automatic interior orientation

recognition of fiducial marks by their type, peculiar
to certain analog camera images
allows to re-calculate interior orientation parametersCalculate interior orientation
allows to open the Select images window that is
used to delete results of fiducial marks measure-
ments on selected images

Delete interior orientation data

4.2. Interior orientation workflow

Interior orientation is performed to calculate parameters which define a position and
orientation of film image coordinate system relatively to coordinate system of digital
image. Besides, interior orientation allows to define parameters describing a systematic
film image distortion can be found.

Result of interior orientation operation is obtaining of interior orientation parameters
used to transform measurement results from the digital image coordinate system to the
film image coordinate system.

Three types of transformation from the digital image coordinate system to the film image
coordinate system are implemented in the system (according to camera passport data):
affine, projective and rotation-scale-shift. Affine and projective transformations are
usually performed if during calibration fiducial marks coordinates were specified in
surveying camera coordinate system. These transformations are executed while exclud-
ing systematic distortion on images.

To define parameters of affine transformation it is necessary to measure coordinates
of at least three fiducial marks, and to define projective transformation parameters – at
least four fiducial marks. Otherwise it is necessary to apply simple rotation-scale-shift
transformation.

Interior orientation is performed for central projection images acquired by film or digital camera.
Interior orientation of scanner images – space borne images or ADS 40(80) data – is not available
in the system, since metadata files containing interior orientation parameters are delivered along
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with images from RS data provider (information about types of data and projects see in the
“Project creation” User Manual).

To perform interior orientation of central projection images the system provides the
following workflow:

1. Defining project cameras that includes the following steps:

• input of camera passport data;

• assign cameras to project images;

• define directions of camera axes for project images.

2. Perform interior orientation for the following types of images:

• images acquired by film camera;

• images acquired by digital camera.

3. Accuracy control of obtained interior orientation results (see the Section 4.4.6).

When deleting images from a project it is strongly recommended to synchronize the data in the
project to remove redundant orientation results. To do this choose Project › Synchronize.

4.3. Project cameras management

4.3.1. Images selection and highlighting

The system provides a set of standard tools and ways of selection and highlighting of
project images in lists and tables of the system’s dialogue windows.
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Fig. 9. Standard ways of images selection in lists/tables

To select/highlight images in a table or list there are the following tools:

• selection of images/strips using checkboxes near the image or strip name;

• highlighting of images/strips by mouse click on the image or strip name;

In order to highlight multiple images or strips, press and hold the Ctrl or Shift key while
clicking mouse.

• selection of images using standard toolbox, which contains the following buttons:

○ – allows to select all images;

○ – allows to unselect all images;

○ – allows to inverts images selection;

○ – allows to select highlighted images;

○ – allows to unselect highlighted images;

○ – allows to select in a table or list those images which are highlighted on a block
scheme in 2D-window;

○ – allows to highlight on a block scheme in 2D-window those images which are
selected in a table or list.
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4.3.2. Project cameras management

Prior to executing interior orientation it is necessary to define parameters of cameras
which were used to acquire project images.

In order to define project cameras, input their parameters from passport data, assign
cameras to project images and define directions of cameras axes for specific project
images the Manage project cameras window is used.

In order to open the Manage project cameras window choose Orientation › Manage
cameras or click the button of the AT additional toolbar.

Fig. 10. The Manage project cameras window

the Manage project cameras window contains the following sections:

• the Project images section is used to select project images and to view statistics for
each image: assigned camera, camera axes orientation and current step of interior
orientation; the section also includes a table of all project strips/images, their para-
meters and standard toolbox for images selection;

• the Project cameras section is used to define project cameras: to form a list of
cameras of current project, to input/edit camera parameters, to import, export, remov-
ing and renaming of cameras. The section contains a list of project cameras with
data about number of assigned images, as well as a toolbox used for camera man-
agement;
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• the Change camera for selected images section allows to assign selected camera
to selected project images, and to specify orientation of camera axes on project im-
ages;

• the image preview section is used to display highlighted image in a table. The section
includes image name, preview window of highlighted image with display of camera
axes and toolbox used to perform interior orientation and view its results in report,
as well as image size in pixels.

Table 3. Toolbox for camera management

FunctionButtons
allows to input a new project camera
allows to import a camera from another project to
current one
allows to edit parameters of a camera selected in a
list
allows to copy selected in a list camera with all its
parameters
allows to rename selected in a list camera
allows to remove selected in a list camera
allows to unassign a camera selected in a list from
project images. After that in the Project cameras
list in the Num. of images column the “0” value is
displayed

To input a new project camera perform the following actions:

1. In the Manage project cameras window click the button. The Camera window
opens.
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Fig. 11. Film camera parameters

2. Input a camera name and specify camera parameters according to its passport
(see the Section 4.3.3 and Section 4.3.4) or import camera parameters (see the
Section 4.3.5).

3. Click OK. A name of new camera is shown in a list of the Project cameras section,
and in active profile resources in the current project folder the Cameras folder is
created. It contains file with the camera description Camera_name.x-cam.

The button allows to edit all camera parameters, except for its name, specified in the
Camera field. To rename camera selected in a list use the button.

4. [optional] Repeat steps 1–3 to define other cameras in a project if project images
are acquired using different cameras.

In order to assign camera to selected images perform the following actions:

1. In the Manage project cameras window select a camera in the Project cameras
list.

2. Select images in the Project images table.
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3. Set theAssign selected camera to selected images checkbox to assign selected
camera to images.

To recalculate interior orientation without assigning new camera, clear theAssign selected
camera to selected images checkbox and click the Execute button.

4. Set the Set camera rotation for selected images checkbox and select rotation
angle – 0º, 90º, 180º or 270º.

5. Click the Execute button. Selected camera will be assigned to selected project
images.

4.3.3. Parameters of film camera

To input parameters of film camera perform the following actions:

1. Choose Orientation › Manage cameras or click the button on the AT toolbar. The
Manage project cameras window opens.

2. Click the button to specify a new project camera. The Camera window opens.

Use the button to edit parameters of existing camera.

27

Aerial triangulationPHOTOMOD 6.0.2



Fig. 12. Parameters of film camera

3. In the Camera type section set the Film option.

4. Specify a camera name in the Camera input field.

5. Input focal length (in mm) in the Focal length input field.

6. [optional] Set the Calibration date checkbox and select calibration date.

7. Input principal point coordinates (in mm) in the Principal point fields.

8. [optional] Input theDescription – arbitrary text used for example, for easy identific-
ation of the camera and projects where it is used.

9. In the Fiducial marks list choose one of the following data types according to the
camera calibration data (if any):

• Principal point only – principal point coordinates Xo and Yo (in mm). If calibration
data is unavailable and there are no fiducial marks, interior orientation is performed
only using principal point coordinates;
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• Fiducial marks – this option is used if there are no reference values of distances
between fiducial marks and fiducial coordinates values, but there is a possibility
to calculate principal point coordinates in a crossover point of lines connecting
fiducials;

• Calibrated distances – allows to set reference values of distances between fi-
ducial marks (in mm) by XY axes: Lx and Ly;

• Fiducial coordinates – allows to set coordinates of fiducial marks X,Y (if they
are available in the camera passport).

10. [optional] In the Fiducial marks template list select appropriate camera-template,
which type of fiducial marks corresponds to current camera. Selected type of fiducial
marks contains all necessary information about fiducials: their numbering, template
and search area. Using camera-template allows to perform automatic interior ori-
entation.

A list of camera-templates is available only if in the Fiducial marks list the Calibrated
distances or Fiducial coordinates option is selected.

11. In theDistortion list select one of the following distortion types according to passport
data of survey camera distortion:

• None – no passport data;

• Formula – to input distortion coefficients of Brown-Conrady model;

In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.

Fig. 13. Formula and distortion parameters

Only distortion coefficients b1 and b2 relatively to Х-axis are used for camera self-calib-
ration.
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The button is used to transform distortion calculated by formula to a radial
one.

Fig. 14. Parameters of distortion transformation

• Radial – to input table values of radial distortion by radius-vector distance;

• 4 directions + – to input table values of distortion by directions of image coordin-
ate axes;

• 4 directions “Х” – to input table values of distortion by diagonal directions;

• 8 directions – to input table values of distortion by directions of image coordinate
axes and by diagonals.

During input of distortion data the point of symmetry coordinates are specified –
zero distortion (in mm) and table values of distortion (in microns) or distortion
coefficients (formulas). To use principal point coordinates as point of symmetry
coordinates click the To principal point button.

Fig. 15. A table of distortion values by diagonal directions

The figure above shows a table of distortion values by diagonal directions. Directions
orientation is shown on a scheme right of the table. Each row of the table allows to
input the following values: distance from point of symmetry (radius) in the first
column, and distortion values in the columns corresponding to the numbers of dir-
ections.

30

Aerial triangulationPHOTOMOD 6.0.2



The following buttons are used to add, delete lines and edit values in the table:

• – allows to add a new line (Ctrl+Ins);

• – allows to delete selected line (Ctrl+Del);

• – allows to revert a distortion sign;

• – allows to multiply distortion values by 1 000, to convert them into microns;

• – allows to divide distortion values by 1 000, to convert them into microns.

Positive values of distortion coefficients mean “shift” of image away from the center, and
negative – towards the center.

12. Click OK to complete input of camera parameters.

4.3.4. Digital camera parameters

Perform the following actions to input digital camera parameters:

1. Choose Orientation › Manage cameras or click the button of the AT additional
toolbar. The Manage project cameras window opens.

2. Click the button to specify a new project camera. The Camera window opens.

Use the button to edit parameters of existing camera.
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Fig. 16. Parameters of digital camera by the example of DSS camera

3. In the Camera type section set the Digital option.

When entering characteristics of a digital camera, principal point coordinates, focal length
and point symmetry (zero distortion) are defined inmm, and pixel size and value of distortion
coefficient – in microns.

4. [optional] In order to change units of digital camera parameters, in the Show digital
camera parameters in section choose millimeters or pixels.

It is not recommended to change units of digital camera parameters repeatedly, since it
may cause insignificant loss of accuracy. Recalculation is made by using the Pixel size
parameter.

During save of camera parameters the data is saved in the system in millimeters regardless
of the selected units. When the window opens the default data is also displayed in milli-
meters.

5. In the Point of origin section specify pixel position, with respect to which shift of
principal point and symmetry point is specified to consider distortion from camera
passport: In image center or In lower left corner.
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Scheme of coordinate system is shown to the right from the Point of origin section.

If the Sensor size is specified, the button allows to recalculate a position of principal
point and point of symmetry when coordinates origin is changed.

6. Input the Pixel size value to Х and Y input fields in microns.

Regardless of the units of digital camera parameters, the Pixel size is specified inmicrons,
and the Sensor size – in pixels.

The Pixel size parameter should be specified to display camera parameters in pixels.

7. [optional] In order to define the Sensor size, enter its size by Х and Y in pixels.

The button allows to swap sensor size values by X and Y to fix errors of data input.

The Sensor size value could be imported frommetadata or from a file with *.cal extension.
This parameter is used to control camera axes orientation during import.

8. Input the Focal length value in mm.

9. Input X,Y-coordinates of principal point with regard to image center (in mm) to the
Principal point input fields.
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Fig. 17. Dependence between image and monitor coordinate systems

Here:

• Xi and Yi – axes of image coordinate system – Right;

• Xp and Yp – axes of Pixel/Monitor coordinate system – Left;

• xpp and ypp – principal point coordinates, measured from upper left corner of the
image (from origin of Pixel/Monitor coordinate system);

• xipp and y
i
pp– principal point coordinates, measured from central pixel of the image

(from the image coordinates origin).

Image coordinates origin may differ from origin of Pixel/Monitor coordinate system. In this
case it is necessary to recalculate principal points coordinates, specified in the camera
passport, considering used coordinate system.

10. [optional] Input theDescription – arbitrary text used for example, for easy identific-
ation of the camera and projects where it is used.

11. In theDistortion list select one of the following distortion types according to passport
data of survey camera distortion:

• None – no passport data;
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• Formula – to input distortion coefficients of Brown-Conrady model;

In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.

Fig. 18. Formula and distortion parameters

Only distortion coefficients b1 and b2 relatively to Х-axis are used for camera self-calib-
ration.

The button is used to transform distortion calculated by formula to a radial
one.

Fig. 19. Parameters of distortion transformation

• Radial – to input table values of radial distortion by radius-vector distance;

• 4 directions + – to input table values of distortion by directions of image coordin-
ate axes;

• 4 directions “Х” – to input table values of distortion by diagonal directions;

• 8 directions – to input table values of distortion by directions of image coordinate
axes and by diagonals.

During input of distortion data the point of symmetry coordinates are specified –
zero distortion (in mm) and table values of distortion (in microns) or distortion
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coefficients (formulas). To use principal point coordinates as point of symmetry
coordinates click the To principal point button.

Fig. 20. A table of distortion values by diagonal directions

The figure above shows a table of distortion values by diagonal directions. Directions
orientation is shown on a scheme right of the table. Each row of the table allows to
input the following values: distance from point of symmetry (radius) in the first
column, and distortion values in the columns corresponding to the numbers of dir-
ections.

The following buttons are used to add, delete lines and edit values in the table:

• – allows to add a new line (Ctrl+Ins);

• – allows to delete selected line (Ctrl+Del);

• – allows to revert a distortion sign;

• – allows to multiply distortion values by 1 000, to convert them into microns;

• – allows to divide distortion values by 1 000, to convert them into microns.

Positive values of distortion coefficients mean “shift” of image awayfrom the center, and
negative – towards the center.

12. Click OK to complete input of camera parameters.

4.3.5. Import and export of camera parameters

TheCamerawindow provides opportunities of import and export of camera parameters,
as well as possibility to use features of standard cameras.

TheCamerawindow opens using the and buttons in theManage project cameraswindow.
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To import of camera parameters perform one of the following actions in the Camera
window:

• choose Import › From file to import camera parameters from *.x-cam file, located
in folder of Windows file system.

The Load camera window opens. Select file with camera parameters *.x-cam and
click OK. Camera’s parameters will be loaded to appropriate fields of the Camera
window;

• choose Import › From resource to import camera parameters from *.x-cam file,
located in folder of active profile resources.

TheOpen window opens, that displays a tree of active profile resources. In the folder
of active profile resources select file with camera parameters *.x-cam and click OK.
All parameters of camera from selected file will be loaded to appropriate fields of the
Camera window;

By default the Cameras folder is used to store *.x-cam files with camera parameters in the
profile resources of each project.

• choose Import › Import from CAL-file (EnsoMOSAIC) to import digital camera
parameters from the *.cal file of the EnsoMOSAIC system.

To import of camera parameters from another project to a current one perform the fol-
lowing actions:

1. In the Manage project cameras window click the button. The Open window
opens.

37

Aerial triangulationPHOTOMOD 6.0.2



Fig. 21. Camera selection in resources of another project

2. Select the camera file *.x-cam in the Cameras folder of another project in active
profile resources.

3. Click Open. As a result, the camera name appears in the camera list.

To export of camera parameters to *.x-cam file the Export › To file or Export › To re-
source in the Camera window are used.

For automatic input of standard cameras data to input fields of the Camera window the
Standard camerasmenu is intended. The menu is used, if the camera parameters are
fully or partly coincide with parameters of standard camera, that allows to significantly
reduce time of manual input of new camera parameters.

Camera description in the *.x-cam file includes the followingmain lines, which correspond
to parameters shown in the Camera window:

• name – camera name;

• calibration_date – calibration date;

• description – camera description;

• focus – focal length;

• principal_point – principal point coordinates.
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Fig. 22. Camera parameters in the file of *.x-cam format

4.4. Interior orientation of film camera images

4.4.1. Interior orientation modes

In order to perform interior orientation of images acquired by film camera the system
provides the following modes:

• interior orientation in manual mode using measurement of coordinates of fiducial
marks on all project images (see the Section 4.4.2);

• interior orientation in semi-automatic mode using image template, with already
measured coordinates of fiducial marks and available interior orientation (see the
Section 4.4.4);

• interior orientation in automatic mode using camera template with defined type of fi-
ducial marks (see the Section 4.4.5).

4.4.2. Manual measurement of fiducial marks coordinates

To perform Interior orientation of image the Interior orientation window is used.
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Fig. 23. Manual measuring of fiducial marks

The window includes the following parts and contains the following interface elements:

• toolbar with buttons used to perform the following operations:

○ , , , – allows to pass to adjacent image of a block located left, top, bottom
or right side, respectively;

○ , – allows to pass to previous or to next unprocessed image (with unmeasured
fiducials);

○ – allows to open the Manage project cameras window;

○ – allows to open the Semi-automatic interior orientation window;

○ – allows to open the Automatic interior orientation window;

○ – allows to open the Report on interior orientation window;

○ – allows to remove all fiducial marks measurements on a current image;
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○ – allows to open theMarker settings window used to setup marker shape, size
and color.

• the Image information and Camera information sections are used to display gen-
eral information about selected image and about camera parameters;

• the main window of image view is used to fiducial marks search and the additional
lens-window is used for precision marker position in fiducial center. Image manage-
ment in windows is performed using the standard buttons;

TheCtrl+F8 shortcut allow to show/hide scroll bars in themain window and in the lens-window.

• the table of fiducial marks in the Measurements section is used to display fiducials
coordinates from camera passport (in mm), measured coordinates acquired after
measuring of fiducial coordinates, and values of their discrepancies after interior ori-
entation operation;

• marker coordinates (in pixels and mm), buttons used to measure and delete fiducial
coordinates, a list used to choose a transform type;

• the status bar used to display image zoom ratio in the main window and the lens-
window, and marker coordinates (in pixels). After measuring of two fiducial marks,
the status bar shows also marker coordinates on image (in mm)/marker coordinates
on image considering distortion (in mm) and pixel size (in mm);

• the Apply button allows to perform image interior orientation after measuring of its
fiducial marks.

In order to performmanual measurement of fiducial marks coordinates on project images
perform the following actions:

1. Highlight a block in 2D-window anв choose Orientation › Interior orientation ›
Manual interior orientation or click the button of the AT additional toolbar. The
Interior orientation window opens.
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Fig. 24. Manual measurement of fiducial marks coordinates

2. Choose a fiducial mark which coordinates to be measured in the Measurements
table of fiducial marks coordinates, which displays XY-coordinats of the mark (in
mm) from camera passport. Find on image and show by marker the mark in the
view window. In the right lens-window selected fiducial mark is displayed.

3. Perform precision positioning of marker on chosen fiducial mark in the lens-window
using mouse cursor and arrow keys. Marker position coordinates (in pixels and
mm) are displayed in theMarker coordinates (pix) andMarker coordinates (mm)
input fields.

4. Click the Measure mark button to fix measured fiducial coordinates. After fiducial
coordinates measurement the fiducial table shows the measurement result – co-
ordinates of measured fiducial Xр and Yр (in pixels).

5. Repeat pp. 2-4 to measure coordinates of the second mark. After measurement of
two fiducial marks a status bar will display information about pixel size, marker co-
ordinates on image (in pixels and mm), and marker coordinates, calculated consid-
ering distortion (in mm).
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6. Repeat pp. 3-4 for the rest of fiducials. After measurement of first two fiducial marks
a marker will be automatically positioned to vicinity of the next fiducial mark on image
in image view window and in the lens-window.

7. After measurement of all fiducials coordinates choose one of the following trans-
formation type: Rotation, Scale, Shift; Affine; Projective in the Transform type
list.

8. Click the Apply button to perform interior orientation. After that the fiducials table
will display the Ex and Ey values of discrepancies (in mm) between fiducial marks
specified in camera passport and measured on image.

Maximal error should not exceed the size of the pixel. To perform accuracy control of interior
orientation results using report click the button.

9. [optional] After measuring fiducial marks coordinates at least on one block image
click the button to try to perform interior orientation of the rest block images in
semi-automatic mode.

10. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 4.4.6).

4.4.3. Image management

This chapter contains a description of standard image managing options in image view
window. A toolbox of image view window contains the following buttons used to manage
an image:

• – allows to zoom in an image by one step (*);

• – allows to zoom out an image by one step (/);

• – allows to fit to page data of opened layers (Alt+Enter);

• – allows to display data in 1:1 scale, when one pixel of the image corresponds to
one pixel on the screen;

• – allows to center image by marker in working area of 2D-window.

To turn on panning mode that allows to move an image using mouse in a view window –
press and hold the Alt key while moving mouse.
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Fig. 25. Standard toolbar of the “Interior orientation” window

4.4.4. Semi-automatic interior orientation

Principle of operation of semi-automatic mode is the automatic search andmeasurement
of fiducial marks coordinates on all project images in accordance with selected template-
image and further interior orientation for all block images. As a template-image one of
project images is used. For this image fiducial mark template is defined and interior
orientation is performed. Thus, semi-automatic interior orientation of the entire images
block requires interior orientation results of at least one image of a project, obtained
after manual measurement of fiducial marks coordinates.

To execute semi-automatic interior orientation perform the following actions:

1. Choose Orientation › Interior orientation › Semi-automatic interior orientation
or click the button of the AT additional toolbar. The Semi-automatic interior
orientation window opens.
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Fig. 26. Defining of fiducials search area and reference mark

2. In the Project images table select a template-image, which will be used for search
andmeasurement of fiducial marks coordinates on other project images. To choose
a template-image select the image in the table and click the button. Left of the
image name the Template label is displayed.

Any image of the project with performed interior orientation could be used as template-image.

3. Use sliders in theMarks search parameters section to define the following search
parameters:

• Mark area size is used to define fiducial template. Setup the fiducial area size
in such way that fiducial image is fully located in search area;

• Search area size is used to define fiducial location. If images are sliced unevenly
and fiducial marks are located at different distances from image edge on different
images, it is recommended to set sufficiently large search area (outer rectangle,
which circumscribe a fiducial mark).
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In order to specify search areas use the image view window and the lens-window, along
with buttons of toolbar. TheCtrl+F8 shortcut allows to show/hide scroll bars in view windows.

4. For automatic search of fiducial marks using correlator that compares fiducial mark
image with its template, define threshold value in the Correlation threshold input
field (0.9 by default).

5. Choose images in the Project images table to perform interior orientation in semi-
automatic mode.

6. [optional] In the Search for marks section set the Search images with int. or.
already performed checkbox to include to calculation the images (from selected
ones), which have interior orientation results available, i. e. to recalculate interior
orientation for them in accordance with the selected template.

7. Choose one of the following transformation type: Rotation, Scale, Shift; Affine;
Projective in the Transform type list.

8. Click the Start button to perform semi-automatic interior orientation.

9. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 4.4.6).

Below the table of images there are the buttons that allow to open the following windows:

• – Project cameras management;

• – Interior orientation (manual);

• – Automatic interior orientation;

• – Report on interior orientation.

TheOrientation › Interior orientation › Delete interior orientation datamenu item is used
to remove interior orientation data in case of unsatisfactory results.

4.4.5. Automatic interior orientation

The system provides possibility to perform interior orientation in automatic mode, if
template-camera is specified in properties of film camera in the Fiducial marks section
(see the Section 4.3.3).

Interior orientation in automatic mode consists in automatic search and measurement
of fiducial marks on project images according to specified type of fiducial marks, and
further interior orientation. Specified Fiducial marks parameter already contains inform-

46

Aerial triangulationPHOTOMOD 6.0.2



ation about fiducials typical for the selected camera: their numbering, template and
search area.

Current version of the system supports types of fiducial marks for RC 20, RC 30 and LMK
cameras.

To correctly perform automatic interior orientation, orientation of the camera image axes should
be set correctly (see the Section 4.3).

To execute automatic interior orientation perform the following actions:

1. Choose Orientation › Interior orientation › Automatic interior orientation or
click the button of theAT additional toolbar. TheAutomatic interior orientation
window opens.

2. To perform interior orientation in automatic mode select images in the Project im-
ages table.

Fig. 27. The “Automatic interior orientation” window

3. For automatic search of fiducial marks using correlator that compares fiducial mark
image with its template, define threshold value in the Correlation threshold input
field (0.8 by default).

4. [optional] In the Search for marks section set the Search images with int. or.
already performed checkbox to include to calculation the images (from selected
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ones), which have interior orientation results available, i. e. to recalculate interior
orientation for them in accordance with the selected template.

5. Choose one of the following transformation type: Rotation, Scale, Shift; Affine;
Projective in the Transform type list.

6. Click the Start button to perform automatic interior orientation.

7. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 4.4.6).

Right from the Project images section there are the buttons that allows to open the
following windows:

• – Project cameras management;

• – Interior orientation;

• –Semi-automatic interior orientation;

• – Report on interior orientation.

TheOrientation › Interior orientation › Delete interior orientation datamenu item is used
to remove interior orientation data in case of unsatisfactory results.

It is strongly recommended to synchronize the data in the project to remove redundant orient-
ation results when deleting images from a project. To do this choose Project › Synchronize.

4.4.6. Report on interior orientation

Report on interior orientation allows to estimate a quality of interior orientation of film
camera images.

To view the report on interior orientation perform the following actions:

1. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar. The Report on interior orientation
window opens.
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Fig. 28. Main parameters of interior orientation report

2. On the Main parameters tab specify the following report parameters:

• in the Show report section choose the All images or Selected images option;

• choose a type of residual: RMS (root mean square), Mean abs. value (mean)
orMax (maximal) and specify the Threshold for interior orientation residuals
value in the appropriate field in pix or mm.

If project images were scanned by photogrammetric scanner, mean absolute value Eср
should not exceed a half pixel size. The approximate ratio of the mean, maximum and
mean square error is calculated as follows:

Emax ≈ 2 Emean and RMS ≈ 2 Emean

where: Emean – mean residual, Emean
xy = 2 0.5pix – max residual, RMS – quadratic

mean RMS.

3. On the Additional tab specify the following additional parameters:

• choose format of residuals: Fixed point or Exponential;

• define accuracy of residual values output: Normal, Higher or Maximum.
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Fig. 29. Additional parameters of interior orientation report

4. Click OK. After that a report opens, which contains general information on the im-
plementation of interior orientation and consists of the following sections:

• Links used to return to previous view place or to the beginning of the report, to
refresh report data after calculating of interior orientation, and to change a report
parameters.

• Block statistics – project name, data on number of all/selected strips/images in
a block, time and date of the report creation, strips tablewith the following general
information: on which strips/images and to what extent the interior orientation is
performed, and whether the residuals values satisfy a given residuals tolerance
for measurement of fiducial marks on images. The Strips column contains links –
strips names, that allow to pass to tables of images in each strip.

• Tables of images in each strip show general information about images – camera
data, axes orientation, number of fiducial marks measured on the image, type of
image transformation and interior orientation residual of selected type (RMS,
mean module or maximal) in selected units (pix or mm) on theMain parameters
tab of theReport on interior orientationwindow. The first column contains links
that allow to open selected image in the Interior orientationwindow to edit fiducial
marks measurements. The Images column contains links – names of images
that allow to pass to detailed report about interior orientation of selected image.

Red color is used to mark images/strips, for which interior orientation is not performed,
yellow color is used for images/strips for which interior orientation is performed incorrectly
or incompletely, i.e. with residuals exceeding a threshold value, and also when not all fiducial
marks are measured. Residuals themselves also appear in red.

The figure below displays an example of interior orientation which is not satisfactory
under the following conditions and with the following data: threshold value for mean
module – 0.2 pix, coordinates of one of the marks on image of the 9-th strip are not
measured, and coordinates of all marks of one of images of the 10-th strip are not
measured.
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Fig. 30. Report on interior orientation of film camera images block

Toolbar in upper part of interior orientation report contains the following buttons:

• (Backspace) – allows to go back to previous view;

• (F5) – allows to refresh a report after change of the report parameters;

• (Ctrl+F) – allows to perform data search in a report (by keyword or its part);

• – allows to save a report to HTML-file in any folder out of active profile re-
sources;

• – allows to save a report to HTML-file in active profile resources;

• – allows to print a report;

• (Ctrl+P) – allows to open print preview window.

5. In the table of images click the link of selected image in the Image column. After
that a detailed report on interior orientation of selected image is opened. The report
contains the following data:

51

Aerial triangulationPHOTOMOD 6.0.2



• links to pass to the following places:

○ [Edit] – allows to open the Manual interior orientation window where it is
possible to “re-measure” fiducials coordinates and recalculate interior orienta-
tion;

○ [Back] – allows to return to previous window of the report;

○ [Refresh] – allows to обновить отчет при change a report parameters;

○ [Report parameters] – allows to open window used to change a report paramet-
ers.

• image statistics – camera parameters, image size, pixel size, interior orientation
data;

• table of fiducial marks on image contains the following data:

○ maximal residual threshold Ex, Ey, Exy specified on theMain parameters tab
of the Report on interior orientation window;

If threshold value on RMS or mean residual is specified, threshold on maximal residual
is automatically calculated in selected units (pix or mm).

○ marks coordinates taken form camera passport (in mm) – X,Y;

○ marks coordinates on image (in pix) – X,Y;

○ values of discrepancies between passport data and measured data (in pix and
mm) – Ex, Ey, Exy;

○ specified threshold value on selected residual in selected units on the Main
parameters tab of the Report on interior orientation window;

○ calculated on all marks residual values by RMS, mean abs. and max Ex, Ey,
Exy (pix or mm).

Residuals that are out of thresholds are highlighted by red color. Thus, the report
displays by red color the following residuals:

○ residuals on all marks, that exceed defined threshold on selected residual
(RMS, mean abs. or max);

○ residuals on each mark, that exceed defined threshold on maximal residual.
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Fig. 31. Report on interior orientation of film camera image

4.5. Interior orientation for digital camera images

Interior orientation of image acquired by digital camera is to determine the principal
point position relative to the center of the lower left pixel of the image.

To perform interior orientation of images acquired by digital camera perform the following
actions:

1. Input correctly all parameters from digital camera passport to appropriate input
fields of the Cameras window (see the Section 4.3.4).

It is necessary to pay attention to parameters units, and to define point of origin, which will
be used to specify coordinates of principal point and symmetry point (zero distortion point):
relative to the lower left pixel or the center of the image.

2. Assign the camera to project images and setup camera axes direction for selected
images in the Camera management window (see the Section 4.3).
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3. ChooseOrientation › Interior orientation › Calculate interior orientation or click
the button of the AT additional toolbar to recalculate interior orientation.

4. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar to control results and fix errors of interior
orientation.

Report on interior orientation for digital camera contains information whether the interior
orientation is done. It also includes camera parameters and principal point coordinates,
calculated relative to the center of the lower left pixel.

Fig. 32. Report on interior orientation of digital camera images block
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Fig. 33. Report on interior orientation of digital camera image

Toolbar in upper part of interior orientation report contains the following buttons:

• (Backspace) – allows to go back to previous view;

• (F5) – allows to refresh a report after change of the report parameters;

• (Ctrl+F) – allows to perform data search in a report (by keyword or its part);

• – allows to save a report to HTML-file in any folder out of active profile resources;

• – allows to save a report to HTML-file in active profile resources;

• – allows to print a report;

• (Ctrl+P) – allows to open print preview window.

4.6. Interior orientation control

Prior to perform aerial triangulation it is necessary to make interior images orientation.
During interior orientation in some cases radially directed systematic errors occur.
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Also, when execute images interior orientation in some cases errors occur because of
incorrectly specified focal length or due to incorrect distortion considering. In order to
determine the presence of such errors, it is necessary to perform block adjustment using
GCP and the projection centers.

Accuracy of focal length, principal point coordinates and accounting distortion determ-
ining are interrelated. An error in focal length calculation results in error distortion con-
sidering and error of determining the principal point coordinates. It is necessary to
specify correct values of focal length and principal point coordinates in order the distortion
value does not exceed the specified tolerance. It is recommended to verify the sign of
the distortion correction and distortion units.

5. The “Points measurement” module

5.1. General information about module

In order to measure coordinates of triangulation points (tie, check and GCP) in manual
mode and editing points coordinates with errors obtained after automatic measuring of
tie points coordinates, the system provides the Points measurement module.

The module allows to automatically calculate parameters of images interior orientation when
measuring tie points coordinates.

The Points measurement module is used on the following steps of data collecting for
aerial triangulation operation:

• input and measurement of GCP coordinates;

Automatic selection of images for non-measured GCP in the Points measurement module
is performed after measurement of coordinates of first two-three GCP on block images or
when preliminary exterior orientation is performed in geodetic coordinate system (by projection
centers, for instance).

• measurement of tie points coordinates on block images entirely in manual mode and
performing of images relative orientation;

• editing of tie points position to fix errors obtained after automatic measurement of
points coordinates;

• editing of triangulation points to fix errors obtained on step of block adjustment (see
the “Block adjustment” User Manual);

• measurement of tie points coordinates to estimate accuracy by Y-parallax after import
of exterior orientation data.

The following items of the Orientation menu and buttons of the AT additional toolbar
are used to start the Points measurement module:
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• Open selected images for measurement – allows to launch the Points meas-
urementmodule and automatically open block images selected in 2D-window in the
module;

• Open images containing marker – allows to launch the Points measurement
module and automatically open in the module all images that contain marker position
in 2D-window;

• Open in-strip stereopair – allows to launch the Points measurement module
and open two images of selected in-strip stereopair;

If just one image is selected in 2D-window, neighboring right image in a strip will be opened
by default. If the last image in a strip is selected, image to the left of the selected will be
opened.

• Open inter-strip stereopair – allows to launch the Pointsmeasurementmodule
and open two images of selected inter-strip stereopair.

If just one image is selected in 2D-window, neighboring lower image in a strip will be opened
by default. If selected image is in the outermost strip, the top image on the selected will be
opened.

The Points measurementmodule represents a set of two windows – the main Points
measurement window and the Triangulation points window. The main Points
measurementwindow displays selected images in separate windows and contain tools
used to perform triangulation points measurement. The Triangulation points window
is a catalogue of all triangulation points along with their measurements data and contains
tools for work with points catalogue.
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Fig. 34. The “Points measurement” module

Awork in the Pointsmeasurement and Triangulation pointswindows is synchronized
in the following way:

• when choosing a triangulation point on one of the images using mouse double click
the system automatically starts search for selected point on the opened images of
the module and search of appropriate point on the terrain, if the point is not measured
on the image. Besides, the point will be also automatically highlighted in the triangu-
lation points catalogue;

• when choosing a triangulation point in a catalogue using mouse click the point will
be shown on opened images of the module automatically, if the point is measured
on these images and/or a search of appropriate point on the terrain, if the point is not
measured on opened image;

• when choosing a triangulation point in a catalogue using mouse click and by the
button or by double mouse click the system allows two ways of displaying, depending
on the Automatically choose images containing point mode (see the Sec-
tion 5.2):

○ all images where the point is measured are opened automatically, if the Automat-
ically choose images containing point mode is turned off;
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○ all images where the point is measured and/or could bemeasured (marker is located
to the place or probable measurement) are opened automatically, if the Automat-
ically choose images containing point mode is turned on.

• filtering of display of different points types in catalogue and on opened images is also
synchronized.

When the module is launched marker is placed to estimated position of the point.

Fig. 35. Search for a point on terrain with measured coordinates and without measured coordinates

After measurement of coordinates of each new tie point images relative orientation (Y-
parallax on measured points) is performed automatically.

For viewing results of relative orientation the system provides the following features:

• the button of the Triangulation points window toolbar is used to view relative
orientation report for the whole images block in the read-only mode. The report is
opened after defining of the report parameters;

• the button of the Points measurement upper toolbar allows to view relative ori-
entation report only for images opened in themodule. The report is opened considering
default or defined previously report parameters;
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5.2. The “Points measurement” window

The main window of the Points measurementmodule is used to measure/edit triangu-
lation points on project images with or without correlator, in mono or stereo mode.

The Points measurement window contains the following interface elements:

• the main toolbar used to apply different operations to all opened images consists of
the following panels:

○ the upper panel contains buttons used to manage images zoom, images selection
for measurements, measuring/editing of triangulation points coordinates, transfer
of GCP from georeferenced maps, setup of triangulation points symbols and
common parameters;

○ the left toolbar contains buttons used to manage display of triangulation points and
residuals vectors in all images windows.

• windows of opened images, each of them display an image and its name, and contains
its own toolbar and status bar.

Setting of the Points measurement and Triangulation points window size is preserved after
reboot of the module/system.

During triangulation points measurement in the Points measurement window the fol-
lowing concepts are used in the system:

• The active image – image displayed in the window selected by mouse click. The
active image window is highlighted by blue frame;

• The “left” image – a status assigned to one of opened windows, that is considered
during stereopair opening and is used to correlate other images with this one during
measurement of tie points using correlator.

To define one of opened images as a “left” one, click the button located in the toolbar of
this image. To define an active image as a “left” one click the button of the upper toolbar
of the Points measurement window.
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Fig. 36. The main window of the “Points measurement” module

If in-strip or inter-strip stereopair is opened, a “square” in the middle of the Points
measurement window allows to setup relative location of main windows of images and
lens-windows.

Changed position of the Points measurement and Triangulation points windows is re-
membered by the system and restored at the module next launch.

Fig. 37. Interstrip stereopair in the “Points measurement” module

The system provides opportunity to transform images during displaying in the opened
windows of the Pointsmeasurementmodule. The transformation influences on images
display and on measurement of points coordinates using correlator.
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To choose a transformation type, click on the arrow to the right of the button. Opened
menu contains the following items:

• No transform – allows to cancel images transformation (images are shown without
rotation);

• Rotation by block scheme 90º multiple – allows to rotate images by images rotation
angle, which occurs during block forming in 2D-window, rounded to the nearest angle
multiple of 90º;

• Rotation by block scheme, exact – allows to rotate images by images rotation
angle, which occurs during block forming in 2D-window;

• Block layout: rotation – allows to rotate images according to block scheme;

• Block layout: scale and rotation – scale and rotation are used during transformation
according to block scheme;

• Block layout: projective transform – image projective transformation is used during
transformation exactly in the same way as on block scheme;

• Image scale – allows to change basic scale of images for correlator (the same scale
is used during images display 1:1).

Table 4. Upper toolbar of the “Points measurement” window

FunctionsButtons
standard buttons of images management in all
opened windows with images at once

, , , ,

allow to display the next image in a strip (to “flip”
images in opened windows) to the left or right by

, , ,

one image in a strip, up/down by one image in adja-
cent strips
allows to return to previous or to pass to next
marker position during image change in the Points
measurement window

,

allows to place image windows across the width of
the Points measurement window, i.e. to “fill out” a
screen with windows if some of them were closed
allows to open the Add images window used to
select images and add them to new windows of the
Points measurement module
allows to choose images transformationmode during
their display in the Points measurement window
allows to turn on automatic refresh mode of a block
scheme as a points coordinates are measured (the
mode is turned off by default). Automatic refresh of
a block scheme applies only to images opened in
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FunctionsButtons
the Points measurement module, i.e. The local
block scheme is refreshed
allows to open a new stereo window containing
stereo image of selected images pair where it is
possible to measure points coordinates in stereo
mode. By default a stereo image открывается
стереоизображение на всю рабочую область the
Points measurement window is opened, instead
of all opened image windows. If you press the button
while holding down the Shift key, the opened stereo
window will be double size of image window, selec-
ted to be displayed in a stereo mode, Ctrl – allows
to open window with one window size to the “left”
image window location. The Esc key allows to close
the stereo window
is used to display images as a color or black-and-
white one
allows to add a tie point to marker position on all
opened images without correlation (marker is posi-
tioned manually on all images)
allows to change position of selected in a list point
on images and to add the point to marker position
on images where it was not measured
allows to move a point along tie residual vector on
all images. To display tie residuals vectors on im-
ages the button of the leftward toolbar is used
allows to move a point along GCP residual vector
on all images. To display GCP residuals vectors on
images the button of the leftward toolbar is used
allows to remove coordinates measurement of se-
lected point on all images
allows to open the Delete point measurements
window used to specify criteria of selection points
to be deleted
allows to synchronize marker on all images (С), so
the system tries to place marker on all opened im-
ages to the terrain point shown by marker on active
image (requires creation of block layout). The more
data is considered during block layout creation, the
more accurate is marker positioning
allows to open a stereo pair consisting of the “left”
image and active image as a rightward
allows to correlate the active image with the “left”
one to add a new tie point using correlator (see the
Section 6.4)
allows to correlate all opened images with the “left”
one to perform measurement of new tie point co-
ordinates using correlator
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FunctionsButtons
allows to calculate correlation coefficient (Q) of all
opened images with the “left” one and to show a
value of correlation coefficient in a status bar of each
opened image (in the “left” image status bar the
auto-correlation coefficient value is shown)
allows to open the Coefficient of correlation ana-
lyzer window used to view and analyze correlation
coefficient of the active and “left” images.
allows to open the relative orientation report for
opened images (the report will consider default
settings or previously set parameters)
allows to open the Map window used to load geor-
eferenced map (vector, raster map or DEM) to
transfer GCP from them on image opened in the
Points measurement module
allows to find on georeferenced map opened in the
Map window, terrain point pointed by marker on the
active image of the Points measurement window
(see also Section 7.7)
allows to open the Add GCP window to transfer
GCP from georeferenced map opened in the Map
window on image opened in the Points measure-
ment module
allows to show/hide toolbar on all images windows
allows to show/hide status bar on all images win-
dows
allows to open the Marker settings window used
to setup shape, size and color of marker
allows to open the Symbols window used to setup
symbols used to display measured triangulation
points according to their type
allows to open the Points measurement settings
window to specify correlator parameters and setup
of automatic display of report on relative orientation
after clicking OK in the Points measurement
module
allows to specify the active image as the “left” one

Table 5. Leftward toolbar of the “Points measurement” window

FunctionsButtons
allows to show/hide all measured triangulation points
in opened images
allows to display all triangulation points measured
in opened images using symbols, specified accord-
ing to their type in the Symbols window
allows to display names labels of triangulation points
measured in opened images
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FunctionsButtons
allows to display models by ties in symbols display
mode of triangulation points. An additional “angle”
elements are added to a tie point symbol indicating
a connection with the adjacent images (to the right
and/or left). For example, to triplet point symbol the
angle brackets will be added to the left and right
[only after Block adjustment] allows to display GCP
residuals vectors
[only after Block adjustment] allows to display tie
residuals vectors
allows to turn on/off a filter of triangulation points
display on opened images according to settings
made in the Points filter window
allows to open the Points filter window used to
choose triangulation points type to by shown in
opened images and in catalogue of the Triangula-
tion points window
allows to display overlap areas of project images
as frames in windows of opened images
allows to display overlap areas of project images
as filled polygons in windows of opened images
allows to display 6 standard zones, recommended
to be used for measurement of tie points coordinates
(see the Section 7)

5.3. Windows of opened images

Each of project images opened in the Points measurement module is displayed in a
separate window.

One of the images windows is the “left”, another is active. The “left” window may be
also an active window at the same time. Images shown in the “left” and active windows
are used for correlation during tie points measurement, and also for selecting a stereopair
to be opened in a stereo window to perform measurements in stereo mode.

At launch of the Points measurement module images containing selected point are
opened in viewing windows automatically. It is also possible to perform automatic
choosing of images containing selected point in the triangulation points catalogue using
the button of the Triangulation points window.

In order to open or add images in the Points measurementmodule, perform the follow-
ing actions:

1. Click the button. The Add images window opens.
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Fig. 38. Manual selection of images to add or open them in the “Points measurement” module

Strips and images containing highlighted tie point (in a list or on opened images) are shown
by light-green background color.

2. [optional] For automatic selecting of images containing a point highlighted in the
Triangulation points window, click the button.

3. Set checkboxes near images names to open them in the Points measurement
window.

4. Click OK. Marker in opened windows will be positioned to a supposed area of the
point position.

Each image window in the module contains the following interface elements:

• buttons of upper toolbox used to work with image:

○ , , , , – standard buttons for image management in the window;

○ – allows to add point and measurement in marker position;

○ – allows to move and add selected point to marker’s position;

○ – allows to move a point along tie residual vector;

○ – allows to move a point along GCP residual vector;

○ – allows to remove measurement results for point selected on image;

○ – allows to select image as a “left” one, with which the rest images will be cor-
related, if tie points coordinates were measured using correlator (see the Sec-
tion 6.4).

• working area used to display image and its name in the upper left part;

• the status bar with the following information:

○ image zoom ratio, marker position coordinates (in pix and mm);
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○ coefficient of image correlation with the “left” image if tie points coordinates were
measured using correlator (auto-correlation coefficient is displayed in the status
bar of the “left” image);

○ the icon used to display additional information about image.

Move the mouse to the icon, to view pop-up window with data about image size and
rotation angle, number of measured points and coordinates of marker position on image.

• right-click menu.

In the upper left corner of the image window the image name is shown for all images.
For scanner space images a sensor name and off-nadir angle (if any), obtained from
metadata are also shown in the upper right corner.

Fig. 39. Image window in the “Points measurement” module

In order to perform color correction of an image – to setup brightness, contrast and
gamma-correction – the Shift+F8 shortcut is used.

The Ctrl+F8 shortcut allows to show/hide scroll bars in the active image window.

To move an image in the window the system provides the panoramic mode – moving
an image using mouse move along with pressed Alt key.

The system also provides possibility to display a frame to make easy placing marker
to center of standard shape objects. To display the frame choose the Show frame for
centering on area objects item in the right-click menu.

To change frame size rotate the mouse wheel while holding the following keys pressed:

• H – horizontal size;

• V – vertical size;

• B – the same size on both axes.
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In order to hide the frame choose the Show frame for centering on area objects item
in the right-click menu once more.

Table 6. right-click menu of image window

FunctionsButtons
allows to add a tie point to marker position on selec-
ted image

New tie point (+)

allows to add a tie point to marker position on all
selected images without correlation (marker should
be positioned manually on all images)

Add point on all images

allows to change a position of a point selected in a
list on images and to add it to marker position on
images where it was not measured

Move/addmeasurement intomarker position
(Ins)

allows to move a point selected in a list on images
and to add it to marker position on all images

Add or move point measurements to marker
positions on all images

allows to move a point along tie error vector on all
images. To display tie residuals vectors on images
the button of the leftward toolbar is used

Move point along tie error vector

allows to move a point along GCP error vector on
all images. To display GCP residuals vectors on
images the button of the leftward toolbar is used

Move point along GCP error vector

allows to delete coordinates measurement of selec-
ted point on all images

Delete measurement (Del)

allows to specify selected image as the “left” imageLeft image (L)
allows to display a frame used to place marker to
center of standard shape objects

Show frame for centering on area objects

allows to move a marker to nearest measured point
on selected image

Move marker to the nearest point on this image
(S)

allows to move a marker to nearest measured point
on all images

Move marker to the nearest point on all images
(Shift+S)

allows to turn on the distance measuring modeDistance measuring mode (D)
allows to shift one image left in a stripShift one image left
allows to shift one image right in a stripShift one image right
allows to shift one image up on adjacent stripShift one image up
allows to shift one image down on adjacent stripShift one image down

5.4. Distance measuring

The Points measurement module provides features that allow to measure distances
on terrain (in pixels) in windows of opened images.

To calculate distance in meters use data about ground sample distance (GSD), that is specified
in the Ground sample distance (GSD) window opened using the Block › Set GSDmenu item
(see the “Project creation” User Manual).

To measure distance between terrain points on images perform the following actions:
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1. Place a marker in the first point on terrain on the image. Select the Distance
measuring mode item in the right-click menu or press the D key to turn on the
distance measuring mode.

2. Indicate the second point on terrain by left button mouse click. After that a measuring
line with indicated distance between points in pixels is displayed.

3. Press the D key once again to turn the distance measuring mode off.

Distance measuring mode allows to estimate conformity error of terrain points in images
overlap areas. This error is considered during tie points measurement in automatic
mode and is used to increase measurements accuracy (see the Section 6.3). In order
to specify conformity error, use the Search area parameter on the Search for points
tab of the Tie point measurement parameters window.

To estimate conformity error of terrain points in images overlap areas after measuring
tie points in automatic mode perform the following actions:

1. Open a block stereopair in the Points measurementmodule (see the Section 5.3).

It is recommended to estimate the conformity error on multiple stereopairs: on in-strip ste-
reopairs in different strips of a block, and on inter-strip stereopairs.

2. Indicate some point on terrain by mouse double click on one of images in overlap
area. The system perform automatic search of the same terrain point on another
image of stereopair and place marker to probable location of corresponding point.

3. Measure a distance between indicated and found point on terrain in distance
measuring mode.

Fig. 40. Distance measuring in the “Points measurement” module
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6. Relative orientation of images

6.1. Relative orientation workflow

One of the stages of building a triangulation network is images relative orientation, that
requires measured coordinates of tie points.

Tie points – the same points on the terrain on adjacent block images needed to build
single models from stereopairs and then to merge them into triangulation networks.

After measurement of tie point coordinates it is necessary to perform relative orientation
of block images, to input and measure GCP coordinates, to perform network adjustment
and to obtain exterior orientation parameters of a block.

Measuring of tie point coordinates – is stereoscopic measurement, i.e. measuring of
coordinates of the same point on both stereopair images at once (or on multiple over-
lapped adjacent images) in stereomode.

Measuring of tie point coordinates on two images of a stereopair in manual mode is
performed in the system using one of the following ways:

• manual measuring of point coordinates on each of stereopair images;

• manual measuring of point coordinates on a single image and transfer it to another
image using correlator;

• manual measuring of point coordinates on each image in stereomode;

• search of a point and measuring its coordinates on image using correlator.

The system also allows to measure tie points coordinates on block images in fully
automatic mode.

During removing images from a project it is strongly recommended to synchronize data in the
project in order to remove unnecessary results of orientation. To do this choose Project › Syn-
chronize.

The following recommendations should be considered during tie points measurement:

• to perform relative orientation it is recommended to combine two methods – first ex-
ecute automatic measurement with “bad” points filtering and than manual mode for
editing of measurements acquired in automatic mode and adding of new tie points
(to accumulate measurements that allows to increase relative orientation accuracy);

• when using only manual procedures for tie points measurement, the optimal way is
measuring at least 2 tie points in 6 standard zones for each stereopair in a strip;
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Fig. 41. Recommended zones to measure tie points coordinates in strips

• in order to consolidate images strips into a block it is recommended to measure tie
points coordinates in inter-strip overlap zones on both sides in relation to a midline
of inter-strip overlap area.

Fig. 42. Recommended location of tie points in inter-strip images overlap areas

If block adjustment is performed using independent models method, it is necessary to transfer
inter-strip tie points to at least one adjacent image in each strip. Otherwise they will be not
taken into account when using this type of block adjustment (see the “Block adjustment” User
Manual).

6.2. The “Triangulation points” window

The Triangulation points window contains a list of all triangulation points of a project
(ground control, check, and tie) and also tools for points view, search, edit, and import/ex-
port.

The Triangulation points window is opened independently or as a part of the Points
measurement module. In the independent Triangulation points window there is a
possibility to proceed to the Points measurementmodule that allows to display results
of измерений выбранной в каталоге точки триангуляции on project images.
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To open the Triangulation points window perform one of the following actions:

• choose Orientation › Tie points list or click the button on the main toolbar or on
the AT additional toolbar. В окне Triangulation points отображается the All trian-
gulation points tab is displayed;

• choose Orientation › GCP list or click the button on the main toolbar. In the Tri-
angulation points window the GCP list tab is displayed;

• open the Pointsmeasurementmodule. In the lower part of the Pointsmeasurement
module there is the Triangulation points window located on the All triangulation
points tab.

The Triangulation points window contains the following two main tabs:

• GCP list – list of ground control points both with measured coordinates and without
them;

• All triangulation points – list of all triangulation points (ground control, check, and
tie).

The title of the Triangulation points window displays a number of all triangulation
points/number of points shown in the list on selected tab.

The GCP list tab contains a list of all measured and unmeasured GC points with their
coordinates and measurements accuracy data (RMS) on terrain. Buttons of the toolbar
allow to input, view, search, edit, import and export of GCP, and for viewing of selected
point measurements on project images in the Points measurement module (see
Section 7.1).

Fig. 43. GCP list

On theAll triangulation points tab displays full list of triangulation points: all measured
tie points, measured/unmeasured GCP/check points. The toolbar allows to search, filter,
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edit, import/export and display points on project images in the Points measurement
module.

Fig. 44. Triangulation points list

Table 7. Toolbar of the “Triangulation points” window on the “All triangulation points” tab

FunctionsButtons
allows to refresh the points list
allows to open the Find window allowing to search
a point by its name. Input full name or its part, define
the search direction and click the Find next button.
Found point is highlighted in the list. The Points
measurementmodule shows all positions of found
point on images
allows to remove selected points from a list. To se-
lect multiple points use Shift and Ctrl keys
allows to remove all triangulation points from a list
allows to use selected points as tie points («+»), if
these points were excluded previously («-») (Ctrl+I).
In this case previously excluded GC point, that is
measured on multiple images, is used only as tie.
In order to use the point as a GCP, select the Ground
Control type on the GCP list tab in editing mode
allows to not use selected points as tie points, i.e.
to exclude the points from calculation of relative
orientation (Ctrl+E). Excluded point is marked by
«-» sign, but is not removed. When excluding GC
point with measurements on multiple images, it will
be excluded both by GCP and by tie
allows to assign numeric names to highlighted points
(to rename points)
allows to perform import of triangulation points from
PAT-B, X-Points, and from PHOTOMOD 4.x
allows to perform export of triangulation points to
PAT-B and X-Points
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FunctionsButtons
allows to open the Point properties window used
to display name, type, code and coordinates of se-
lected point
allows to display point selected in a list on images
(is duplicated by mouse double click on the point in
a list) (see the Section 5.3)
allows to setup accuracy control parameters and to
open relative orientation report
allows to display all triangulation points in a list, in-
cluding non-measured GCP/check points
allows to display all points on opened images in the
Points measurementmodule. This filter is applied
both to records in the list, and to points display on
images in the Points measurement module. The
title of the Triangulation points window displays
number of points selected after filtration
allows to display only common points on opened
images. This filter is applied both to records in the
list, and to points display on images in the Points
measurement module. The title of the Triangula-
tion points window displays number of points se-
lected after filtration
allows to display values of Y-parallax and triplet re-
siduals for points in the list in pixels
allows to display values of Y-parallax and triplet re-
siduals for points in the list in millimeters
allows to enable automatic search for images con-
taining the point’s position: if the mode is enabled,
the button or mouse double click on a row with
the point in coordinates list allows to open the im-
ages in the Pointsmeasurementmodule, on which
selected point coordinates are already measured,
otherwise, to open all images that contain the point’s
coordinates

In order to invert work of the mode (change its state to the opposite) for a short time, click
the Alt key and select a point using mouse double click or click the button.

When toggling between and modes and some point is selected in the list and is not cor-
responding to chosen mode, it is displayed by grey color in the table.

The list of triangulation points is a table.

Points sorting in columns of the list is performed by mouse click on the column header.
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Table 8. Types of table columns – list of points on the “All triangulation points” tab

FunctionsButtons
displays point’s codeCode
displays point’s nameName
displays point’s type (tie, GCP, check, excluded)Type
displays «+», if the point is used for calculating of
relative orientation, «-», if the point is excluded from

Tie point included

calculation. When a tie point is excluded all values
in columns are inactive. When a GCP is excluded,
it is excluded completely by ground control and by
tie, and in the Type field the Excluded value is
displayed
displays «+», if the point is measured in automatic
mode (see the Section 6.3) or «-», if the point’s co-
ordinates are measured manually

Point measured automatically

displays number of images where point’s coordin-
ates were measured

Total measurements

displays number of strips with the point’s coordinates
measurements

Strips with point measurements

displays «+», if the point’s coordinates are measured
on a single image (with no ties) only, otherwise «-»

Measured on a single image

displays «+», the point’s coordinates are measured
on stereopairs, otherwise «-»

Measured on stereopairs

displays «+», the point’s coordinates are measured
in triplet, otherwise «-»

Measured in triplets

displays «+», if interstrip point is single within one
of the strips or «-», if it is not single within a strip
(i.e. is measured on stereopair or in triplet)

Stripswithmeasurements on isolated images

displays «+», if the point’s coordinates are measured
on images of non-adjacent strips, otherwise «-»

Measurements on non-adjacent strips

displays correlation coefficient, if the point’s coordin-
ates were measured using correlator

Minimum correlation coefficient

displays Y-parallax (in pix or mm), if stereopairs are
opened in the Points measurement module and
relative orientation is done

Max Y-par

displays triplet residual by XY for a point with
measurements in triple overlap area (in pix or mm),

Max Exy

if the triplets are opened in the Points measure-
ment module
displays triplet residual by Z for a point with meas-
urements in triple overlap area (in pix or mm), if the

Max Ez

triplets are opened in the Points measurement
module

During executing of relative orientation it is recommended to set the following threshold
values:
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• correlation coefficient threshold – 0.9-0.95;

• maximal Y-parallax – no more than the pixel size;

• values of threshold on maximal error in triplets are calculated using the following
formula:

Emax ≈ 2 Emean , where Emean – average error threshold;

• average error by XY is calculated using the following formula:

Emean
xy = 2 0.5pix

average error by Z – is average error by XY, multiplied by ratio of the camera focal
length (f) to the survey basis (b):

Emean
z = f

b Emean
xy .

6.3. Automatic measurement of tie points coordinates

6.3.1. Work sequence and conditions

The system provides possibility to measure tie points coordinates and perform relative
orientation in automatic mode. When working in automatic mode correlation algorithm
is used for search and measurement of tie points coordinates.

To perform automatic measurement of tie point coordinates the following data should
be available:

• interior orientation parameters of images, which will be considered in automatic
measurement of points coordinates;

It is highly recommended to perform interior orientation prior to automatic search of tie points,
since otherwise most of the filtering parameters are ignored, that considerably reduces relative
orientation quality.

• block layout.

Sufficient condition for launch the operation of automatic measurement of tie points coordinates
is availability of initial (“rough”) block layout, considering, for example, size of images overlap
and/or quick ties data. However, the more data is used for the block layout creation, the more
accurate is the block scheme and, hence, the better the results of measurement of tie points
coordinates in automatic mode.

To measure tie points in automatic mode perform the following actions:
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1. Create a block layout considering available data.

2. Setup parameters of tie points automatic measurement, transfer, filtering and start
the operation of automatic measurement of tie points coordinates.

3. Perform accuracy estimation of relative orientation and detecting of tie points
measurement errors.

4. Manually eliminate errors of tie points measurement in the Points measurement
module or choose other filtering parameters (for example, specify more “strict” tol-
erances for measurement errors) and start the operation of automatic measurement
of tie points coordinates once more.

5. Update block layout considering tie points. Change settings of automatic tie point
measurement parameters if necessary and start once more operation of further
collecting of tie points measurements. Repeat steps 3-4 until obtain satisfactory
results.

6.3.2. Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1. Open the Automatic tie points measurement window using one of the following
ways:

• choose Orientation › Automatic tie point measurement;

• click the button of the system main toolbar;

• click the button of the AT additional toolbar.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox on theOrientation tab of the Parameters window.

2. Use default setting of measurement parameters or set manually themain parameters
for tie points search, measure and filter.

3. [optional] For more detailed tuning and refining of themainmeasurement parameters
set the additional parameters.

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Click the Distributed processing... button. The Distributed measurement
of tie points window opens.
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The Maximum number of tasks for this project value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.

Fig. 45. Parameters of distributed measurement of tie points in automatic mode

2. Specify the Number of tasks to create, which will be processed on one com-
puter. See the description of distributed processing setup in the General inform-
ation User Manual.

3. Click OK to go back to previous window.

5. Click the Start button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.

6.3.3. Main parameters of tie points measurement

The Automatic tie points measurement window allows to use presets for tie points
coordinates measurement (for airborne and UAS images) or to manually select optimal
combinations of main and additional parameters used for automatic tie points search,
measurement and filtering.

Open theAutomatic tie points measurementwindow using one of the following ways:

• choose Orientation › Automatic tie points measurement;

• click the button of the main system toolbar;

• click the button of the AT additional toolbar.
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Fig. 46. The “Automatic tie points measurement” window

The Automatic tie points measurement window includes the following interface ele-
ments:

• the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

• a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

• the Tasks section used to specify main actions (measurement, transfer, filtering, re-
porting) during operation of automatic measuring of tie points coordinates;

• the Parameters section used to specify main parameters of automatic measuring of
tie points coordinates;

• the More button used to setup additional parameters of measuring of tie points co-
ordinates;

• the Start button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.
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The system provides the following buttons in the toolbar to work with auxiliary windows:

• – allows to select triplets without tie points for repeated measures (these points
are marked as “not performed”), and their adjacent images (it allows optimize the
measurement time points);

• – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

• – allows to open the block layout window to create a block layout or update it;

• – allows to open theRelative orientation report settingswindow used to specify
parameters and view a relative orientation report;

• – allows to open the Triangulation points window used to view a list of triangula-
tion points;

• – allows to open the Points measurement module and open automatically open
images selected in the list, if more than 6 images are chosen. Otherwise, an in-strip
stereopair with image selected in the list will be opened.

To save and load sets of main and auxiliary parameters the system provides the following
buttons:

• – is used to load a set of parameters from *.x-ini file saved previously in active
profile resources or out of them.

The arrow located next to the button allows to open a drop-down menu containing
the following items:

○ Load settings from file allows to open the Load settings window used to load a
set of parameters from *.x-ini file, located out of active profile resources;

○ Reset settings to defaults allows to use default settings;

○ UAS allows to load preset of parameters optimally selected for UAS images.
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Fig. 47. Example set of basic parameters for the UAS

During tie points measurement for UAS images it is recommended to perform search in
two steps: on the first one - search for tie points only inside strips, on the second step –
just between strips, at that it is not recommended to use the Transfer tie points option.

• – used to save setting of main and additional parameters to a file with *.x-ini
extension in active profile resources.

To save setting to a file with *.x-ini extension located out of active profile resources, open
drop-down list by clicking the arrow next to the button and choose Save settings to file....

Setting saving is used to create files with settings directed to work with certain type of block,
kind of images, or terrain, etc.

The Tasks section is used to specify the following actions during automatic tie points
measurement:

• Measure tie points in stereopairs allows to perform search and measurement of
tie points coordinates on in-strip and inter-strip stereopairs;

A stereopair is called in-strip, if it is formed by two adjacent images in a strip, and inter-strip
is any other stereopair of a block.
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• Transfer tie points allows to perform transfer of measured points to adjacent stereo-
pairs (transfer of points located in triple overlap area to adjacent models), and transfer
of tie points to adjacent strips;

• Filter tie points by relative orientation allows to perform points filtering that have
measurements, exceeding specified values of errors thresholds;

Points check if to filter them or not, is performed sequentially by errors type – first check -
whether the point falls within specified correlation threshold, then whether it does not exceed
maximal vertical parallax value, and finally, search for triplet errors is performed, if the appro-
priate option is specified.

Check for exceeding correlation threshold is applied only to new points (if measured points
are already available). In order to check all points whether they exceed correlation threshold,
set the additionalDelete points with correlation below threshold checkbox on theRejection
tab in the Tie point measurement parameters window of additional parameters.

It is possible to perform actions with tie points inside strips, between strips, or not perform at
all.

• Filter tie points by adjustment results allows to perform automatic block adjustment
using specified parameters and to filter measured tie points after that;

Points filtering using adjustment results is applied if there are blunders on images between
strips. The filtering is performed using residuals tolerance specified in the Adjustment
parameters window, see the “Block adjustment” User Manual.

• Report on relative orientation on completion allows to open the Relative orient-
ation reportwindow automatically to view and edit tie points measurements just after
completing of automatic relative orientation.

TheParameters section allows tomake the following settings of automatic measurement
of tie points coordinates:

• Points per stereopair – allows to specify a number of points to be measured on in-
strip and inter-strip stereopairs;

Resulting amount of measured points may be either greater than a predetermined amount –
because of points transfer from adjacent stereopairs, or less due to further filtering. Default
amount of points is 30 per each images pair in forward overlap and 10 points in side overlap.
The minimum number of points to perform control by the vertical parallax residual – 6 points.

The Points per stereopair parameter depends on settings defined on the Miscellaneous
tab in the Tie point measurement parameters window.

• Correlation threshold (%) – minimal acceptable value of correlation coefficient for
tie points, that will be selected during automatic search;

82

Aerial triangulationPHOTOMOD 6.0.2

solver.pdf


Recommended values lie in range from 90 to 95%. In contrast to all other filtering criteria,
this parameter directly influences on operation of points measurement and transfer. Check
for exceeding of correlation threshold is performed only for new points (if there are already
measured points). To check all measured points for exceeding of correlation threshold (usually,
at final stage of collecting measurements of tie points) set the additional Delete points with
correlation below threshold checkbox on the Rejection tab in the additional parameters
window.

• Maximum vertical parallax (in pixels or mm) – threshold value for rejection executed
after points measuring/transfer. On each step of rejection process, the program
searches for the point with maximal Y-parallax on the stereopair and rejects it. After
that, it makes relative orientation once more and the iteration is executed until max-
imal Y-parallax exceeds the parameter specified here, or until 6 points or less remain
on stereopair. Recommended value is a pixel size;

• Maximumerror in triplets in XY-plane and by Z (in pixels, meters or mm) – threshold
discrepancy of points measurements on adjacent stereopairs in triple overlapping
zone of adjacent images in a strip. Use the following formula to calculate values of
acceptable errors in triplets:

Emax ≈ 2 Emean , where Emean – acceptable mean error.

Mean triplet errors in XY plane is calculated using the following formula:

RMS ≈ 2 Emean

Mean error by Z equals the mean error value in XY plane multiplied by the ratio of
focal length (f) to survey basis (b):

Emean
z = f

b Emean
xy .

• Measure points by zones – allows to apply a method of sequential measurement
by zones of overlap area. If the checkbox is cleared, points search is performed over
the whole area of images overlap. The system allows to select zones and define their
size in the Zones section on the Miscellaneous tab of the additional parameters
window;

• Filter points by zones – is used to filter points in stereopair zones sequentially;

The operation provides filtering the worst (by parallax) points on stereopair, passing zone by
zone one after another. So the worst point on stereopair is found and deleted first, then the
worst one in the next zone and so on. Uniformity of point’s distribution on stereopair is also
verified in such a way.
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• DEM – allows to choose a DEM (if any) to consider its data during automatic tie points
measurement. For this it is necessary to have saved adjustment results available.

This parameter allows to use DEM for calculation of the true position of the point. Thereby
the required search area of points reduces.

6.3.4. Additional parameters of automatic measurement of tie points
coordinates

For more detailed setup and adjustment and refinement of the basic parameters of tie
points coordinates measurement the Tie point measurement parameters window of
additional parameters is used. It is opened using the More button located in the main
Automatic tie point measurement window.

Fig. 48. Points search parameters

The Tie point measurement parameters window contains four tabs with parameters.

To reset to default parameters, delete the ProjCorrMatchOptions.x-ini file located in the project
root folder.

The Search for points tab allows to setup the following parameters:

• Search area (pix) – allows to specify a “halfsize” of area of matching point search;

• Contrast point search area (pix) allows to search tie points in areas with maximal
contrast (on images with clear objects outlines);

In some cases it is reasonable to measure points in areas with low contrast, for example,
when forested areas have maximal contrast, and in these areas correlator’s errors are very
probable. In this case the Contrast point search area value should be set to 0.
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• Tries per point – number of tries of matching point search with correlation coefficient
value that exceeds specified in the search area;

• Multipass points search allows to perform points search and filtering on stereopairs
in multiple passes with help of different algorithms. It is applied in case of insufficient
quality of the block layout, when real relative rotation of images relative to each other
is sufficiently big;

For multipass points search it is recommended to set correlation threshold high enough, for
example, 95%.

It is recommended to use multipass points search for UAS images.

• Search the whole images area allows to specify images pairs to search points: ad-
jacent images in each strip and/or non-adjacent pairs of images in a strip and inter-
strip pairs of images.

Fig. 49. Parameters of correlator

The Correlator tab is used to setup parameters of area correlator work and contains
the following parameters:

• Correlation matrix half size (pix) allows to specify size of correlation matrix by X
and Y axes;

• Autocorrelation control allows to specify level of auto-correlation – the Maximum
value of sigma in Gaussoid that is the top limit of distribution of the mask correlation
coefficient in a small area on the same image. The more the sigma value, the less
probability of correct points measurement, which were measured using correlation
with the given point as an initial one;

• Do not use image border area is used to specify a size of area near the image
border, that is not used during correlation operation;

Service area width (2% of image width and height by default) should not be less than on the
image; otherwise a big amount of “bad” points would be measured in image service areas.
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• the Image blur slider is used to consider image material quality, from No to Strong
blur.

For images without blur or with negligible blur it is highly not recommended to place the slider
to position different from No.

In most cases the Image blur parameter is applied for processing of UAS images block.

Fig. 50. Filtering parameters

The Rejection tab is used to setup filtering parameters of points found and contains
the following options:

• Preliminary filtering with detection of trusted points group is used to preliminary
filtering of blunders, that do not allow calculate correctly angular elements of relative
orientation (see the parameters of trusted points group on the Miscellaneous tab);

• Delete all tie points, if after filtering number of them left is less then specified
number – allows to delete all tie points on a stereopair, acquired during operation of
automatic measurement of points coordinates, if after their filtering their number is
not sufficient to perform correct relative orientation;

• Deletemeasurements on non-adjacent images allows to filter potentially erroneous
points, measured on non-adjacent images inside a strip;

To measure tie points for UAS images in two steps it is recommended to set the Delete
measurements on non-adjacent images checkbox on the first step and to not to use this
parameter on the second step.

• Delete single points allows to reject points measured on single images;

• Delete points with correlation below threshold allows to delete points previously
measured using correlator, if their correlation coefficient in below threshold value
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specified in theCorrelation threshold field of theAutomatic tie point measurement
window;

It is recommended to use the option for recurrent or final points filtration, since the filtering
covers all measured points, not only new ones, added during just another start of automatic
tie points measurement operation.

• Delete points surplus allows to delete points, if their number exceeds number spe-
cified in the Points per stereopair field of the Automatic tie point measurement
window, sorted by the Y-parallax in descending order;

The parameter considers whether the Filter points by zones checkbox is marked, that allows
to delete points evenly. It is recommended to use the option after the initial tie points meas-
urement on UAS images.

The points are deleted regardless of type and number of measurements per point (the system
may delete both GC point and the points in triple overlap).

• Check correlation of measurements transferred from other stereopairs is used
to check on each stereopair correlation coefficient of measurements, collected during
points transfer from other stereopairs, since the chain of such transfers may lead to
errors accumulation and bring unacceptable result;

• X-parallax clipping (%) allows to specify number of points with minimal and maximal
x-parallax (relatively to total amount of points) which will be deleted after filtering in
strip and between strips.

It is recommended to apply this rejection method if erroneous points are dispersed clearly
along stereopair basis (if, for example, a highway with bright marking goes in parallel to survey
basis and correlator puts points on marking line elements, which do not correspond with each
other.

• Check by reverse stereopair –allows to check the search results on reverse stereo-
pair; if the results are not equal, point deletes;
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Fig. 51. Miscellaneous parameters

TheMiscellaneous tab contains sections and options to setup the following additional
parameters:

• Number automatically measured points starting with is used for automatic num-
bering of measured tie points starting with number, specified in the entry field, that
allows to distinguish these points from the ones already measured on the project
images;

Regardless of the set value, the system does not generate points with duplicate numbers. If
the point with some number already exists, then this number will be skipped when creating
new points.

• Minimum distance between points (pix) allows to specify minimal distance in pixels
between points measured on the image;

It is recommended to increase the value of this parameter, when the problems with block
adjustment occur. The parameter is considered only during measurement new points. Existing
tie points are not rejected.

• Minimal dispersion allows to specify minimal dispersion of mask to protect from
points search on the clouds and water bodies;

The option is used to exclude points in monotonous areas, for example, for satellite scanner
images, if there are black strips on images borders, and for overexposure due to cloudiness.
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• Pyramid level for preliminary search (only for central projection images) – allows
to choose an image pyramid level used to preliminary search of points. If the checkbox
is set on, preliminary search is performed by source image;

• Fixed search sequence – allows to obtain the same results of automatic measure-
ment of tie points coordinates during multiple runs of the operation with the same
initial parameters;

• Use automatic block layout results allows to use the block layout results, automat-
ically created for UAS images;

If the automatically generated block layout is available, then during automatic measurement
of tie points coordinates information from current block scheme is not used, and the Search
the whole images area parameter is also ignored. The default search parameters are used
only (considering data of automatic block layout).

• The “Points per stereopair” parameter influences on the Points per stereopair
parameters located in the Automatic tie point measurement window and allows to
select the following number of points:

○ Points to add per session – values specified in the main window, that mean a
number of new points, which will be added to already measured ones;

○ Target number of points on a stereopair – values specified in the main window,
that define total points number;

The resulting number of measured points may be both greater than a predetermined amount –
due to points transfer from adjacent stereopairs, and less due to the subsequent rejection of
points. Default value is 30 points on each in-strip images pair, and 10 points – in inter-strip
overlap. The minimum number of points to control the vertical parallax residual is 6.

• parameters which allow to specify trusted points group to be used as a master sample
for points rejection (see the Preliminary filtering with detection of trusted points
group parameter on the Rejection tab). A group of points is considered as trusted
if the following two conditions are met during the points search:

1. The distance between the point on one image and the corresponding point on
another image should not exceed the parameter specified in the Maximum
spread radius within trusted points group input field.

2. Number of points found, which satisfy to the first condition should not be less
than the parameter specified in the Minimum trusted points group size input
field.

If a trusted group has been found, it supposedly means that angles of relative orient-
ation have been computed correctly and the points rejection can be performed using
these data. Otherwise, the rejection of points will not be executed, even if the Prelim-
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inary filtering with detection of trusted points group checkbox is set on the Re-
jection tab.

TheMaximumpoints to use filtering by trusted group parameter is used to specify
the limitation on the number of points to reject.

It is recommended to set theMaximum points to use filtering by trusted group value from
40 to 60. It is not recommended to set more than 60 points.

The Stereopairs section contains the following parameters:

• Create stereopairs based on exterior orientation data, from images, projection
centers of which are within range of – if this option is checked, the stereopairs will
be composed from images, projection centers of which are located at the distance
no more than a specified value (in meters), otherwise, the stereopairs are composed
from nearest images in a strip.

• From different strips only – if this option is checked, the in-strip stereopairs will not
be considered. Otherwise, all in-strip stereopairs will be considered, including the
nonadjacent.

Fig. 52. Miscellaneous parameters

The Zones section allows to define a zone size on a stereopair, where the system
performs automatic search and measurement of tie points coordinates. Information
about recommended zones is located in the Section 6.1.

The Points transfer section contains the following parameters:
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• Strict limits for initial point position – if the checkbox is set, the system performs
search for a point only inside of image, otherwise, the search is possible out of the
image boundary, if the Search area parameter value on the Search for points tab
exceeds the image size.

• Automatically transfer manually measured – allows to transfer tie and/or GCP,
measured manually.

• Automatically reject manually measured – if the checkbox set on, tie and/or GC
points manually measured are not transferred.

• Points, measured automatically – allows to transfer and filterGC points, measured
automatically.

If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

The Rejection by angles section allows to specify parameters of measured points fil-
tering by single or multiple relative orientation parameters of the right or left image.

In some cases after automatic measurement of tie points coordinates due to erroneous
points the images are rotated in a block and their relative orientation parameters are
calculated incorrectly. To prevent images rotation the filtering of measured tie points
by the values of the rotation angle is used. To do this it is necessary to change angles
threshold value (in degrees) for each of stereopair elements. As a result, the points
which cause exceeding of angles thresholds will be rejected after relative orientation
recalculation.

It is not recommended to use this method of rejection for blocks, in which the images can actually
be rotated in relation to each other, since in this case the likelihood of removing properly placed
tie points increases.

6.4. Measurement of tie points coordinates

ThePointsmeasurementmodule provides tools used to measure tie points coordinates
manually without correlation or using correlator.

Measurement of tie points coordinates without correlation – adding tie point to marker
position on opened images.

Measurement of tie points coordinates using correlation – automatic search on project
images for a terrain point, that corresponds to a point specified by marker on the “left”
image, and further attempt of the system to calculate correlation coefficient to make a
decision about adding of tie point. A point search using correlator depends on the cor-
relator parameters settings.
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For tie points measuring/editing without correlator the Points measurement module
provides the following features:

• to measure tie point coordinates perform the following actions:

1. Choose and open image to measure tie points coordinates (see the Section 5.3).

2. Choose and show using marker the same terrain point on opened images.

3. Click the button of the upper toolbar of the Points measurement window. A
new tie point is added to the triangulation points list and is displayed on opened
images (see also Section 8.2).

• to transfer already measured tie point into specified marker position with adding
measurements of this point to another image perform the following actions:

1. Open images with measurements of selected tie point and (if needed) images,
containing the same terrain point, but without measurements (see Section 5.3).

2. Show by marker new position of tie point on all opened images.

3. Click the button of the upper toolbar of the Points measurement window. Tie
point is transferred/added to specified marker position on images. Tie points
measurements are updated in the triangulation points list.

During adding of a point located out of image border, a point without coordinates values is created
in the table. At that after saving the points list data with blank record and the point on image will
be removed.

The Points measurement module provides the following opportunities for tie points
measurements using correlator:

• to correlate active image with “left” and to add tie point, perform the following actions:

1. Choose and open images to measure tie points coordinates (see the Section 5.3).

2. Choose the “left” image and click the button in the toolbar of this image window.

3. Show by marker a terrain point on the “left” image.

4. Show by marker a terrain point on the active image different from the “left” one,
that approximately corresponds to this point.

The active image window is highlighted by blue frame.

5. [optional] In order to place marker on all opened images to marker position on
the active image, double click selected terrain point on the image.
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When place marker within a radius of 10 pixels around existing tie point, an existing
point will be edited during using the correlator, rather than a new point will be created.

6. Click the button of the upper toolbar of the Points measurement window.
After correlation operation one of the following events will occur:

○ if the system failed to calculate correlation coefficient, the “Bad point” warning
will appear;

○ if correlation coefficient is calculated successfully, the New tie point window
opens. The window displays point’s code and name (by default) (for its editing
it is possible to use any symbols), and calculated correlation coefficient.

Fig. 53. Correlation of the active image with the “left” image

Data display in the coefficients table depends on values of the Correlation
threshold for points measurement and Correlation threshold for marker
movement parameters, specified in the Points measurements settings
window.
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Fig. 54. Adding a point depending on degree of images correlation

When adding a new tie point, the panel with the Code and Name fields is of yellow
color, when editing existing point it is green.

7. Make a decision about adding of new tie point. To add a point set checkboxes
next to selected images in the list and click OK, otherwise click theCancel button.

• to correlate all opened image with the “left” image in order to add a tie point, perform
the following actions:

1. Choose and open images to measure tie points coordinates.

2. Choose the “left” image and click the button in the toolbar of this image window.

For correlation of all opened images with the active image, it is not necessary to choose
the “left” image.
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3. Show by marker a terrain point on the “left” image.

4. Show by marker on other opened images a terrain point, that approximately
corresponds to this point.

5. Click the button on the upper toolbar of the Points measurement window or
use the Ctrl+Space shortcut. After the correlation operation the New tie point
window opens, that allows to analyse correlation coefficients and make a decision
whether to add a new tie point or there is a warning “Bad point” (see the descrip-
tion above).

Fig. 55. Correlation of all opened images with the “left” image

6. To add a point select images in the list (set appropriate checkboxes) and click
OK, otherwise click the Cancel button.

The button on the upper toolbar of the Points measurement window is used to view
correlation coefficients of all images with the “left” image without adding of a tie point. In the
status bar of each image window, which is correlated to the “left” image, the correlation
coefficient is displayed. And in the status bar of the “left” image there is the auto-correlation
coefficient.

The button on the upper toolbar of the Points measurement window is used for
detailed analysis of correlation coefficient of active image with the “left” image. Click
this button to open the Coefficient of correlation analyzer window.
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Fig. 56. Analyzer of correlation coefficient

To analyze the quality of correlation peak click the button. A gaussoid surface will
be displayed on a scheme with center in maximal correlation position. To setup the σ
value of gaussoid, press and hold the button, then select necessary value using the

slider .

If the same image is chosen as the “left” and active, the auto-correlation sigma is displayed –
minimal sigma value, at which no one peak within 10 pixel radius is not out of gaussoid.

6.5. Parameters of points coordinates measurement

Semi-automatic search and measurement of tie points coordinates using correlation
algorithm includes matching of corresponding fragments of images considering maximal
relative coefficient of correlation. A point search using correlator depends on the correl-
ator parameters settings.

In order to open the Points measurement settings window click the button on the
upper toolbar of the Points measurement module.

Fig. 57. Points measurement settings
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When the Show report after finished editing checkbox is set, relative orientation report
is opened after clicking OK in the Points measurement module. The

Correlator section contains the following parameters used to setup correlator using
during tie points measurement or for analysis of correlation coefficients (using the ,

, , buttons of the Points measurement module):

• Correlation matrix halfsize (in pixels) – allows to specify size of correlation matrix
by X and Y axes;

• Contrast point search area (in pixels) – allows to specify area where to perform a
search for a point of maximal contrast;

It is recommended to use this parameter for images with big percent of one-colour areas.

• Corresponding point search area (in pixels) – allows to specify area where to per-
form a search for a terrain point, that corresponds to a point of the “left” image (area
around marker);

• Correlation threshold – allows to define a value of correlation threshold for point
coordinates measurements and for marker movement. These values influence
on search and measurement of tie points coordinate in the following way:
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Fig. 58. Adding a point depending on degree of images correlation

6.6. Editing of tie points

The system allows to edit tie points, and to change points type in a list.

To change point’s position highlight it using one of the following ways:

• chooseOrientation › Tie points list or click the button of theAT additional toolbar.
The Triangulation points window opens. Select a point to be edited in the table by
double mouse click;

• in the image window of the Points measurementmodule double click a point’s area;

• in the Triangulation points window of the Points measurement module select a
point to be edited by mouse double click;

• during the adjustment step; perform the following actions:
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1. Select a point on a block scheme or in a list, which error exceeds specified
threshold value.

2. Click the button. The Information window opens.

3. Click the Measure button.

As a result marker is placed to a position of selected point on all images/only on images
with point measurements.

To change point’s position perform one of the following actions:

• change point’s position manually or using correlator in the same way as during
measurement of point’s coordinates;

• click the button of image window toolbar, to move the point along vector of the tie
error on a single image, or click the button of the upper toolbar, to move the point
on all images;

• click the button of image window toolbar, to move the point along vector of the
GCP error on a single image, or click the button of the upper toolbar, to move the
point on all images.

To display vectors of tie and GCP errors the system provides the and buttons of the left
toolbar correspondingly.

When using the , , , buttons to change over block images a marker is fixed to selected
point position. To fix a marker in relation to image border, it is possible to use theAlt+H shortcut.

Click the Apply button to confirm the changes or click OK to confirm the changes and
exit from the Points measurement module.

Change of the point type is provided in the following windows:

• the Exterior orientation parameters window;

Excluded GCP are not considered during block adjustment. It is recommended to use the
Excluded type for non-measured GC points prior block adjustment operation.

• the GCP list and All triangulation points tabs of the Triangulation points window;

• the Point properties window.

6.7. Measurement of tie points coordinates in stereo mode

The system provides possibility to measure points coordinates in a stereomode.
Measurement of tie points coordinates in a stereomode are required when the points
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are located on high objects, or at the bottom corner of the building (so that in the mono
mode a point is not visible on the second image of the stereopair).

There are the following two modes of points measurement in stereo mode on selected
stereopair in the Points measurement module:

• measurement of points coordinates in moving marker mode;

• measurement of points coordinates in fixed marker mode in stereocomparator (set
by default).

Stereocomparator mode – a mode with marker fixed in the center of the window. In
stereocomparator mode it is possible to move an image using pressed left mouse button.
At that marker remains fixed in the window center. The main advantage of this kind of
stereo measurements is that it is possible to position the marker with sub-pixel accuracy.
The pixel size depends on the current zoom and the marker moving step is defined by
the sensitivity slider located at the bottom of the stereo window. Stereocomparator
mode is used either to work with in-strip stereopairs for measuring of tie points coordin-
ates in images overlap area, or for measurement of tie points between strips in inter-
strip overlap area.

For points coordinates measurement in stereomode the stereoimage window is used.
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Fig. 59. Stereoimage in stereocomparator mode

Stereowindow toolbar contains the following information and buttons:

• , , , , – standard buttons used to manage image in the window;

• (Ctrl+F6) - allows to turn on/off stereocomparator mode;

• (F11) – allows to switch stereo phase (to swap “left” and “right” images);

• – is used to add new tie point;

• – is used to move and add a point to marker position;

• – is used to remove a point from stereoimage;

• – allows to create epipolar images by points, if at least five tie points coordinates
are measured;

Creating of epipolar images (images for which Y-parallax tends to zero) is available when
there are at least 5 measured tie points on stereopair.
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• – allows to create epipolar images using adjustment results, if it is possible (if
there are adjustment results available);

• – allows to show/hide the control panel used to setup a stereo image (in lower
stereowindow corners);

• a name of opened stereopair image;

• a value of Y-parallax Y-par (in pix) on selected tie point (available only for in-strip
stereopairs).

In the lower part of stereo window there are control panels used to adjust images and
manage their movements.

Left group of red arrows is used to move the left image of stereopair (Shift + arrow
keys).

The group of grey arrows (duplicated by arrow keys of the keyboard) is used to move
left and right images at once.

The group of light blue arrows allows to move the right image (Ctrl + arrow keys).

The additional buttons on the right group of arrows allow to perform the following actions:

• – zoom in the right image scale on 5% (along with pressed Shift key – on 1%);

• – zoom out the right image scale on 5% (along with pressed Shift key – on 1%);

• 1:1 – reset the right image to 1:1 scale.

The Step slider is used for sensitivity adjustment of mouse move, mouse wheel rotation
and actions of keyboard arrows. Move step is changed from 0.1 to 20 of current screen
pixel size (which corresponds to current zoom level), and is also setup using the following
shortcuts: Ctrl+0, Ctrl+1... Ctrl+9.

“Steering-wheels” are used for images rotation. The left “steering-wheel” is intended
for both images rotation at once (by clicking on the wheel field or entering rotation angle
value into numeric field). And the right wheel – for right image rotation. If it is necessary
to restore the initial image position, use double click on the numeric field.
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To display the panel used to adjust the image brightness, contrast and gamma-correction
for a single image or both images of a stereopair use the Shift+F8 shortcut.

The , , sliders are used to adjust a brightness, contrast and gamma-correction
of a stereoimage. Tools located in the right part allow to select left, right or both images,
and also color channels, which correction settings will be applied to.

It is possible to setup parameters for all channels at once if the button is pressed
down, otherwise the system allows to setup individual channel.

Fig. 60. Panel used to adjust image brightness and contrast

It is possible to setup parameters for both stereopair images at once if the button is
pressed down, otherwise, separately for the right stereopair image or for the left one

.

To restore brightness and contrast settings to default values, right click the settings
panel and select the Reset item.

Brightness, contrast and gamma settings are not restored after the module restart.

To measure points coordinates in stereomode perform the following actions:

1. In the Points measurement window select “left” and active images of a stereopair.

2. Specify approximately by marker the same terrain points on these images and click
the button of the main toolbar of the Points measurement module. By default
a single window with stereoimage instead of all opened windows of images will be
opened in the module.

Click the button while holding pressed the Shift key to open a stereo window with size
of two images on place of the “left” and active images; or hold the Ctrl key to open a stereo
window with size of one window on place of the “left” image.

The Esc key allows to close a stereo window and to go back to opened windows of the
Points measurement module.

3. Click the button or use the Ctrl+F6 shortcut to turn on the stereocomparator
mode (which is on by default).

4. To measure points coordinates in stereocomparator mode perform the following
actions:

1. Place a marker at the terrain point.
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2. Remove a X-parallax, rotating mouse wheel or using horizontal arrows to move
left or right image.

3. To measure coordinates of a new tie point click the button. As a result of
correlation one of the following events occurs:

• The “Bad point” warning is displayed if the system failed to calculate correla-
tion coefficient;

• The New tie point window opens if correlation coefficient is calculated suc-
cessfully. The window shows the point code and name (by default), and also
calculated correlation coefficient. It is possible to use any symbols to edit the
point’s name.

Fig. 61. Correlation of the active image with the “left” one

Data display in coefficients table depends on values of parameters Correla-
tion threshold for points measurements and Correlation threshold for
marker movement specified in the Points measurement settings window
(see the Section 6.5).
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Fig. 62. Adding a point depending on degree of images correlation

4. Make a decision on adding a new tie point. To add a point set checkboxes to
select images in the list and click OK, or click the Cancel button to cancel op-
eration.

5. [optional] To move current selected tie point to marker’s position click the
button.

6. If calculated value of Y-parallax for this point is not satisfactory it is necessary
to re-measure the point. At that for better positioning of the image it is necessary
to rotate mouse wheel while holding pressed the Ctrl key or to rotate vertical
arrows of the left and right images to eliminate vertical parallax.

Maximal acceptable value of the vertical parallax is one pixel.
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5. [optional] To turn on the moving marker mode click the button once more (to
turn the stereocomparator mode off) or use the Ctrl+F6 shortcut. When measuring
tie points in the moving marker mode use the following tricks to remove parallaxes:

• mouse wheel+Ctrl – allows to change marker’s parallax;

• mouse wheel+Shift – allows to change X-parallax;

• mouse wheel+Ctrl+Shift – allows to change Y-parallax.

6. Close stereo window to return to the Points measurement window.

6.8. Point properties

In order to view selected point properties click the button of the Triangulation points
window. The Point properties window opens.

Fig. 63. Point properties

The window displays the following information about point:

• the Name field allows to change a name of selected point;

• the Code field shows a code assigned to selected point (not editable);

• the Type section allows to change a type of selected point and to make it Check,
Ground control, Tie or to exclude it from orientation;

• set the Unused tie point checkbox if a point is not used as tie point;

• the Targeted checkbox – allows to mark a point as targeted point, without changing
its type;

• the Measured automatically checkbox – is set if a point is obtained by automatic
measurement of tie points;
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During editing of automatically measured point in the Points measurement module, the
Measured automatically checkbox is cleared and a point is considered as measured
manually.

• for GC points the geodeticCoordinates andRMS of selected point are also displayed.

6.9. Relative orientation report

6.9.1. Report parameters and output

The system allows to view the results of relative orientation operation after measurement
of tie points coordinates. To view and analyze the data, and control accuracy of relative
orientation the system allows to generate a report, that is formed considering specified
parameters of accuracy control, residuals threshold and data output format.

Relative orientation and accuracy control includes the following steps:

• accuracy control for measurements on stereopairs using residual vertical parallaxes;

• accuracy control for measurements in triple overlap zones using discrepancies in tie
points measurements taken on two adjacent stereopairs (models);

• control of tie points number and uniformity of their distribution on stereopairs and in
triplets;

• control of difference between kappa angle and a block scheme.

It is possible to view the relative orientation report in theAutomatic tie point measure-
ment, Triangulation points windows, and in the Points measurement module after
clicking the button. Prior to the report appearing the Relative orientation report
settings window opens.

When the report is opened from the Points measurementmodule, theRelative orient-
ation report settings window is not opened, and the report is shown only for images
opened in the module considering previously set or default parameters. To view and
edit the parameters it is possible to use the link in the report window [Report parameters].

In order to open the relative orientation report perform the following actions:

1. Choose Orientation › Relative orientation report or click the button in the
toolbar of the Triangulation window. The Relative orientation report settings
window opens. It is used to specify parameters of accuracy control and format of
output results of relative orientation in report.
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Fig. 64. Parameters of relative orientation report

2. Select the Main parameters tab (it is selected by default).

3. In the Show report section specify block images to be included to relative orientation
report:

• to view a general report for the whole images block select the for all images
option;

• to view a report for selected images select the for selected images option;

• to view a report for selected and their adjacent images select the for selected
images option and set the add adjacent images checkbox.

4. In the Stereopairs section specify the following parameters of accuracy control for
points measurements on block stereopairs:

• to check measurements for vertical parallax error select the Check vertical
parallax checkbox and input acceptable threshold value (in pixels or mm) for
selected error type (RMS, mean or maximal error);

It is recommended to set the threshold value of maximal error equal to the pixel size.

• to check discrepancy of kappa angle from block layout set theCheck discrepancy
of kappa angle from block layout checkbox and specify a threshold value of
angles discrepancy in degrees;
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It is recommended to specify Angle discrepancy threshold values from 30 to 45 de-
grees.

• to check stereopairs for sufficient measurements number set theCheck number
of tie points checkbox and specify minimal number of tie points per stereopair;

It is recommended to specify Minimal number value not less than 12 point per in-strip
stereopair (2 points per each of 6 standard zones) and at least 2 points per inter-strip
stereopair.

• to check distribution uniformity of tie points on stereopairs set the Check point
distribution uniformity checkbox;

There is non-uniform points distribution on a stereopair, if in each of 6 standard zones
a number of points differs more than 2 times from average amount of points in zone.

• to check number of tie points and their distribution uniformity on inter-strip stereo-
pairs set the Check errors in inter-strip stereopairs checkbox.

The checkbox is cleared by default, since an analysis of points in 6 standard zones for
inter-strip stereopair is not necessary in many cases.

5. In the Triplets section specify the following parameters of accuracy control for
points measurements in triplets:

• to check measurement errors in triplets set the Check residuals in triplets
checkbox and input threshold value by XY and by Z (in pix, mm or meters) for
selected residual type (RMS, mean or maximal error);

A threshold value for maximal error in triplets is calculated using the following formula:

Emax ≈ 2 Emean , where Emean – mean error threshold.

Mean triplet errors in XY plane is calculated using the following formula:

RMS ≈ 2 Emean

Mean error by Z equals the mean triplet errors value in XY plane multiplied by the ratio
of focal length (f) to survey basis (b):

Emean
z = f

b Emean
xy .

• to check triplets for sufficient number of measured tie points set the Check
number of tie points checkbox and specify minimal number of points.
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It is recommended to specify a Minimal number at least 3 points per each triplet.

6. Open theAdditional tab, that includes sections used to setup data view parameters
in the report.

The Residuals format section is used to setup format of errors numeric values in
the report:

• fixed point – is used to set format of errors numeric values accurate within 3
decimal places;

• exponential – is used to set format of errors numeric values in exponential
notation, where a part of number is replaced with symbols E+n, where E (expo-
nent) means multiplying the preceding number by 10 to the power n.

The Precision section is used to setup output data accuracy, select: normal, high
or maximal.

The Angles section is used to setup angles format in the report:

• Alpha, omega, kappa – angular elements of image exterior orientation (are used
in Russian coordinate systems);

• omega, phi, kappa – angular elements of image exterior orientation (are used
in International coordinate systems (see the “Block adjustment” User Manual)).

The Angle units section is used to setup format of angles measurements units:

• radians;

• degrees;

• gons – plane angle measure that equals to 1/100 of a right angle measure,
measurement of full rotation is 400 gons.
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Fig. 65. Additional report parameters

7. Click OK. The report on relative orientation results is opened. It considers all spe-
cified main and additional parameters (see the Section 6.9.2).

6.9.2. Report view and analysis

Report on relative orientation includes results of relative orientation operation, displays
statistics of tie points measurement, and allows to reveal and eliminate errors of points
measurement. The report is generated for all or for selected project images considering
parameters specified in the Relative orientation report settings window.

A feature of relative orientation report is the ability to pass to the Points measurementmodule
directly from the report that allows to eliminate detected measurement errors.

It is possible to view relative orientation report from different windows of the system using the
button. TheRelative orientation report settingswindow opens before the report displaying.

When the report is opened in the Pointsmeasurementmodule, theRelative orientation report
settings window in not opened, and the report is opened only for images opened in the module
considering preset or default parameters. To view and edit the parameters it is possible to use
the link in the report window [Report parameters].
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Fig. 66. Relative orientation report

Relative orientation report contains the following main elements and sections:

• the toolbar with buttons used to perform the following operations:

○ – allows to return to previous view of the report;

○ – allows to refresh relative orientation results in the report after editing of tie
points in the Points measurement module;

○ – allows to perform a search for information in the report;

○ – allows to save report data to files with *.htm, *.html extensions out of active
profile resources;

○ – allows to save report data to files with *.htm, *.html extensions in active
profile resources;

○ – allows to print a report;

○ – allows to open a report preview window before its printing.
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• the links in upper part of a report:

○ jump to [in-strip measurements] – allows to view the points measurements inside
strips;

○ jump to [inter-strip measurements] – allows to view the points measurements
between strips;

○ see also the [interior orientation report] – allows to open report on interior orientation;

○ [Back] – allows to go back to previous report view;

○ [Refresh] – allows to refresh relative orientation results in the report after tie points
editing in the Points measurement module;

○ [Report parameters] – allows to change the parameters and refresh the report;

○ [Unselect all] – allows to cancel data selection in the report;

○ [Top] – allows to go to the report top.

• the Block statistics section of a report used to view general statistics, contains the
following information:

○ a project name;

○ a total number of project strips/images;

○ a number of selected strips/images;

○ report generating date.

• the In-strip measurements section of a report used to view and analyse points
measurements inside strips, contains the following tables:

○ statistics table on in-strip measurements (strips table);

○ table of stereopairs of each strip;

○ table of triplets of each strip.

In inter-strip stereopairs and triplets tables there is a possibility to go to the Points measure-
mentmodule and open images of selected stereopair/triplet automatically, that allows to edit
points measurements there.

• the Inter-strip measurements section of a report used to view and analyse points
measurements between strips, contains the following tables:

113

Aerial triangulationPHOTOMOD 6.0.2



○ statistics table on inter-strip measurements;

○ table of inter-strip stereopairs.

In inter-strip stereopairs tables there is a possibility to open selected stereopair in the Points
measurement module that allows to edit points measurements there.

6.9.3. The in-strip measurements section

The In-strip measurements section of report is used to view points measurements
results inside a strip and contains the following data:

Fig. 67. The “In-strip measurements” section

• Table of strips (Statistics) contains measurements data inside each strip and includes
the following columns:

○ the Strips column is used to display a strip name in block;

○ the Images column is used to display names of the first and the last images in a
strip;

○ the Total column is used to display a number of stereopairs/triplets in each strip;
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○ the Complete column is used to display a number of stereopairs/triplets with per-
formed relative orientation with errors within specified thresholds;

○ theResiduals column is used to display a number of stereopairs/triplets with errors
exceeding specified thresholds;

○ the Not complete column is used to display a number of stereopairs/triplets for
which relative orientation is not performed.

Yellow color highlight is used if relative orientation inside a strip is performed with
errors.

Strips where there is no relative orientation results are highlighted by red color.

• Table of stereopairs contains points measurements data on stereopairs for each strip
and includes the following columns:

○ the first column is used for points measurements editing and allows to open the
Points measurement module with images of stereopair selected in the table;

When editing is completed and the Points measurement module is closed, click the
[Refresh] link in the report to re-calculate relative orientation and refresh the report.

○ the Stereopair column is used to display names of images of each stereopair of
a strip;

Click the stereopair link to open detailed report on measurements of selected stereopair
(see the Section 6.9.5).

○ the Number of points column is used to display a number of points measured on
a stereopair;

○ the Vertical parallax column is used to display a value of vertical parallax for all
measurements on a stereopair (RMS, mean abs. and maximal error) considering
threshold parameters, error type and measurement units specified in the Relative
orientation report settings window;

A row of stereopair with points which coordinates failed to be calculated, is highlighted by
red color, and in the Vertical parallax column the warning message “Coordinates calcu-
lation failed” is displayed with specifying Y-parallax value in brackets.

○ theDiscrepancy of kappa angle column is used to display a value of kappa angles
difference (calculated using block scheme) between images.

○ the Distribution uniformity column is used to display data about uniform or non-
uniform distribution of points on a stereopair;
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A distribution of points on a stereopair is considered as non-uniform, when in any of 6
standard zones, на которые условно делится область перекрытия снимков, a number
of points differs more than twice from average number of points in zone.

○ the +/- buttons in the last column allow to highlight/cancel highlight of stereopair
on a block scheme in 2D-window for visual estimation of stereopair location in im-
ages block.

A stereopair is highlighted along with adding it to already highlighted ones in 2D-window.
Cancelling of a stereopair highlighting is performed along with “subtraction” from highlighted
stereopairs.

Stereopairs with measurements errors are highlighted by yellow color, stereopairs
with unavailable relative orientation by red color.

The following errors are shown by red color (they are depending on parameters
specified in the Relative orientation report settings window):

○ number of points measured on a stereopair, below specified threshold;

○ values of vertical parallax, exceeding specified threshold;

○ non-uniformity of points distribution;

If there each standard zone contains measurements of coordinates of at least one point,
then a stereopair with measurements errors is highlighted by yellow color.

○ difference of kappa angles, that exceeds specified value.

• Table of triplets displays data on measurements in each triplet of a strip and contains
the following columns:

○ The first column is used for measurements editing and allows to open thePoints
measurement module and to open automatically images of selected triplet at the
same time;

After the editing is completed and the Points measurement is closed click the [Refresh]
hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Triplet column is used to display names of images of each triplet in a strip;

After clicking the triplet link the detailed report on selected triplet measurements is opened
(see the Section 6.9.6).

○ the Number of points column is used to display number of points measured on
triplet;
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○ the Tie residuals column is used to display values of tie residuals in triplet by XY
and Z (RMS, mean abs. and max error) considering parameters of threshold, error
type and measurement units specified in the Relative orientation report settings
window.

Triplet errors by ties, exceeding specified thresholds, are highlight by red color.

6.9.4. The inter-strip measurements section

The Inter-strip measurements section of report is used to view points measurements
results inside a strip and contains the following data:

Fig. 68. The “Inter-strip measurements” section

• The inter-strip ties table (Statistics) displays a number of inter-strip stereopairs for
each pair of adjacent strips and presence of measurement errors during relative ori-
entation operation.

• The inter-strip stereopairs table contains the following columns:

○ the first column is used to edit points measurements and allows to open the Points
measurementmodule and to open automatically at the same time images of inter-
strip stereopair selected in the table;

After the editing is completed and the Points measurement is closed click the [Refresh]
hyperlink in the report to re-calculate relative orientation and refresh the report.
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○ the Stereopair column is used to display names of images of each inter-strip ste-
reopair;

After clicking the inter-strip stereopair link the detailed report on selected stereopair
measurements is opened (see the Section 6.9.4).

○ the Number of points column is used to display a number of points measured on
inter-strip stereopair;

○ the Vertical parallax column is used to display a value of vertical parallax for all
measurements on a inter-strip stereopair (RMS, mean abs. and maximal error)
considering threshold parameters, error type and measurement units specified in
the threshold parameters;

○ theDiscrepancy of kappa angle column is used to display a value of kappa angles
difference (calculated using block scheme) between images.

○ the Distribution uniformity column is used to display data about uniform or non-
uniform distribution of points on a inter-strip stereopair.

○ the last columns allows to highlight a stereopair (+) or cancel the highlighting of a
stereopair (-) in 2D-window that allows to estimate visually whether the stereopair
is located within images block.

A stereopair is highlighted with adding it to already highlighted ones in 2D-window. Can-
celling of a stereopair highlighting is performed along with “subtraction” from highlighted
stereopairs.

If in the Relative orientation report settings window the Check errors in interstrip
stereopairs checkbox is set, then the errors in the report are highlighted in the following
way: yellow color shows strips and stereopairs that contain points measurements ex-
ceeding threshold, and the errors values are shown by red color.

6.9.5. The stereopair measurements section

Relative orientation report provides possibility to view a detailed report on any selected
stereopair that contains data on tie points measurements, calculated relative orientation
parameters, information about kappa angles difference and uniformity of tie points dis-
tribution on a stereopair. A detailed report allows to perform control of measurement
accuracy of common points of a stereopair images by values of vertical parallax resid-
uals. To view detailed report for selected stereopair click the stereopair hyperlink in the
tables of in-strip and inter-strip stereopairs.
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Fig. 69. Detailed report for selected stereopair

Detailed report on selected stereopair includes the following data:

• hyperlinks of detailed report:

○ [Relative orientation report] – the link is used to return to the first page of the
common report on in-strip and inter-strip measurements;

○ [Back] – the link is used to return to previous view of detailed report on stereopair
measurements;

○ [Refresh] – the link is used to refresh relative orientation results in the report after
editing of tie points in the Points measurement module;

○ [Report parameters] – the link is used to change the report parameters and to re-
fresh the report;

○ [Edit] – the link is used to view and edit measurements on a stereopair in the Points
measurement module;

○ [Select stereopairs] – allows to select a stereopair on a block scheme in 2D-window;

○ [Unselect stereopairs] – allows to unselect a stereopair on a block scheme in 2D-
window;
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○ [Unselect all] – allows to unselect all previously selected stereopairs.

• information about number of measured tie points on a stereopair;

• the Vertical parallax table contains the following columns:

○ the first column is used to edit selected tie point and allows to open the Points
measurement module and to open at the same time images of the stereopair
automatically and place marker on selected point;

After the point editing is completed and the Points measurement module is closed click
the [Refresh] hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Point column displays names of tie points;

○ the Number of points column is used to display a number of points measured on
inter-strip stereopair;

○ the Image ... (left) column displays a value of vertical parallax residual on the left
image of stereopair (in mm and pix);

○ the Image ... (right) column displays a value of vertical parallax residual on the
right image of stereopair (in mm and pix).

In the threshold row the threshold for vertical parallax residual is displayed in accord-
ance with specified value, measurements units and residual type (RMS, Mean abs.
and max error) of the Vertical parallax threshold parameter in the Relative orient-
ation report settings window.

At the bottom of the table there are final values of vertical parallax residual on all
measurements of the stereopair (RMS, Mean abs. and max error). The system per-
forms control of threshold exceeding only for error type specified in the Relative
orientation report settings window.

Values of vertical parallax residuals exceeding specified threshold, are highlight by
red color.

• theRelative orientation parameters table contains values of calculated relative orient-
ation angles for the left and right images according to selected angular system and
measured units on the Additional tab in the Relative orientation report settings
window;

• theOrientation 2D (by block scheme) andDiscrepancy of kappa angles tables contain
values of kappa angles;

Accuracy control of kappa angles discrepancy between images is performed if in theRelative
orientation report settings window the appropriate checkbox is set and a threshold value
for kappa angles discrepancy is specified.
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• the Distribution uniformity tables contain information about uniformity of points distri-
bution over standard zones. To estimate the parameter the system analyses a differ-
ence of points number in each of 6 standard zones.

Control of points number and uniformity of their distribution on stereopair’s zones is performed
if corresponding parameters are specified in theRelative orientation report settingswindow.

6.9.6. The triplet measurements section

Relative orientation report provides possibility to view a detailed report on selected
triplet. A detailed report for a triplet is used to view and perform accuracy control of
measurements in triplet by tie points errors. In order to view a detailed report on selected
triplet click the triplet link in the triplets table of the Inter-strip measurements section
of the report (see the Section 6.9.3).

Fig. 70. Detailed report for selected triplet

Detailed report on selected triplet includes the following data:

• hyperlinks of detailed report:

○ [Relative orientation report] – the link is used to return to the first page of common
report on relative orientation;
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○ [Back] – the link is used to return to previous view of detailed report on measure-
ments in triplet;

○ [Refresh] – the link is used to refresh relative orientation results in the report after
tie points editing in the Points measurement module;

○ [Report parameters] – the link is used to change the report parameters and to re-
fresh the report;

○ [Edit] – the link is used to view and edit a triplet measurements in the Points
measurement module;

○ [Stereopairs] – two links used to proceed to detailed measurements report of points
on stereopairs, that form the triplet (see the Section 6.9.5).

• information about number of measured tie points in a triplet;

• the Tie residuals table contain the following columns:

○ the first column is used to edit selected tie point and allows to open the Points
measurement module and to open automatically at the same time triplet images
and to place marker on selected point;

After the point editing is completed and the Points measurement module is closed click
the [Refresh] hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Point column is used to display a tie point name;

○ the Ex, Ey, Ez, Exy columns – tie residuals by X, Y, Z axes and tie residual by
(XY) in measurement units specified for residuals control in triplet in the Relative
orientation report settings window.

In the threshold row there is a triplet residual threshold according to specified value,
measurement units and error type (RMS, Mean abs. and max error) of the Triplet
residuals threshold parameter in theRelative orientation report settingswindow.

At the bottom of the table final values of tie residuals on all triplet measurements are
shown (RMS, Mean abs. and max error). Accuracy control is performed only for the
residual type that is specified for the Triplet residuals threshold parameter in the
Relative orientation report settings window.

Values of tie errors that exceed specified threshold are highlighted by red color.
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6.10. Relative orientation control

6.10.1. Control of points recognition correctness

In order to perform aerial triangulation it is necessary to measure on stereopairs tie
points coordinates, that are needed for buildingmodels by stereopairs formed by adjacent
images of a strip, and for joining images into strips and blocks networks.

If tie points weremeasured automatically, some of interstrip points, measured in shadows
or on trees may be a source of errors.

Time between shooting of two adjacent images is usually small enough and object
shadow does not shift on significant distance.

When surveying two different strips the time difference often allows the shadow to move
on distance that is close to required accuracy of adjustment. It causes systematic shift
of strips relatively to each other. At that it will result in systematic error on projection
centers, and a random error on GCP.

Trees shadows and heads position may be changed due to wind. In this case, the error
is random or systematic within small area. During automatic filtering it is impossible to
detect error of points measurements.

In the case when tie points are measured automatically, some of points measured on
borders of extended objects also may be reason of errors. In this case there is possib-
ility of big correlation coefficient on such points, however, measurement accuracy of
points located along extended objects borders is small enough due to homogeneity of
this object. At the same time accuracy of points measurements in direction perpendic-
ular to to the object border is high. During automatic filtering it is impossible to detect
error of points measurements.

After points filtering it is necessary to perform control of points recognition correctness on ste-
reopairs and triplets.

6.10.2. Control of uniform distribution of points measurements on
stereopairs

For relative orientation it is necessary to measure not less than 5 tie points on each
stereopair, each 3 of them should not be on the same line.

In order to increase adjustment accuracy it is recommended to measure more than 6
points on each stereopair.

It is also recommended to avoid situations when there are many points in some small
part relatively to the rest area of stereopair. It is better to either thin out these points or
add more points on the rest of stereopair area to distribute the points over stereopair
uniformly.
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When measuring points along man-made extended objects: roads, power lines, etc., group of
points measured along straight line, is equal to only two points on this line during relative orient-
ation calculation.

6.10.3. Control of vertical parallax residuals on stereopairs

To perform aerial triangulation beside to measure of tie points coordinates it is also
necessary to calculate differences of tie points coordinates on both images of a stereo-
pair.

Difference of points coordinates on two images is called parallax. Vertical parallax is difference
of Y-coordinates, horizontal parallax is difference of X-coordinates of points on images that
compose a stereopair.

In some cases, errors of points’ recognition may not result in big vertical parallax resid-
uals, but cause wrong angles of relative orientation (for example, when kappa angle is
more than 45 degrees).

6.11. Adjustment control in triplets

6.11.1. Control of uniform distribution of points measurements in
triplets

For correct triplets creation it is necessary to measure not less than 2 points with distance
between not less than 1/3 of image width.

It is recommended to measure not less than 1 point in each of 3 zones: central and 2
outermost.

If it is impossible to measure more than 1 point in each of 3 zones (for example, if water
body covers more than a half of strip width) use bundle adjustment. During this operation
it is necessary to measure more tie points during relative orientation and in interstrip
ties. In areas where there is no images overlap but it is necessary to provide high ac-
curacy it is recommended to use “not-transferred” points as well.

“Not-transferred” point – points which coordinates are measured only on a single image in one
strip (it is not measured in overlap of adjacent images in a strip).

6.11.2. Errors control in triplets

During errors control you should consider that height errors in triplets are bigger on
average than plane errors. A coefficient is equal to survey height/basis ratio.

Too big height errors in triplets are usually caused by the following reasons:

• wrong points measurement;

• interior orientation errors;
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• blunders in focus length;

• blunders in distortion input.

If it is impossible to reduce height errors by control of wrong points measurement, it is
recommended to check accuracy of images relative orientation.

If the strip is drifted too much in height, it is recommended to check camera parameters
(distortion).

The system does not provide errors control in triplets, for this strip adjustment is used
(one of a block strips) by independent strips method in free model. In this case each
strip is adjusted individually with subblock selection.

7. Images exterior orientation

7.1. GCP adding and measurement their coordinates

Aerial triangulation workflow provides for defining parameters of block exterior orientation
after images relative orientation.

Measurement of GC point coordinates means adding of known terrain point coordinates
to GC points list and measurement of its pixel coordinates on image.

GC point is a terrain point with known geodetic coordinates, which is a source point for
photogrammetric measurements.

Adding and measurement of GC points coordinates on block images in the system allow
to calculate exterior orientation parameters of images block, when metadata with exter-
ior orientation parameters, obtained from a provider, is not available.

Generally, adding and measurement of GC points coordinates is performed on a step of tie
points coordinates measurement and relative orientation. Then it is necessary to adjust a block
and calculate exterior orientation parameters. After that project images block is fully prepared
for further processing, including stereo vectorization, DEM and orthomosaic generation.

If the GC points coordinates data is unavailable at the time of data collection for aerial
triangulation procedure, the system provides possibility to adjust a block in a free
model (without GC points), that allows to proceed to project processing step directly
(see the “Block adjustment” User Manual).

When deleting images from a project it is highly recommended to synchronize data in a project
to remove redundant results of orientation. To do this choose Project › Synchronize.

In order to use GC points during block adjustment perform the following actions:

1. Input coordinates of GCP to coordinates list.
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2. Measure coordinates of GC points on project images.

To perform correct block adjustment it is recommended to measure coordinates of all input
GC points on block images, since all points – both measured and unmeasured – take part
in statistics during block adjustment. Otherwise, it is possible to exclude unmeasured points
on steps of coordinates measurement and block adjustment.

7.2. List of exterior orientation parameters

The exterior orientation parameters are projection centers coordinates of each block
image, 3 angles (omega, phi, kappa), as well as survey time. All the above parameters
describe image position in space.

In order to view, import, input or edit exterior orientation parameters chooseOrientation ›
Exterior orientation data list or click the button of the main toolbar of the system
or of the AT additional toolbar.

The Exterior orientation parameters window opens, which contains a table (list) of
exterior orientation parameters and its toolbar.

Use the Ctrl+mouse wheel to quickly scroll through the list (аналогично полосам прокрутки
окна). To navigate through the rows rotate the mouse wheel.

Fig. 71. List of exterior orientation parameters

The list of exterior orientation parameters contains the following exterior orientation
data of project images:

• project images code and name;

• XYZ – projection center coordinates in meters;

• Omega-Phi-Kappa – angles of exterior orientation in degrees;

• survey time;

• type and RMS of projection centers coordinates and angles.
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The table displays adjusted and initial values of angles and GC points coordinates.

The toolbar buttons allow to work with the table, to perform import/export of exterior
orientation parameters, to define a type of exterior orientation parameters, to exclude
coordinates, to define kappa angle, etc.

Excluded coordinates values are displayed in the table by grey color. It is possible to edit these
values, and after that the coordinates are automatically considered during adjustment.

If there are XY points or Z points with unused coordinates available, the coordinates values are
not deleted and are displayed in the table as inactive.

Points with not specified angles RMS, but at least one angle value is specified, are displayed
in the table as inactive. If both angles RMS values and angles values are not specified in the
table, then the angles are not shown in the table.

If there are no exterior orientation parameters for some images but survey time is spe-
cified for them, the button is used to calculate missing exterior orientation parameters
for all or for selected images using linear interpolation by time.

It is recommended to calculate missing exterior orientation parameters using linear interpolation
by time for UAS images, since the time data is acquired from images containing metadata.

The system provides connection between the Exterior orientation parameterswindow
and 2D-window: images selected in 2D-window are automatically selected in the table
of the Exterior orientation parameters window. When the images are selected in the
table, they are automatically selected in 2D-window.

Table 9. The “Exterior orientation parameters” toolbar

FunctionsButtons
allows to turn on/off the editing mode of the table
data (data shown in the Code and Name columns
are not editable)
allows to perform a search in the table for image by
its name (Ctrl+F)
allows to delete highlighted rows from the table
allows to delete all data from the table
allows to import a list of exterior orientation paramet-
ers from text file
is used to export the list of exterior orientation
parameters to text files with *.csv and *.txt exten-
sion
allows to swap X and Y coordinates of projection
centers for selected/all images in the table
is used to change coordinate system for selected/all
images in the table

127

Aerial triangulationPHOTOMOD 6.0.2



FunctionsButtons
allows to make exterior orientation parameters
(angles and/or projection centers) of images selec-
ted in the table GCP
allows to make exterior orientation parameters
(angles and/or projection centers) of images selec-
ted in the table check
allowsmake exterior orientation parameters (angles
and/or projection centers) of images selected in the
table excluded
allows to include all three coordinates (X, Y, Z) of
projection centers for selected images in the table,
if some coordinates were excluded
allows to exclude Z-coordinate of projection centers
for selected images in the table (for points with XY
coordinates)
allows to exclude X, Y-coordinates of projection
centers for selected images in the table (for points
with Z coordinate)
allows to open the Set exterior orientation para-
meters accuracywindow used to specify threshold
values in meters for RMS by XY and Z for projection
centers, and for angles accuracy values for selec-
ted/all images in the table
allows to change the kappa angle by a predeter-
mined value for selected/all images in the table
allows to calculate missing data on projection cen-
ters coordinates and/or angle using interpolation of
exterior orientation parameters by time
allows to specify the kappa angle value in accord-
ance with the flight path
allows to copy “adjusted” exterior orientation para-
meters to corresponding fields of initial exterior ori-
entation parameters for images selected in the table
allows to show/hide initial data (input to the table
manually or obtained during import)
allows to show/hide “adjusted” data – exterior orient-
ation parameters, calculated during block adjustment
operation

7.3. GCP list

In order to input GC points coordinates to the GCP list perform the following actions:

1. Choose Orientation › GCP list (Ctrl+Alt+G) or click the button of the main
toolbar. The Triangulation points window opens on the GCP list tab.
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Use Ctrl+wheel to quickly scroll through the list (similar to scroll bars). Rotate the mouse
wheel to move through the lines.

Fig. 72. The GCP list

2. To add a new GCP to the table click the button or use the Alt+Ins shortcut.

Editing mode of the table data is automatically on.

Input to the table the following data:

• Name – a name of GC point;

• Type – point type: Ground control (by default), Check or Excluded;

The Check and Excluded types are assigned to GC points only after their meas-
urement on project images. The Check points is not involved into block adjustment,
but is used for accuracy control. The Excluded points type is used for temporal
point exclusion from GC points list, for example, to exclude unmeasured GC
points prior to block adjustment.

In order to change a point’s type use the , , buttons of the toolbar of the GCP
list tab.

• X, Y, Z – X, Y, Z coordinates of GCP in meters.

During adding of new GCP, a default coordinates values are equal to 0 meters.

If some coordinates values are unavailable, and also for excluding of some co-
ordinates valuers there is a possibility to assign a point type: XYZ, Z or XY.

To assign a point XY type use the button. To assign a point Z type use the
button. The button is`used to consider all three coordinates of GC point.
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GC points coordinates are specified in coordinate system selected on a step of project
creation (see the “Project creation” User Manual).

The system allows to use Z coordinate taken from DEM. The button is used
for this. In order to load a DEM from project resources, select single or multiple
points and click the .

If a DEM is already loaded to a project, it will be used automatically.

• Std.dev. X, Std.dev. Y, Std.dev. Z – values of RMS accuracy by X, Y, Z coordin-
ates (in meters);

• Number ofmeasurements – number of block imageswhereGC point coordinates
are measured (filled in automatically after measurement of GCP coordinates on
images).

On a step of GCP input theNumber of measurements column displays 0 value.

The system also provides opportunity to performimport of GCP list from a text file.

Prior to adjustment it is recommended to measure coordinates of all input GCP or to assign
the Excluded type for points without measurements.

3. Complete input of GCP to the table and proceed to their coordinates measurement
on images (see the Section 7.6).

For successful adjustment of central projection images block the coordinates of projection
centers of the block images are used or at least three GC points, which coordinates should be
measured on at least two adjacent images of the block. Information about recommended amount
of GC points for blocks of scanner spaceborne images see in the Section 10.

The toolbar of theGCP list tab is used to input/import/editing of GC points coordinates,
and also allows to open themodule of GCP coordinatesmeasurement on project images.

Table 10. Toolbar on the “GCP list” tab

FunctionsButtons
allows to turn on/off the editing mode of GC points
in the table
allows to search for GCP in the list using its name
(Ctrl+F)
allows to add a new GCP to the list
allows to delete all GCP selected in the list
allows to delete all GCP from the list including their
measurements
allows to import the GCP list from text file to the list
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FunctionsButtons
allows to export the GCP list from the list to text file
allows to swap X and Y coordinates for selected/all
GCP in the list
allows to re-calculate the coordinate system for se-
lected/all GCP in the list
allows to consider all three X, Y, Z coordinates in
case of XYZ GC points (default parameter)
allows to use XY GC points, i.e. to exclude the Z-
coordinate of selected/all points of the list
allows to ZGC points, i.e. to exclude the XY-coordin-
ates of selected/all points of the list
allows to open the Set exterior orientation para-
meters accuracy window used to define accuracy
of coordinates (RMS) by XY or by Z for selected/all
GC points of the list
allows to open the Point propertieswindow to view
a name, type, code and coordinates of selected
point (see the Section 6.8)
allows to open the Points measurement module
to measure/view on image a GCP selected in the
list. Thus the button allows to display the GCP on
the images where it was already measured or may
be measured in the future
allows to open the relative orientation report
allows to load a DEM used to obtain or refine Z co-
ordinate values for GCP from the list
allows to acquire (extract) Z coordinate from loaded
DEM for GCP selected in the list (if the DEM is
already used in the project, it is loaded automatic-
ally)
[only for the “Points measurement” module] allows
to acquire GCP from DEM considering adjustment
results, i.e. to measure the GC point in marker pos-
ition on selected images in the Points measure-
ment module. Coordinates of the GC point are
measured using the following way: X, Y – adjusted
coordinates, Z – is taken fromDEM (see the descrip-
tion in Section 7.6)
allows to assign the Ground control type to points
selected in the list
allows to assign the Check type to points selected
in the list
allows to assign the Excluded type to points selected
in the list
allows to turn on the automatic selection of images,
that contain the point’s position: if the mode is on,
click the button or double click the point’s record
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FunctionsButtons
in the coordinates list allows to open all images in
the Points measurement module, where the co-
ordinates of the selected point are already meas-
ured, otherwise – all images of the block, that con-
tain the point’s coordinates

7.4. List of triangulation points

The system provides possibility to view, search and edit of triangulation points. The
Triangulation points window is used to do this.

ChooseWindow › Triangulation points coordinates to open the Triangulation points
window.

Fig. 73. The “Triangulation points” window

The Triangulation points window contains the toolbar with buttons used to perform
the following operations:

• – allows to set on/off the filter of triangulation points display;

• – allows to setup the filter of triangulation points display;

• – allows to display all/selected on a block scheme points in the table;

• – is used to search for an image by name (part of name);

• – allows to display GC/tie points with initial coordinates (see the ’Aerial triangulation”
User Manual);

• – allows to display triangulation points with coordinates obtained after adjustment;

• – allows to display only errors.

For refreshing data about project state after changes the Refresh button is used.

The list of triangulation points is a table with the following columns:
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• Code – an object code;

• Name – image name;

• Type – displays point’s type (tie, GCP, check, excluded);

• X, Y, Z – GC/tie point initial coordinates;

• X', Y', Z' – adjusted coordinates of triangulation points;

• dX, dY, dZ – error values on point.

The Triangulation pointswindow is synchronized with 2D-window: when point selecting
in 2D-window it is also selects in the table. Double-click by row with point allows to open
the Points measurements module to edit point’s position.

7.5. Import of GCP catalogue

The system provides import of GC points coordinates list from file with *.csv or *.txt
extension.

To perform import of GC points coordinates list from file perform the following actions:

1. Choose Orientation › GCP list or click the button of the main toolbar. The Tri-
angulation points window opens.

2. Click the button on the GCP list tab.

3. Select a file containing GCP catalogue and click OK. The Import GCP catalogue
window opens.
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Fig. 74. Import of GCP catalogue

4. The Line template field displays a list of fields, contained in each line of the import
file:

• Name – object’s name;

If imported file does not contain a column with GCP names (numbers), then after import
operation the names like Point0001 are assigned to the points automatically.

• X Y Z – values of GC point coordinates by X, Y, Z;

• STDDEVX, STDDEVY, STDDEVZ— accuracy of coordinates measurements by X, Y, Z
axes (RMS);

• * – missed field during import.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped. To all vertexes two (for 2D objects import)
or three coordinates are specified.
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In order to setup active template, perform one of the following actions:

• drag a field name from the Available fields list to the Preview file table column.
After that the template in the Line template field is changed. To cancel a field
selection, double click the Preview file table column;

• change a template manually in the Line template field. After that column types
in the Preview file table will be changed automatically.

The button is used to return to default template Name X Y Z.

The button is used to compare the Line template field with data shown in the
Preview file table.

Active template corresponds only lines shown in the Preview file table.

The button is used to replace specified fields names with fields names from the
first line of the Preview file table. It is possible to specify any names for vectors
import.

For import of laser scanning data the field names from the list of available names are
specified.
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Fig. 75. Setup of a template sample

5. [optional] For automatic selection of current template the Automatically validate
template checkbox is set by default. In order to setup a template for a file that
contains lines with different number of columns, clear the Automatically validate
template checkbox and setup the template manually in the Line template field.

6. [optional] In order to define a line from which to start data import, input the line
number to the Start import from line field.

7. [optional] In order to display necessary number of lines in the Preview file table,
set the Preview maximum parameter. 10 lines are displayed by default.

8. In the Available fields section select desired field name and drag it on a table
column. To cancel the selection of the field name double click the column header.

9. In the Field separators section set single or multiple checkboxes to specify field
separators in the file: comma, space, tab, semicolon or other. The comma and
space are set by default.

10. In the Decimal separator section set the following parameters:
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• Point only – to use only a point as a decimal separator in coordinates;

• Point or comma – to use both a point and a comma as a decimal separator in
coordinates.

If the Field separator is selected as a comma, it is not recommended to specify the
Decimal separator as a comma, since objects with incorrect coordinates will be created
after import operation.

11. In the Misc section set the following checkboxes:

• UTF-8 – is used to recognize text in Unicode coding;

• Parse degrees minutes seconds – is used to recognize records from the list
of projection centers or GCP.

When using this parameter it is highly recommended to check recognizing correctness
after import operation.

12. The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

The * symbols marks columns with data which is not imported.

13. In the Points with existing names section specify actions to perform when names
of imported GC points coincide with points names already existing on the GCP list
tab:

• Replace – allows to replace a point with the same name in the list, i.e. the point
data will be updated;

• Skip – allows to cancel import of GCP with the same name.

14. [optional] To convert coordinate system set the Convert coordinate system
checkbox and specify source and output coordinate systems.

15. Click OK. The Import ground control points window opens, which contains the
GCP table to be added. Points which names are the same as names of existing
GCP in the GCP list of the Triangulation points window are shown by red color,
new GCP – by black color.

137

Aerial triangulationPHOTOMOD 6.0.2



Fig. 76. Selecting GCP to be added to the list

16. Select points to be imported using checkboxes and/or standard selection tools.
Click OK. After that coordinates of GC points with set checkboxes will be loaded in
the end of the GCP list.

If in the Points with existing names section the Skip parameter is selected, then only
new GCP are selected for adding by default, if the Replace parameter is selected, all GCP
checkboxes are selected to be added.

If RMS of X, Y, Z coordinates was not imported or is absent in GCP file, then default value
of RMS for all coordinates is 0.2 meters.

7.6. Measurement of GCP coordinates

After completing of GCP coordinates input it is possible to measure these GCP on block
images in the Points measurement module.

In order to measure GC point coordinates perform the following actions:

1. Open the Triangulation points window on the GCP list tab.

2. Select GC point in the table to measure its coordinates on images and click the
button or double click the point name in the table. The Points measurement module
is opened.

If at least three GCPwere already measured on block images or there was executed
preliminary orientation in geodetic coordinate system (by projection centers, for in-
stance), the system performs automatic search for corresponding terrain point on
block images and places marker on this image point.

When the system performs a search for terrain point in mode of images automatic selection
(the button of the Triangulation points window is clicked) it automatically opens all
images that contain the terrain point with measurements or without them, otherwise – only
images that contain measurements of selected point.
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If GCP measurements or preliminary orientation results are unavailable, click the
button of the upper toolbar of the Points measurement module. Select and

open images and perform a search for terrain point manually.

3. Measure coordinates of GC point on a single or multiple images (the point lies in
the overlap area) using one of the following ways:

To measure and edit GCP coordinates it is recommended to use the All triangulation
points tab in the module that contains data of all measurements and features of points
sorting, filtering and search.

• GCP coordinates measurement without correlator is used if a point is located on
terrain and is clearly recognized on all images.

Show by marker the terrain point on images. Click the button of the upper
toolbar of the module.

• GCP coordinates measurement and transfer with correlator is used if a point is
not clearly recognized on all images.

In this case measure the point on a single image using the button of the upper
toolbar of the image window or use the Ins hotkey. Define the image as the left
using the button in the image window. Then transfer the point from the left
image to other images using the button to transfer the point on the image in
the active window or use the button to transfer the point on all images opened
in the module.

Recommended correlation coefficient during GCP transfer is 0.90–0.95.

• measurement of coordinates in stereomode is used when the point is located on
high-rised object and/or is not displayed on all images.

4. After measurement of GCP coordinates an information about the measurement
appears in the All triangulation points list.
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Fig. 77. Measurement of GCP coordinates in the “Points measurement” module

In order to find a GCP in the Triangulation points table perform the following actions:

1. Click the button. The Find window opens.

2. Input GCP full name or its part into the Find field, specify a search direction and
click OK.

To move a GCP on images (to edit measurement of selected point) perform the following
actions:

1. Select measured GC point in the table of the Triangulation points module and
click the button or double click the point name in the table to display the meas-
urements of selected point on block images.

2. Show by marker new position for selected GC point.

3. Click the of the module upper toolbar. After that the GC point on images is moved
to marker’s position, and measurements data is refreshed in the Triangulation
points table.
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To delete measurements of GC point select the point in the Triangulation points table
and click the button of the module upper toolbar to delete only measurements of the
point on all images. The operation does not lead to deletion of GC point coordinates
from the Triangulation points table (see also Section 8.6).

In order to completely delete a GC point (to delete point’s measurements on images
and to delete the point with its coordinates from the table) select GC point in the table
and click the button of the Triangulation points window toolbar.

A description of GCP transfer from georeferenced map (raster or vector map, as well
as DEM of the same terrain, where project images are acquired) see in the Section 7.7.

To transfer a GC point from DEM considering adjustment data perform the following
actions:

GC points transfer from DEM considering adjustment data is performed only for the projects of
the Space scanner survey type, adjusted by metadata, when it is necessary to improve a block
scheme in case of discrepancy of nadir and off-nadir images. Namely, to improve results of
adjustment (to refine Z coordinate) by DEM using GCP coordinates measurement.

1. Open the Points measurement module.

2. Click the button of the Triangulation points window toolbar to go to the GCP
list tab.

3. Click the button to load DEM. Select a file containing DEM and click OK.

If a DEM is already loaded to the system, it will be used automatically.

If there is loaded DEM the status bar of the window displays the path to opened DEM and
its name, and there is also the button allowing to close the DEM.

4. Click the button of the upper toolbar of the module to open an image to transfer
a point from DEM.

5. Show the location of a new GCP on images by marker.

6. Click the button of the Triangulation points window toolbar to add a new GC
point, which coordinates are calculated by DEM and adjustment data. A new GC
point arrears in the list of the Triangulation points window.

To add the only one measurement of GC point coordinates on selected image click the
button holding pressed Alt key, otherwise the point will be added on all opened images.
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7.7. Georeferenced external data

7.7.1. The “Map” window

Georeferenced external data (raster and vector maps, DEMs, and web-maps) for the
same terrain as project images, are used as a basis to obtain GCP coordinates and
measurement of the GCP on project images.

In order to use all features of the Map window it is recommended to work with georeferenced
block scheme, i.e. it is necessary to have already measured GCP available on project images
(two, at least) or block layout created using exterior orientation data (see the Section 7.7.3).

General workflow on GCP transfer includes the following steps:

1. Load of georeferenced data (briefly: map).

2. Selection of terrain point on the map and search for the point on project images.

3. Transfer the point from the map – add/measure of point’s coordinates on project
images.

4. [optional] Editing of the GC point.

Main purpose of theMap window – load of georeferenced data (raster and vector maps
and DEMs) in order to use them for adding GC points andmeasurement their coordinates
on project images.

To open the Map window, open the Points measurement module and click the
button of the main module toolbar.
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Fig. 78. The “Map” window

By default, all data opened in 2D-window is displayed in working area of theMapwindow.
Besides, if there is georeferenced block scheme the Triangulation points layer is created,
and work with it is synchronized with windows of images opened in the Points meas-
urement module.

In the right part of theMap window there is the Layer’s Manager used to manage these
data and navigation window for fast move to needed part of the map. There is a toolbar
in the top of the window.

In the status line of theMap window the marker’s position coordinates on the georefer-
enced map are shown.

It is possible to move the whole image in the working area of theMapwindow in panning
mode by moving mouse with pressed left button along with holding pressed the Alt key.

In the bottom of the working area of the Map window there is the panel used to setup
brightness, contrast and gamma-correction of the image shown in the working area.

The Shift+F8 shortcut allows to hide the brightness setting panel.
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In order to return to default settings of brightness and contrast, right click the settings panel and
select Reset.

Settings of brightness, contrast and gamma-correction are not restored after the module restart.

Table 11. The “Map” window toolbar

FunctionsButton
allows to open a window used to select a raster map
file located out from profile resources, which have
one of the following raster formats: TIFF, JPEG, BMP,
IMG, PNG, NTF, GIF, PIX, JP2, DEM
allows to open a window used to select a vector
map file located in active profile resources
allows to open a window used to select a file of DEM
located in active profile resources to obtain Z coordin-
ates for measured GC points
allows to open a window used to select a source of
geospatial data of WMS format and to load web-
maps, located on specified area
[for georeferenced block scheme only] allows to find
marker position in windows of opened images of
thePointsmeasurementmodule (the button action
is duplicated by double mouse click) – allows to
perform automatic search for a placement of marker
specified on the map on images opened in the
module
allows to perform a search of a terrain point spe-
cified on the map by marker on all project images –
after that windows of those project images where
the point was found are opened in the Points
measurement module (the button action is duplic-
ated by Shift + mouse double click)
allows to add a GC point on opened images of the
module without correlation, i.e. to transfer a point
with coordinates from the map to a terrain point
specified by marker on selected images. The added
point is displayed on images and in the list of trian-
gulation points of thePointsmeasurementmodule
allows to open a window used to add and measure
GCP coordinates with correlation to search corres-
ponding points on project images, and to use a DEM
to acquire Z-coordinate (see the Section 7.7.4)
allows to use the marker = mouse (F4) mode of
working area
allows to center image in working area by marker
(F7)
allows to use the Fixed marker mode (F6) – when
marker is always at the center of the screen and
mouse moving results in the image moving
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FunctionsButton
allows to show/hide service windows, located to the
right from the working area: Layer manager and
navigation window
allows to show/hide navigation window only
allows to show/hide scroll bars
allow to manage a zoom of the whole image of the

window working area. The field

, , ,

is used to display a current zoom, and allows to
change the zoom using the slider

7.7.2. Prepare and load georeferenced data

The system supports using of the following georeferenced data: raster maps, vector
maps, DEMs, and web-maps to acquire GCP data.

Loaded external georeferenced data are restored during next module session, but removed
from memory during log off from the system.

Prior to use georeferenced maps and DEM (briefly:maps) perform the following actions:

1. Prepare the input data in the following way:

• for raster data specify a folder out of active profile resources to place a raster
format file (TIFF, JPEG, BMP, IMG, PNG, NTF, GIF, PIX, JP2, DEM) and georeference
file with the same name (see the Section 7.7.5);

• for vector data and DEM perform their import to files of interior format of the
system (*.x-data and *.x-dem correspondingly) and save them to the folder in
active profile resources. See a description of the vector data and DEM import in
the “Vectorization” User Manual.

2. Open the Points measurement module.

3. Click the button of the top module toolbar. The Map window opens. In the
working area of the Map window the data loaded during work in 2D-window is dis-
played.

4. [optional] Click the button to display a list of layers and to manage them.

5. Load georeferenced map.

To load a raster map to a project perform the following actions:

1. Click the button. The Loading images window opens.
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2. Select a raster map file and click theOpen button. The Load georeferenced images
window opens.

3. [optional] Re-calculate coordinate system of the raster map to bring it in correspond-
ence with the project coordinate system. If there is a background color on the edges
of the map, specify the background color and define the color transparency.

4. Click OK. New raster layer appears in the Layers manager and loaded raster map
is displayed in the Map window working area.

To load a DEM to a project perform the following actions:

1. Click the button. The Open window opens.

2. Select DEM file in active profile resources and click the Open button.

3. New DEM layer appears in the Layers manager and loaded DEM is displayed in
the Map window working area.

To load a vector map to a project perform the following actions:

1. Click the button. The Open window opens.

Fig. 79. Parameters of vector map loading

2. Select vector map file in active profile resources.

3. [optional] Recalculate coordinate system if necessary.
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4. Click theOpen button. New vector layer appears in the Layers manager and loaded
vector map is displayed in the Map window working area.

Perform the following actions to load a web-map to a project:

1. Click the button. The Settings window opens.

Web-map loading is possible for georeferenced block scheme only.

Fig. 80. Parameters of web-map loading

2. [optional] Setup parameters of the web-map loading.

3. Click OK. The Load web-map window opens.

Fig. 81. Parameters of web-map loading

4. In the Source list select a source of georeferenced data of WMS standard.

5. [optional] Define a working area to load a web-map.
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6. In the Reproject section define a coordinate system of loaded web-map using the
following way:

• Auto – automatic transformation to coordinate system of a project;

• None – use coordinate system of the web-service;

• Reproject into coordinate system and specify necessary coordinate system.

7. Click OK. New vector layer appears in the Layers manager and loaded map is dis-
played in the Map window working area.

7.7.3. Search for GCP on project images

To transfer GC points from a map to a project it is necessary to find these points on
project images. To do this perform the following actions:

1. Select specific terrain point on a map in the Map window and place marker on this
point.

Specific terrain point – a terrain point which is clearly visible in comparison with other terrain
objects: it has good contrast, sharpness, is distinguished by color and shape.

2. Find this terrain point on project images in the Points measurement module.

Search for corresponding terrain point on images depends on availability of some project
data.

3. [optional] If there no measured GCP and exterior orientation data available in the
project perform the following actions:

1. In the Points measurement module click the button of the upper toolbar.

2. Select and open those project images that contain the terrain point specified
in the map.

3. Find this point manually and show it on project images using marker.

4. If the project contains at least 2 measured GCP and/or exterior orientation paramet-
ers are used for block layout creation, use the following synchronization tools to
perform search for the terrain point on project images:

• for automatic search for the point on project images opened in the Points
measurement module click the button in the Map window. Define the point
position more exactly using marker, if necessary;
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• to perform automatic search for the point on all project images and to open in
the Points measurement module just those images where the point is found,
and also with marker positioning, click the button in the Map window. Define the
point position more exactly, if necessary.

The system also provides reverse synchronization, when it is searching on the map for the
terrain point specified on the image. To do this place marker on the image point in the
active window of the Points measurement module, and then click the Find on map
button of the main toolbar of the module.

7.7.4. Transfer GCP from map

To transfer selected GCP from map, i.e. to add/measure coordinates of found point on
project images, the system provides the following features:

• adding GCP without use of correlator;

• adding GCP using correlator.

To use correlator it is necessary to have already measured GCP in a project and/or exterior
orientation parameters along with created block layout using these parameters. Besides,
during adding a GCP using correlator there is a possibility to use DEM to obtain a value of
point’s Z-coordinate.

To quickly add GCP without correlator perform the following actions:

1. Load raster or vector map.

The system allows to use multiple raster and/or vector maps at the same time.

2. Make the maps layer active in the Map window.

3. Use marker to match terrain points on the map in the Map window and on project
images in the Points measurement module (see the Section 7.7.3).

4. Click the Add point without correlation button in theMap window. A new GCP
is displayed on project images and appears in the triangulation points list of the
Points measurement module.

5. [optional] Edit coordinates values or change the point’s type (GCP, check) on the
GCP list tab of the Triangulation points window.

To add GCP from raster map using correlator perform the following actions:

1. Load raster map.
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2. Make raster layer active in the Map window. If there is a DEM available, load in to
the Map window to obtain Z coordinate.

3. Specify a terrain point on the raster map using marker. Click the Find on all
images button in the Map window to open all project images contains this terrain
point in the Points measurement module.

4. Click the Open tool panel for addingGCPs frommap button in theMapwindow
or in the Points measurementmodule. The Add GCPs frommap window opens.

When the Add GCPs from map window is opened it is possible to work both in the Map
window and in the Points measurement module.

Fig. 82. Transfer of GCP from a map

5. In the Raster layer for correlation drop-down list select active layer of raster map.
In the DEM layer for obtaining Z drop-down list select a DEM layer (if any).

To refresh a list of layers use the button.

6. Setup the following correlator parameters:
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• set the Auto checkbox to define the GSD automatically, or input pixel size value
manually;

• specify the Search area of corresponding point on image in meters, the default
value is 100;

• specify the Correlation mask halfsize by X and Y axes (pix), the default value
is 12;

• set the Contrast point search area checkbox and specify a size of the area in
meters (the default value is 10), where the system will search for the point with
maximal contrast;

It is necessary to define more precisely this area size to process data with big monochro-
matic areas.

When measuring points in low contrast areas it is recommended to set 0 value (for ex-
ample, when maximal contrast corresponds to forested areas, where there are good
chances of correlator errors).

• specify the Correlation threshold – minimal value of correlation coefficient for
points coordinates measurement (0.8, by default). Points that have correlation
threshold below specified value are not considered during adding (the “Bad point”
warning appears).

Correlation threshold is defined considering source data quality.

7. To add GCP using correlator it is possible to use the following buttons of the Add
GCPs from map window toolbar:

• Correlate and move marker – allows to search for corresponding point on
opened images of the Points measurementmodule using correlator. In case of
successful correlation marker is moved to the found point, otherwise, the “Bad
point” warning appears;

• Add point with correlation on the active image – allows to add/measure
GCP coordinates on image in active window of the Points measurement mod-
ule – in other words, to search for corresponding point on image in active window
using correlator. In case of successful correlation marker is moved to the found
point and the New GCP window opens, otherwise, the “Bad point” warning ap-
pears;

• Add point with correlation on all images – allows to add/measure GCP
coordinates on all images opened in the Points measurementmodule – in other
words, to search for corresponding point on all opened images. In case of suc-

151

Aerial triangulationPHOTOMOD 6.0.2



cessful correlation marker is moved to the found point and the NewGCP window
opens, otherwise, the “Bad point” warning appears;

• Add point without correlation – allows to “quickly” add a GCP without cor-
relation to a marker position on image in the Points measurement module.

The New GCP window is intended to view/edit coordinates of selected terrain point
on a map, and to analyse correlation coefficient and to select the images of the
project where a new GC point will be added.

Fig. 83. Edit point’s measurements

To add a new GCP perform the following actions:

1. Input a name of a new point to the Name field.

2. Select coordinates to be transferred during point adding.

A value of Z coordinate is displayed when DEM is used.

3. Estimate correlation coefficient shown in the table and select images, where
to add GCP.

4. To add/measure GCP coordinates on selected images click one of the buttons
located at the bottom of the window.

FunctionsButtons
allows to add new GCP with its coordinates to
the triangulation points list and to measure it
on selected images

Add point with measurements

152

Aerial triangulationPHOTOMOD 6.0.2



FunctionsButtons
allows to add new GCP with its coordinates to
triangulation points list without its measurement
on selected images

Add point without measurements

allows to replace coordinates of selected GCP
in the triangulation points list and to re-measure
it on images

Replace GCP with measurements

allows to replace only coordinates of selected
GCP in the triangulation points list without
editing of measurements on images

Replace GCP coordinates

allows to re-measure selected GCP on images
in the triangulation points list without coordin-
ates refresh

Replace measurements only

7.7.5. Raster map georeference

The system allows to georeference scanned cartographic raster material using points
with known geodetic coordinates. If there is a raster georeferenced map on terrain area
is available allows to use it as a reference, i.e. to transfer GC points and measure them
on project images.

The Raster georeference window is used to perform raster map georeference.
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Fig. 84. Raster map georeference window

The window contains the following GUI elements:

• toolbar used to reference raster image by points with known coordinates;

• map window in the top part of the working area (there can be located multiple maps,
if the reference raster or vector map is loaded) with the standard tools panel used to
manage map’s image zoom and rotation in the window;

• table in the bottom part of the working area containing points coordinates with the
following columns:

○ Xg, Yg – point’s geodetic coordinates;

○ Xp, Yp – pixel point’s coordinates after adding the point on the raster map;

○ Name – point’s name;

○ Ex, Ey – errors in point’s X,Y coordinates measurements.
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Table 12. Main toolbar of the “Raster georeference” window

FunctionsButtons
allows to load raster map to the window for its
georeference
allows to load georeferenced raster map to another
working window
allows to add georeferenced vector map of DXF, SHP
or DGN format to another working window
allows to loadGC points data from text file to coordin-
ate table
allows to save georeference data to a file ofMapInfo
TAB format with a name that coincides with the
raster map name
allow to manage the zoom of map display, , ,
allows to remove all points from the table and from
the map
allows to add a new point both to the map and to
the coordinate table (at that, marker coordinates are
saved as pixel ones, and geodetic coordinates are
assigned to 0 value)
allows to delete a point selected in the table
allows to refresh coordinates of selected point (to
save pixel coordinates of a new marker position on
on the map for the point selected in the table)
allows to move marker on map point, selected in
the table, that means that the system performs
search for selected point on the map
allows to copy coordinates of a point selected in the
table to clipboard (the coordinates are copied in the
following format Xp Yp Xg Yg)
allows to refresh coordinates of selected point – to
paste them from a clipboard (the following formats
are acceptable: Xg Yg; Xg Yg Zg; Xp Yp Xg Yg; Xp
Yp Zp Xg Yg Zg, where Zp is identically equal to 0)
allows to openWindows standard color box that al-
lows to choose color of GCP symbols shown on the
map
[raster map window] allows to display raster image
in grey scale
[raster map window] allows to rotate image in the
working window of raster map (no rotation, rotate
by 90, 180, 270 degrees)

, , ,

To perform georeference of raster map perform the following actions:

1. Select Rasters › Images georeferencing. The Raster georeference window
opens.
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2. Click the button of the main toolbar. Select a file with raster map located out of
active profile resources and click OK. After that a raster image is displayed in the
map window.

If folder with raster map file already contains a file of MapInfo TAB format with reference
data, and TAB-file name is the same as a file name of raster map, then the coordinate
table of the window displays reference data.

3. [optional] In order to load additional data used for georeference perform one of the
following actions:

• to import points coordinates from a text file:

1. Click the button. The Import parameters window opens.

Fig. 85. Import parameters of points coordinates from a text file

2. Specify set of the data to be imported and its format and load it to the coordin-
ates table.

3. [optional] In order to prevent change of points coordinates, which are already
measured on images, set the Clear before import checkbox.

4. Click OK to add points to catalogue.

5. Find and add these points on the map by clicking the button and match
geodetic coordinates of point selected in the table to pixel coordinates of the
point on the map.

• to load georeferenced raster map click the button. Reference map is opened
in the separateMap window (next to the window with un-referenced raster map)
and allows to acquire geodetic coordinates in any point. Show by marker two
identical terrain points both on raster and vector reference maps. Click the
button to add GC point on the raster map and to the coordinates table;

• to load georeferenced vector map click the button. Reference vector map is
opened in the separate Map map (next to the window with un-referenced raster
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map) and allows to acquire geodetic coordinates in any point. Show by marker
two identical terrain points both on raster and vector reference maps. Click the

button to add GC point on the raster map and to the coordinates table.

4. In order to add geodetic coordinates of GCP on the map manually perform the fol-
lowing actions:

1. Locate GC point on the map and place marker to this terrain point.

2. Click the button. The point’s pixel coordinates are added to the table.

3. Input manually geodetic coordinates of this point into the Xg, Yg columns and
specify the point’s name in the Name field.

When the fifths point coordinates on the map are measured, coordinates measurement
residuals are calculated automatically and are shown in the Ex, Ey columns of the
table.

4. Repeat the 1–3 steps for other GC points.

For correct map reference it is recommended to recognize at least four points on the
map. If the reference is performed using only one point, the system considers that
measurement unit is one pixel and axes coincide. When two points are used for refer-
ence, the system performs image zoom and rotation, in case of reference by three
points the system applies affine transformations.

5. [optional] Edit GC points (see the description of the main toolbar of the Raster
georeference window).

6. Click the button to save georeference file to MapInfo format.

7.8. Import and export of exterior orientation parameters

7.8.1. Import of exterior orientation parameters

When accurate enough exterior orientation parameters of block images are available,
it is possible to skip steps of GCP and tie coordinates measurement, as well as block
adjustment step from the workflow and proceed right away to steps of stereovectorization,
DEM and orthomosaic generation (see how to estimate accuracy of imported exterior
orientation parameters in Section 7.8.5). Otherwise, if there are inaccurate exterior ori-
entation parameters of block images, imported exterior orientation parameters are used
to block scheme refinement.

There are the following conditions of successful import of exterior orientation parameters:

• correct images exterior orientation;
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• terrain elevation difference data (Zmin, Zmax in meters), which should be specified
either on project creation step (see the “Project creation” User Manual), or directly
during import of exterior orientation data in the Import exterior orientation paramet-
ers window.

When terrain elevation difference on block images is more than 1/10 of flight altitude, it is
recommended to use GSD data to block layout creation using imported data (see the Sec-
tion 3).

In general case perform the following steps to import images exterior orientation para-
meters:

1. Choose Orientation › Direct georeferencing or click the button of the AT
toolbar. After that the information window opens, it contain information about number
of images adjusted using exterior orientation parameters.

If a project contains measured tie points, their relative orientation is performed automatically.

2. Perform accuracy control of imported exterior orientation parameters.

3. Depending on quality of imported exterior orientation parameters, perform one of
the following steps:

• if the exterior orientation parameters are precise enough, pass to project pro-
cessing (to stereovectorization, DEM generation and orthomosaic creation);

• otherwise, perform steps of tie and GC points measurement and then block ad-
justment, after that pass to project processing step.

To import exterior orientation parameters to a project perform the following actions:

1. Choose Orientation › Import exterior orientation or click the button in the
Exterior orientation parameters window. The Open window opens.

2. Select a file containing exterior orientation parameters and click OK. The Exterior
orientation import – Step 1 of 3: File window opens. The File name input field
displays selected file placement and name. To select another file which contains
exterior orientation parameters, click the button.
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Fig. 86. Exterior orientation import – Step 1

3. [optional] If images names in file and in project are not the same, perform one of
the following actions:

• set the Loose matching of image names in file against names in project
checkbox. The system performs search for common substrings and matches
images names. For example, it searches for common substring 018_02595 in
image name RGBI_018_02595 in file and image name 018_02595 in project.

If the Loose matching of image names in file against names in project checkbox is
set the image name with file extension is also imported.

• set the Match by record number checkbox and click the Setup... button. The
Match images by numbers window opens.
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Fig. 87. Images matching by numbers

1. In the Numbers in the file section set the following parameters:

○ Serial numbers of records matching the template – used to match a
list of records numbers in a file by order;

○ Read from the Name field – used to match a list of records numbers in
a file by the last number from the filename.

2. In the Numbers of images in the project section set the following paramet-
ers:

○ Serial numbers of images – used to match a list of records numbers in
a project by order;

○ Read from images names – used to match a list of records numbers in
a project by the last number from the filename.

3. Input necessary parameters to the File recordwith the number andmatches
project image with number input fields.

For convenient setup of necessary parameters it is recommended to place windows
in that way that allows to display on screen a name of the first image in the table
of the Exterior orientation parameters window, and also allows to display first
rows in the Preview file table of the Exterior orientation import window. It is re-
commended to place the Match images by numbers window in such a way that
allow to show both windows mentioned above.

4. Choose one of the following formats to specify a type of imported file:

• PAT-B matrix – file containing coordinates of projection centers and rotation
matrices (see Section 9.5.1).

[optional] If the PAT-B file contains exterior orientation parameters, calculated
for negative plane, set the Negative checkbox and pass to the step 10.
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• CSV (projection centers, Omega/Phi/Kappa angles and GPS-time) – file
containing coordinates of projection centers in any coordinate system, as well
as exterior orientation parameters, and precise time from GPS-receiver.

CSV format is exchange text format with *.csv extension, which is supported by
major applications in different industries. It is used as exchange format when
special geospatial data formats are not applicable for some reason.

• CSV (navigation data: latitude/longitude/altitudeWGS-84, heading/pitch/roll
angles and time) – file containing navigation data (latitude/longitude set in de-
grees, altitude in meters, angles in degrees, radians or gons) and precise time
from GPS-receiver.

To perform import of exterior orientation parameters it is necessary that a project is in
coordinate system consistent with WGS-84 coordinate system.

• CSV (navigation data: projection centers in working c.s., heading/pitch/roll
angles and time) – file containing navigation data (coordinates of projection
centers in project coordinate system, angles in degrees, radians or gons) and
precise time from GPS-receiver.

5. [optional] If data is imported from CSV format, it is necessary to setup a current
template (see Section 9.2).

6. Click the Next button. The Exterior orientation import – Step 2 of 3: Import
settings window opens.

Fig. 88. Exterior orientation import – Step 2
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7. In the Angles section specify measurement units for angles coordinates according
to data of the file to be imported:

• radians;

• degrees;

• gons – plane angle measurement unit that equals to 1/100 of flat right angle
measurement unit, and full angle is 400 gons.

8. [optional] In order to make correction to kappa angle, set the Add to the kappa
angle checkbox and input correction value to the input field.

9. [optional] In order to Invert sign for angles Omega, Phi and/or Kappa, set corres-
ponding checkboxes.

10. In the Relief elevation section set minimal and maximal values of terrain elevation
in the project – Zmin, Zmax in meters.

Relief elevation is automatically set equal to values specified in the project settings (see
the “Project creation” User Manual).

11. [optional] In the Precision (std.dev.) section change precision of a priori RMS of
measurements of projection centers coordinates and exterior orientation angles.

12. [optional] In order to cancel automatic setting of the same precision by all axes,
clear the Uniform precision by all axes checkbox.

13. If import of exterior orientation parameters is performed using the Exterior orient-
ation parameters window, then click the Execute button. After that the exterior
orientation parameters are imported to the list of exterior orientation parameters.

If import of exterior orientation parameters is performed using the Orientation ›
Exterior orientation import...menu item, then click the Next button. The Exterior
orientation import – Step 3 of 3: Additional actions window opens.

Fig. 89. Exterior orientation import – Step 3
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14. Select and set the following checkboxes to perform automatic execution of these
actions just after import of exterior orientation parameters from file:

• Split block into strips by EO data – to split block images into strips using im-
ported exterior orientation parameters (if all images were loaded to a single strip
on a step of project creation);

• Create block layout by EO data – to create block layout considering imported
exterior orientation parameters;

• Adjust block based on imported EO data – to perform block adjustment using
imported exterior orientation parameters;

• Rotate images in block scheme by block layout – to re-create a block scheme
in 2D-window using block layout по накидному монтажу (this checkbox is
available if the Create block layout by EO data is set).

15. Click the Execute button. After that the exterior orientation parameters are imported
to the list of exterior orientation parameters.

16. Estimate accuracy of imported exterior orientation parameters by block layout, by
measured GC points coordinates and/or by values of vertical parallax during
measurement of coordinates of multiple tie points.

7.8.2. Export of exterior orientation parameters

The system provides possibility to perform export of list of source exterior orientation
parameters and adjustment results to PAT-B and CSV formats.

In order to export exterior orientation parameters from a project perform the following
actions:

1. Choose Orientation › Import exterior orientation or click the button in the
Exterior orientation parameters window. The Exterior orientation parameters
export window opens.
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Fig. 90. Exterior orientation parameters export

2. In the Data to export section select data to be exported:

• ext. orientation catalogue – used to export source data (projection centers co-
ordinates, exterior orientation angles, etc.);

• adjustment results – used to export adjusted projection centers coordinates
and exterior orientation parameters.

3. In the Export format set checkbox or both checkboxes to export data into chosen
formats:

• PAT-B – is exchange text format with *.ori extension, which is supported by
major applications in different industries;

• CSV – is exchange text format with *.csv extension, when the data is represented
by table with specified list of fields.

4. Click the button, specify a filename and its placement out of active profile re-
sources.

5. [optional] In order to setup a list of fields to be exported to CSV file, set the following
checkboxes:

• Image code – stated name of image;

• Image name – a name of image;
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• Time – precise time from GPS-receiver;

• XYZ – values of projection centers coordinates in meters;

• XYZ type – type of projection centers coordinates;

• XYZ std.dev. – RMS error of projection centers coordinates in meters;

• Omega, phi, kappa angles – values of exterior orientation angles in degrees;

• Angles type – type of exterior orientation angles;

• Angles std.dev. – RMS error of exterior orientation angles.

To perform export of all fields, click the Select all button.

To clear all checkboxes click the Unselect all button.

To perform export of just fields with images numbers, projection centers coordinates
and exterior orientation angles, click the Name, XYZ, angles button.

6. [optional] To change file names with *.ori and *.csv extensions all at once set the
Synchronize file names checkbox. After that when one file name is changed, with
*.ori extension, for instance, file with *.csv extension will be renamed automatically.

7. [optional] To swap X and Y coordinates, set the Swap X Y checkbox.

If the Swap X Y checkbox is cleared, the data is exported in the right coordinate system.
Otherwise, in the left coordinate system.

8. Click OK. After that exterior orientation data is exported from thelist of exterior
orientation parameters to selected file.

7.8.3. Import orientation from metadata

Source project images (in TIF format or in system’s internal format MS-TIFF) might
contain metadata. The metadata may be contained in raster images acquired by Ul-
traCam camera, as well as in UAS images of EXIF format.

Metadata of digital maps – is data that allows to describe content, volume, position in space,
quality and other features of digital maps, as well as geodetic, gravimetric, photogrammetric
and cartographic data, which is used during creation (updating) and application of digital maps.

If images containing metadata are available in a project, it is possible to import from
the metadata to the project parameters of interior orientation (precise) and exterior ori-
entation (approximate, i.e. calculated by on-board devices). Metadata for project raster
images (file with *.md extension) are stored in the folder, which contains these images.
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Exterior orientation parameters imported from images metadata allow to split a project
on strips using imported exterior orientation, rotate images by block layout using imported
data, adjust block scheme by imported exterior orientation parameters, and proceed to
block processing step, that also includes stereo vectorization.

Prior to orientation data import from images metadata it is recommended to specify height dif-
ference of terrain in the project in the Project properties window (see the “Project creation”
User Manual).

To perform import of orientation data from images metadata perform the following ac-
tions:

1. ChooseOrientation › Import orientation frommetadata. The Import orientation
from metadata window opens.

Fig. 91. Import orientation from metadata

2. [optional] To perform images interior orientation to a project, the Import interior
orientation checkbox is set by default. Set the Replace existing data checkbox
to replace interior orientation data that already exists in the project.

If the project already contains file with name containing camera serial number, then it is
recommended to create backup of this file if the Replace existing data checkbox is set.

3. [optional] To perform images exterior orientation to a project, the Import exterior
orientation checkbox is set by default. Set the Replace existing data checkbox
to replace exterior orientation data that already exists in the project.

If the project already contains file with name containing camera serial number, then it is
recommended to create backup of this file if the Replace existing data checkbox is set.

To perform import of exterior orientation parameters it is necessary that a project is in co-
ordinate system consistent with WGS-84 coordinate system.

4. Click OK. After that the exterior and interior orientation parameters are imported
from images metadata to the project. At that a camera file with name containing
camera serial number is created for each project camera.
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After orientation import from images metadata it is recommended to specify once more
height difference of terrain in the Project properties window (see the “Project creation”
User Manual)

7.8.4. Export georeference data

The system provides possibility to perform export of source data to GIS without prelim-
inary processing in Mosaic to files with *.tab or *tfw extension. At that georeference
is performed using projection of image corners on specified plane (with no height spe-
cified).

To save georeference data file perform the following actions:

1. ChooseOrientation › Create images georeferencing files.... TheCreate images
georeferencing files window opens.

Fig. 92. Save of project images georeference data

2. In the Format section set one of the following formats:

• ArcInfo World File – for further export of saved file with *.tfw extension to
ArcInfo;

• MapInfo TAB – for further export of saved file with *.tab extension to MapInfo.

3. In the Source data section set a source of initial data:

• Adjustment results – adjusted (in third party software) projection centers co-
ordinates and exterior orientation parameters;

• Imported exterior orientation – exterior orientation parameters;

• Block layout – block layout results.
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4. [optional] If it is necessary to perform georeference by projecting images corners
on a plane with specified altitude, input altitude value in meters to the Project on
constant altitude input field.

5. In the Coordinate system section set a coordinate system that is used for images
georeference saving Coordinate system of the project or Latitude-longitude
WGS-84.

6. Click OK. After that the system displays information window which contains inform-
ation about saved images georeference data.

7. Click OK. After that georeferenced images are saved to active profile resources in
selected format.

7.8.5. Imported data accuracy control

In order to perform aerial triangulation in some cases it is necessary to perform import
of images exterior orientation parameters. After data import it is recommended to perform
imported data accuracy control using methods listed below.

Accuracy control of block layout creation by exterior orientation parameters

To reveal blunders occurred during block layout creation, it is recommended to visually
estimate the block scheme, created by exterior orientation parameters (see the Sec-
tion 3). At that it is necessary to keep in mind that beside errors occurred during data
import, errors of interior orientation step, as well as errors of defining of terrain height
difference are also influence on block layout creation.

If visual control of a block scheme using block layout is satisfactory, it is necessary to
perform accuracy control of measured GCP coordinates, and control of vertical parallax
residuals on tie points.

Accuracy control of measured GCP coordinates

To reveal errors in GCP coordinates, use one of the following ways:

First way:

1. Measure coordinates of 2-3 GC points on block images (see the Section 7.1).

2. ChooseOrientation › Direct georeferencing. After that the system displays inform-
ation window, which contains information about number of images adjusted using
exterior orientation parameters.

3. Choose Orientation › Block adjustment or click the button. The Adjustment
toolbar opens.

4. Estimate residuals vectors on GC points (see the Block adjustment User Manual).
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Second way:

1. Place marker on GC point in a block image in 2D-window.

2. Choose Orientation › GCP list or click the button of the main toolbar or the AT
additional toolbar. The Triangulation points window opens.

3. Compare GCP coordinates shown in the Triangulation pointswindowwith marker
coordinates displayed in status bar.

Control of vertical parallax residuals in stereomode

To reveal vertical parallax residuals on tie points:

1. Measure coordinates of 6-10 tie points on block images (see the Section 6).

2. Choose Orientation › Уравнять по exterior orientation parameters. After that
the system displays information window, which contains information about number
of images adjusted using exterior orientation parameters.

3. Choose Orientation › GCP list. The Triangulation points window opens.

4. Choose tie point and open images containing measurements of selected tie point
using the button. The Points measurement module is opened.

5. Choose the “left” and active image of stereopair and click the button of the main
module toolbar. Selected stereopair is opened in a stereo window (see the Sec-
tion 6.7).

6. Click the button of the stereo window toolbar.

7. Estimate value of vertical parallax calculated on tie points in stereomode, shown
in the top right corner of the stereo window.

In mono mode residuals control is performed using the and buttons of the main
toolbar of the Points measurement window.

7.9. Export of GCP catalogue

The system allows to perform export of GCP list from current project to file with *.csv
or *.txt extension.

To perform export of GCP list click the button on the GCP list tab of the Triangulation
points window. The Export GCP catalogue window opens. Specify a name of text file
and its placement out of active profile resources.

GC points are exported to text file with the following list of fields:
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NAME, X, Y, Z, CODE, TYPE, STDDEVX, STDDEVY, STDDEVZ, where:

• NAME – GC point name;

• X, Y, Z – coordinates values (the * symbol is used to mark absent coordinates values);

• CODE – a point’s code;

• TYPE – GC point type (control – GCP, check – check);

• STDDEVX, STDDEVY, STDDEVZ – RMS of GCP coordinates.

In the sample shown below the comma symbol is used as fields separator, and the full
stop is used as decimal point. The first row contains fields headers.

Fig. 93. Sample of GCP catalogue exported to text file

8. Editing of triangulation points

8.1. General information about triangulation points display

The system provides displaying of triangulation points in the following windows:

• in windows of opened images of the Points measurement module (see the Sec-
tion 8.2);

• on a block scheme or on a stereopair in 2D-window (see the Section 8.3);

• on a conventional scheme in the Delete point measurements window for pictorial
view of points to be deleted (see the Section 8.6).
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8.2. Points display in the “Points measurement” module

In order to display triangulation points on images, opened in the Points measurement
module, it is possible to use the following buttons of the left toolbar of the Points
measurement window:

• – allows to show/hide triangulation points;

• – allows to display triangulation points by symbols;

• – allows to show/hide triangulation points names;

• – allows to show/hide models by ties in a mode of triangulation points display by
symbols;

This mode allows to show in addition to tie point symbol “arrows”, indicting its connection
with adjacent images (left and/or right). For example, a triplet point symbol receives additional
right and left angle brackets.

Fig. 94. The left image shows triplet point, located in the center of triple overlap area, the
right one – triplet point from the right image

• – allows to show/hide GCP error vectors;

This function becomes available after block adjustment (see the “Block adjustment” User
Manual).

• – allows to show/hide tie error vectors;

This function becomes available after block adjustment (see the “Block adjustment” User
Manual).
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• – allows to apply/cancel a filter used to show triangulation points of certain types,
selected using the button;

The filtering is also applicable to points displaying in the points catalogue shown in the Trian-
gulation points window.

• – allows to select triangulation points types in order to apply a filter when displaying
them on images and in the points list of the Points measurement module (see
Section 8.5).

Fig. 95. The “Points measurement” module

8.3. Triangulation points display in 2D-window

To display triangulation points in 2D-window or on a block scheme or on a stereopair
perform the following actions:

1. Choose Orientation › Load triangulation points or click the button.

The Triangulation points layer appears in the Manager. Triangulation points are
shown in 2D-window and the Triangulation points – display options window
opens.
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Fig. 96. Settings of points display in 2D-window

2. Setup parameters and modes of triangulation points display in 2D-window. All
changes in window settings are automatically displaying in 2D-window.

In order to open the Triangulation points – display options after their loading once more,
chooseWindow › Triangulation points view control.

The Triangulation points – display options window allows to setup display of the
following triangulation points:

• Measurements – all triangulation points measured on block images;

• Source coordinates – only GC/check points with source coordinates, input to the
list of GCP coordinates (see the Section 7.1);

• Adjusted coordinates – all triangulation points with coordinates, acquired after ad-
justment (see the “Block adjustment” User Manual);

• Block scheme position – all triangulation points with averaged coordinates of block
scheme (the option is used in mode of block scheme without reference, for instance).

The Block scheme position points type is unavailable for display of triangulation points in
the stereopair window.

The ability to display a particular type of points depends on the current mode in 2D-
window. It is possible to select one of the following modes in upper part of the Triangu-
lation points – display options window:

• georeferenced block scheme – the system displays any types of points;

• block schemewithout georeference – the system displays only results of measure-
ments on block images and points positions in averaged coordinates;

• stereopair – the system displays only results of measurements on left and right im-
ages of a stereopair, as well as points positions in source and adjusted coordinates
of points, located in stereopair area.
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To setup symbols and filter usage for points display the system provides the following
buttons:

• – allows to choose symbols for triangulation points of different types;

• and – allow to apply (the first button) and setup (the second one) filter used to
display points of selected types only (see the Section 8.5).

The filter settings are not saved for next module sessions.

The system provides the following modes to setup display of each type of points position:

• – do not display points;

• – points are displayed as small squares, which size is specified by the Point size
parameter;

• – points are displayed using symbols, which are setup using the button.

In the stereopair mode “small arrows” are added in addition to the main symbol to indicate
connection with adjacent images.

Besides, for each points type the system allows the following modes of additional in-
formation display:

• – allows to hide/show points names;

• – allows to hide/show XY-coordinates;

• – allows to hide/show Z-coordinates (this mode is unavailable for the Measure-
ments and Block scheme position points display modes).

Moreover, the system allows to display error vectors between point measurements on
block images and position of this point in source, adjusted or averaged coordinates. To
do this, set the Error vectors checkbox.

Error vectors between measured and source point’s position are shown using crimson color,
between measured and adjusted point’s position – by blue color, between measured and aver-
aged point’s position – by yellow color.

The system provides possibility to save triangulation points as point vector objects in
vector layer, that can be used along with other base vector layers for TIN creation (see
the “DEM” User Manual).

To save triangulation points as vector layer perform the following actions:
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1. Choose Vectors › Create layer from triangulation points. The Load triangulation
points window opens.

Fig. 97. Saving triangulation points on vector layer

2. Choose one or multiple points types according to coordinates to save them to a
vector layer:

• Ground control point catalogue – to save triangulation points in source coordin-
ates;

• Block scheme – to save triangulation points in averaged coordinates;

• Adjustment results – to save triangulation points in adjusted coordinates.

3. Click OK. After that the system opens information windowwhich contains information
about number of points of each selected type, saved on a vector layer. The Trian-
gulation points (Vectors) appears in the Layer manager. Vector point objects – tri-
angulation points are displayed in 2D-window on a block scheme or stereopair.

8.4. Symbols of triangulation points

To setup symbols for triangulation points the Symbols window is used. It could be
opened using one of the following ways:

• the button of the upper toolbar of the Points measurementmodule used to setup
points display on opened images (see the Section 5);

• the button of the Triangulation points – display optionswindow toolbar to setup
points display on a block scheme/on stereopair in 2D-window (see the Section 8.3);

• the Symbols button of the Delete point measurements window used to configure
display of points selected for deletion on graphical scheme (see the Section 8.6).

No matter at what stage and in which system module the symbols are configured, the symbols
settings are stored and are valid for the entire system until the next their change.
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Fig. 98. Setup of points symbols

The window contains the list of all triangulation points. In the left column the symbols
selected (or configured by default) for each point type are displayed. There is also
possibility to change symbol shape and color for tie points (both in-strip and inter-strip).

To change a symbol perform the following actions:

1. In the By ties list select a point type which symbol needed to be changed.

2. Select Symbol option to define a point’s shape – circle , rhombus or square
.

3. Click the Color field and select necessary color from standard Windows color
palette.

4. [optional] To go back to symbols configured by default, click the Cancel button
while holding the Alt key.

5. Click OK to confirm changes.

8.5. Points filter

Points filter is intended for displaying of triangulation points of selected types. For ex-
ample, it is possible to show only triplet tie points or just GCP and check points.
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For points filtering there are two buttons of the left toolbar of the Points measurement
module:

• – for filter setup – choosing points types to be shown;

• – to apply/cancel a filter.

Triangulation points filtering is available for images opened in the Points measurement
module (see the Section 8.2) and for a block scheme or stereopair in 2D-window (see
the Section 8.3).

It is also possible to apply filter to the points list in the Triangulation points window.

It is possible to use special symbols to display points in the system (see the Section 8.4).

For points filtering setup perform the following actions:

1. Click the button. The Point filter window opens.

Fig. 99. Selecting points to be displayed

2. In the following sections choose points types to be shown:

• the By coordinates section allows to select points to be displayed depending
on their coordinates:

○ ground control – GC points (ground and projection centers);

○ check – check points (ground and projection centers);

○ excluded – points with known coordinates, excluded from adjustment;

○ XYZ points – points with known coordinates (X, Y, Z);
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○ XY points – points with known coordinates (X, Y);

○ Z points – points with known coordinates (Z);

○ No coordinates – points with unknown coordinates (ties and projection centers,
if their coordinates are not available);

○ All – allows to select/unselect all points mentioned in the section.

• the By ties section allows to select points to be displayed depending on number
of their coordinates measurements on images:

○ Single – points which are not measured on any stereopair;

○ Stereopair – points measured on one stereopair, at least;

○ Triplet – points measured on one triplet, at least;

○ Strip tie – points measured in inter-strip overlap area;

○ Non-transferred – tie points, which are not measured on adjacent images;

○ Used – tie points used as ties during adjustment;

○ Excluded – tie points excluded from adjustment;

○ All – allows to select/unselect all points mentioned in the section.

• the Auxiliary section allows to select points to be displayed depending on their
type:

○ Geodetic – tie points which are not targeted and projection centers;

○ Targeted – targeted points;

○ Projection centers – projection centers;

○ With changed type – points which type was changed during adjustment.

• theBy residual value section allows to select points depending on residual value
on the point:

TheBy residual value section is available on block adjustment step only (see the “Block
adjustment” User Manual).

○ Worst points – points with maximal residuals (number of points to be displayed
is specified in the appropriate field);
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○ Over acceptable residuals – points with residuals, exceeding threshold. Points
selection by residuals value is performed using additional parametersGround
XY, Ground Z, Tie XY, Tie Z.

Residual thresholds are specified on block adjustment step (see the “Block adjustment”
User Manual).

• In selected models – used to select points located in selection area of stereo-
pair/strip or multiple steropairs/strips:

○ At least one – points measured on one selection area;

○ All – points measured on all selection areas simultaneously.

3. Click OK.

4. Click the button to apply the filter.

8.6. Triangulation points deletion

For points deletion the system provides the following possibilities:

• tools in the Pointsmeasurementmodule (see the Section 5.2) and in the triangulation
points catalogue;

• menu item Orientation › Clear point catalogue is used for deleting all points with
measurement results at once (GCP, check and tie);

• menu item Orientation › Delete point measurements for selective deleting of trian-
gulation points.

Selective points deleting allows to delete points of selected types from project images
marked in the list.

For selective points deleting perform the following actions:

1. Choose Orientation › Delete point measurements or click the button of the
AT panel toolbar of on the main toolbar of the Points measurement module. The
Delete points measurements window opens.
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Fig. 100. Choosing of points types to be deleted

2. In the Selected images with point measurements section select project images
with measured points coordinates, that should be deleted. The section contains list
of project image and the toolbar used for images selection.

For selective points deleting it is necessary to choose at least one image. An exception is
the removal of All without measurements on images points type, i.e. GC points located
on none images of the block. It is possible to obtain such points, for example, after triangu-
lation points import or after deleting images from the block.

3. Set checkboxes next to point types to be deleted as well as deletion modes in the
Select points and Delete mode sections accordingly.

The section contains a list and graphical scheme of point types. The list of point
types and the scheme are synchronized, i.e. points of type selected in the list are
automatically marked (by check mark) on the graphical scheme. And vice versa,
selected point types on the graphical scheme leads to automatic selecting of cor-
responding checkboxes in the point types list.

To select multiple point types on a scheme use the Shift key.

The Symbols button allows to change points symbols on the scheme.
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The system provides the following tools to manage image zoom and BCG paramet-
ers on the scheme:

• «*» – allows to zoom in the image;

• «/» – allows to zoom out the image;

• Alt – allows to turn on panning mode;

• Shift+F8 – allows to setup brightness, contrast and gamma.

For selective points deletion it is necessary to select at least one type of triangulation points
in each of three subsections: By measurement type, By coordinate type and By meas-
urement mode.

In the Select points section select triangulation point types to be deleted from the
following list:

• By measurement type:

○ All – all points of all measurement types on selected images according to co-
ordinates type, measurements method and deletion mode.

Points type is determined by the whole block, rather than by selected images.

○ Strip points:

■ ties on selected images – in-strip tie points on selected images, i.e. points
that contain two or more coordinates measurements on images selected in-
side a strip;

■ isolated – points with a single measurement on selected images;

■ on stereopairs – stereopair tie points, including those that have non-adjacent
measurement in strip;

■ on triplets – all measurements of triplet points, including measurements on
non-adjacent images inside a strip;

■ with non-adjacent measurements – in-strip tie points, with one at least
non-adjacent measurement.

○ Interstrip points:

■ All interstrip ties – all interstrip tie points, if at least one coordinates
measurement of each point falls into selected images;

181

Aerial triangulationPHOTOMOD 6.0.2



■ Interstrip ties for selected strips – interstrip tie points, if all coordinates
measurement of each point falls into selected images (strictly inside the im-
age);

■ Ties on selected images – interstrip tie points, that have two or more
measurements on selected images;

■ With non-adjacent and isolated measurements – interstrip tie points,
without stereopair measurements;

■ On stereopair – interstrip tie points, that havemeasurements on a stereopair,
but without triplet, isolated or non-adjacent measurements;

■ On triplet – interstrip tie points, that have measurements on a triplet, but
without isolated or non-adjacent measurements;

■ On stereopair, isolated, non-adjacent – interstrip tie points, that have
stereopair and isolated measurements; interstrip tie points, that have stereo-
pair and non-adjacent measurements.

○ Additionally:

■ Excluded as tie – all tie points on selected images, excluded by tie in the
Triangulation points window.

• Also:

○ All without measurements on images – coordinates measurements of GC
points, located on none of block images of the project (for example, measure-
ments left after deletion images from the block).

• By coordinate type:

○ Tie;

○ Ground control;

○ Check;

○ Excluded as control.

• By measurement mode:

○ Manual – to delete manually measured points;

○ Automatical – to delete automatically measured tie points.

In the Delete mode section select points deletion mode:
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• Delete measurements of selected points:

○ All – to delete all measurements of selected points, if at least onemeasurement
of selected point coordinates is located on selected images;

In this case all measurements of selected points coordinates will be marked
by red color on the graphic scheme.

○ On selected images – to delete measurements of selected points only on
selected images;

If tie point have only one measurement (out of selected images), it will be also deleted.
Such single measurements are marked by yellow cross on the graphic scheme.

○ only non-adjacent and isolated – to delete measurements of selected points
on non-adjacent images, as well as isolated measurements, including inter-
strip ones, that have no “ties” inside strip.

• Delete measurements for points with coordinates:

○ measurements only – used to delete only coordinates measurements of se-
lected points;

○ points completely – used to delete selected points completely along with their
measurements and records shown in the catalogue of the Triangulation points
window (for GCP, check, excluded GC points).

4. Click OK. The system shows warning with request for deletion, and with information
about number of points to be deleted. Click the Yes button to delete selected points,
and the No button to go back to the Delete points measurements window or the
Cancel button, to close the window and cancel points deleting. After operation
completion the system shows detailed information about deleted points.

9. Data import and export

9.1. Import of triangulation points

9.1.1. Import of triangulation points from PAT-B

The system provides possibility to import GCP and tie point coordinates from files of
PAT-B format.

Perform the following actions to import measurements:

1. Choose Orientation › Import › Import tie points from PAT-B... or click the arrow
to the right from the button of the Triangulation points window toolbar and
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choose Import from PAT-B. The Import measurements from PAT-B window
opens.

Fig. 101. Import measurements from PAT-B

2. Set the File with point coordinates checkbox to import geodetic coordinates. Click
the button to select file to be imported with *.xyz, *.txt, *.csv extension (see
format description in Section 9.5.2).

If there is a coordinate system different from source one (left/right), set the Swap X Y
checkbox to swap X and Y coordinates.

If the Swap X Y checkbox is cleared, GC and tie points coordinates are imported in the
right coordinate system. Otherwise, in the left one.

3. Set the File with measurements checkbox to import point coordinates measure-
ments. Click the button to select a file with *.mea, *.txt, *.csv extension (see
format description in Section 9.5.3). Specify measurement units of points coordin-
ates, that used in image coordinate system – pix,mm ormcm. If the measurements
consider distortion correction and principal point shift, set the Refined camera co-
ordinates checkbox.

4. [optional] In order to select file, which contains images names (numbers) from se-
lected files with geodetic coordinates and point coordinates measurements set the
File with list of correspondent PAT-B and PHOTOMOD image names checkbox
and click the button.

A filename of images names correspondence should be set in the form of
Name_in_PAT_B,Name_in_PHOTOMOD. At that both comma and space could be used
as a delimiter between PAT-B and PHOTOMOD names, but space between images names
should not be used.
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Fig. 102. Example of file of images names correspondence

5. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

6. Click OK. Imported points are added to triangulation points list.

9.1.2. Import of triangulation points from X-Points

The system provides possibility of import of tie and GC points coordinates from X-Points
files.

To perform measurements import perform the following actions:

1. Choose Orientation › Import › Import tie points from X-Points... click the drop-
down arrow next to the button of the Triangulation points window toolbar and
select Import from X-Points.... The Input file window opens.

2. Choose triangulation points file *.x-points and click the Open button. The Import
measurements from X-Points format window opens.

Fig. 103. Import measurements from X-Points format

3. When using points import from another project specify the way of matching images
names in the X-Points file and images names in the project:

• By name;
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• By code;

• Use correspondence file.

In order to use correspondence file click the button and select file with filenames.

4. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

5. Click OK. Imported points are added to triangulation points list.

9.1.3. Import of triangulation points from PHOTOMOD 4.x XPT

The system provides possibility of import triangulation points catalogue from projects,
created in earlier versions the system like PHOTOMOD 4.x.

To perform import of triangulation points catalogue perform the following actions:

1. Choose Orientation › Import › Import tie points from PHOTOMOD 4.x XPT... or
click the drop-down arrow next to the button of the Triangulation pointswindow
toolbar and choose Import from PHOTOMOD 4.x XPT.... The Input file window
opens.

2. Choose triangulation points file *.xpt and click the Open button. The Import
measurements from XPT format window opens.

Fig. 104. Import measurements from XPT

Choose points file and click OK. Imported points will be added to triangulation points
list.

3. Specify the way of matching images names in the *.xpt file and images names in
the project:

• By name;

• By code;
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• Use correspondence file.

In order to use correspondence file click the button and select file with filenames.

4. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

5. Click OK. Imported points are added to triangulation points list.

9.2. Import flight line file

The system provides possibility to import of flight line data (latitude, longitude, heading,
roll, pitch). The main condition of such a file import is availability of survey time data,
acquired, for example, during import of exterior orientation parameters from metadata
or during data load from GPS-receiver.

During import of flight line file the systemmatches the data using survey time, rather than images
numbers.

To import flight line data it is necessary that format of time in the file of project exterior orientation
is corresponding to time format in the flight line file.

To import flight line data perform the following actions:

1. ChooseOrientation › Import › Import flight line.... The Import flight line window
opens.
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Fig. 105. Import flight line data

2. In the Flight line file section click the button to perform loading of flight line
file with *.csv extension.

3. [optional] To configure a template of imported file set the Show CSV parameters
checkbox.

4. The Line template field displays the list of fields, contained in each line of imported
file:

• T – precise time from GPS-receiver;

• Lat – flight latitude;

• Lon – flight longitude;

• Alt – flight altitude;

• Heading – flight heading;

• Roll – roll;

• Pitch – pitch.
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The “*” symbol indicates columns with data that will be not imported.

In order to setup active template, perform one of the following actions:

• drag by mouse field name from the Available fields list to the column of the
Preview file table. After that the template in the Line template field is changes.
In order to cancel field selection, double click the column of the Preview file
table;

• change the template manually in the Line template field. At that column types
in the Preview file table are changed automatically.

The button allows to use the default template T Lat Lon Alt Heading Roll
Pitch.

The button is used to compare the Line template field with data shown in the
Preview file table.

The active template corresponds only to lines shown in the Preview file table.

The button is used to replace specified field names by field values taken from
the first line of the Line template table.

5. [optional] The Automatically validate template checkbox is set by default that al-
lows to select current template automatically. In order to configure the template for
file containing lines with different columns number, clear theAutomatically validate
template checkbox and configure the template in the Line template field manually.

6. [optional] To specify a line from to start data import, define the value of the Start
import from line parameter.

7. [optional] To display necessary number of lines in the Preview file table, set the
Preview maximum parameter. Default number of lines is 10.

8. In the Available fields section select necessary field name and drag it to the table
column. To cancel the field name double click the column header.

9. In the Field separators section set one or multiple checkboxes to specify possible
fields delimiter symbol: Comma, Space, Tab, Semicolon or Other delimiters. De-
fault settings are comma and space.

10. In the Decimal separator section setup the following parameters:

• Point only – to use point only as a decimal separator in coordinates;
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• Point or comma – to use both point and comma as a decimal separator in co-
ordinates.

If comma is used as Field separator, it is not recommended to use comma as Decimal
separator, since it may cause import of incorrect data.

11. [optional] In the Misc section set the checkbox:

• UTF-8 – is used to recognize text in Unicode encoding;

Unicode – symbols encoding format that allows to provide symbols of almost all written
languages.

• Parse ° ’ “ – is used to recognize records of projection centers or GCP.

When using this parameter it is highly recommended to check points coordinates recognition
correctness after import. To do this select any point in 2D-window and check coordinates
values in the Marker window (see the Vectorization User Manual).

12. [optional] To make corrections to camera angles configure them in the Adjust
angles table of the Settings section.

13. Click the Load button to import flight line data. At that the Import flight linewindow
stays open.

14. Choose Window › Block layout or click the button of the main toolbar. The
Block layout window opens.

To create correct block layout it is necessary to have data about terrain altitudes difference
available. This value is setup in the project properties window (see the Project creation
User Manual) or during import of exterior orientation parameters (see the Section 7.8).

Fig. 106. Parameters of block layout creation
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15. In the Mode section set the By ext. or. option.

16. Click the Apply button to create block layout.

17. [optional] To input time correction for selected images set them up in the Adjust
time for selected images input field and use the and buttons to tune selected
images along flight line by time.

9.3. Export of triangulation points

9.3.1. Export of triangulation points to PAT-B

The system provides possibility to export triangulation points from current project to a
file of PAT-B format.

If a project contains points with name in text format (the Name column contain letters), select
these points and click the button of the Triangulation points window toolbox. After that nu-
meric names will be assigned to selected points.

To export coordinates measurements of triangulation points to PAT-B format perform
the following actions:

1. Choose Orientation › Export › Export tie points to PAT-B... or click the drop-
down arrow next to the button of the Triangulation points window toolbar and
select Export to PAT-B. The Export measurements to PAT-B window opens.

Fig. 107. Export measurements to PAT-B

2. Set the File with point coordinates checkbox to export coordinates of measured
GCP to file with *.xyz extension and click the button, specify filename and its
location out of active profile resources (see also the description of the file format
which contains geodetic coordinates in Section 9.5.2).

If there is a coordinate system different from source one (left/right), set the Swap X Y
checkbox to swap X and Y coordinates.
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If the Swap X Y checkbox is cleared, GC and tie points coordinates are exported in the
right coordinate system. Otherwise, in the left one.

3. Set the File with measurements checkbox to export coordinates measurements
of all triangulation points to file with *.mea extension and click the button. Then
specify filename and its location out of active profile resources (by default, the
system suggests location at the same folder with file of geodetic coordinates). A
description of the file format see in the Section 9.5.3. Specify measurement units
for point coordinates measurements, that are used in images coordinate system
and select pix, mm or mcm. If the measurements consider distortion correction
and principal point shift, set the Refined camera coordinates checkbox.

4. [optional] To change file names with *.xyz and *.mea extensions all at once set the
Synchronize file names checkbox. After that when one file name is changed, an-
other file name will automatically receive the same name.

5. [optional] In order to export just selected points from the Triangulation points
window, set the Export selected points only checkbox.

6. Click OK to complete the export operation.

9.3.2. Export of triangulation points to X-Points

The system provides possibility to export triangulation points from current project to a
file of X-Points format. It is possible to export all or just selected points from triangulation
points catalogue, including points with unknown coordinates.

To export all triangulation points of the current project perform the following actions:

1. Choose Orientation › Export › Export tie points to X- Points.... The Export
measurements to X- Points format window opens.

2. Click the button, specify filename and its location out of active profile resources.

3. Click OK to export triangulation points to specified file.

To export only selected triangulation points perform the following actions:

1. Click the button of the main system toolbar. The Triangulation points window
opens on the All triangulation points tab. There is a list of all triangulation points
of a current project.

2. Select triangulation points in catalogue, using the Shift key to select multiple points
at once or the Ctrl key to add multiple points to already selected ones.
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3. Click the drop-down arrow next to the button of the Triangulation pointswindow
toolbar and select Export to X-Points.... The Export measurements to X- Points
format window opens.

Fig. 108. Export selected triangulation points to X-Points file format

4. Click the button, specify filename and its location out of active profile resources.

5. Set the Export selected points only checkbox if it is not set automatically.

6. Click OK to perform export of selected points.

9.3.3. Export of triangulation points to CSV

The system provides possibility of triangulation points export from the current project
to a file with *.csv or *.txt extension.

To export triangulation points of current project perform the following actions:

1. Click the drop-down arrow next to the button of the Triangulation pointswindow
toolbar and select Save active view as CSV.... The Save window opens.

2. Define a filename and its location out of active profile resources.

3. Click Save to export triangulation points to specified file.

9.4. Export points to Geomosaic

9.4.1. Export of project tie points to Geomosaic

The system provides possibility of quick export of project triangulation points toGeoMo-
saic and to use them as tie points there.
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To export coordinates measurements of project triangulation points to GeoMosaic,
perform the following actions:

1. Choose Orientation › Export › Load triangulation points as GeoMosaic tie
points. The Load triangulation points window opens.

Fig. 109. Load triangulation points as Geomosaic tie points

2. [optional] To export triangulation points from GCP list (see the Section 6.2) the
Ground control point catalogue checkbox is set by default.

3. [optional] To export triangulation points from the Block scheme layer in 2D-window,
the Block scheme checkbox is set by default.

4. [optional] To export adjusted points coordinates fromGCP catalogue theAdjustment
results checkbox is set by default.

5. Click OK. The system displays information window containing information about
added or skipped points.

6. Click OK. The Triangulation points (Vectors) layer is created. Vector point objects
(triangulation points) are displayed on block scheme in 2D-window. When creating
a project in GeoMosaic using project images there is a possibility to use the Trian-
gulation points (Vectors) layer as tie points.

9.4.2. Export of project GC points to Geomosaic

The system provides possibility of quick export of project triangulation points toGeoMo-
saic and to use them as GC points there.

To export coordinates measurements of project triangulation points to GeoMosaic,
perform the following actions:

1. Choose Orientation › Export › Load triangulation points as GeoMosaic GCPs.
The Create GCP layer for GeoMosaic window opens.
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Fig. 110. Load triangulation points as Geomosaic GC points

2. Input points step to perform averaging Average with step 1/... of image size.

3. Click OK. The Triangulation points (Vectors) layer is created. In 2D-window averaged
grid of deformations is created by triangulation points on each image. When creating
a project in GeoMosaic using project images there is a possibility to use the Trian-
gulation points (Vectors) layer as GC points.

9.5. Supported formats for import and export

9.5.1. Format of PAT-B file

File with exterior orientation parameters of images in PAT-B format contains adjusted
coordinates of projection centers and matrices of exterior orientation rotation angles.

The first line of PAT-B format file has the following structure:

Image number, 0.0, X, Y, Z, where:

X, Y, Z – coordinates of projection centers.

Then there are two lines containing 9 values of matrices elements of exterior orientation
rotation angles, as follows:

a11, a21, a31, a12, a22

a32, a13, a23, a33

The matrix elements are calculated using the following formulas:

a11 = cos( ϕ ) cos( κ );

a21 = cos( κ ) sin( ϕ ) sin( ω ) + cos( ω ) sin( κ );

a31 = − cos( κ ) sin( ϕ ) cos( ω ) + sin( ϕ ) sin( κ );

a12 = − sin( κ ) cos( ϕ );
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a22 = cos( κ ) cos( ω ) − sin( ω ) + sin( ϕ ) sin( κ );

a32 = sin( ϕ ) cos( κ ) + cos( ω ) + sin( ϕ ) sin( κ );

a13 = sin( ϕ );

a23 = − sin( ω ) cos( ω );

a33 = cos( ω ) cos( ϕ );

Fig. 111. Sample of PAT-B file

9.5.2. Format of file containing points geodetic coordinates

File with *.xyz, *.txt or *.csv extension, containing points geodetic coordinates is a
table.

Each line of *.xyz, *.txt, *.csv file:

GCP number, X, Y, Z, where:

X, Y, Z – GC point coordinates.
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Fields delimiter is space or multiple spaces.

Fig. 112. Sample of file with adjusted geodetic coordinates of points

9.5.3. Format of file containing measurements of points coordinates
on images

File with *.mea, *.txt or *.csv extension, containingmeasurements of points coordinates
on images is a table. The table includes sections of the same format, each of them
corresponds to individual image of a block.

The first line of each section has the following structure:

Image number, image focal length, 0

The second and successive lines contain a table of points:

Point number (name), X, Y, where:

X, Y – points coordinates relative to image principal point (in mm or mcm).

In some cases the file contains point coordinates relative to reference point of camera coordinate
system (in mm, mcm or pixels).
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Fields delimiter is space or multiple spaces.

The end of each section is marked by a line with -99 number.

Fig. 113. Sample of file with measurements of points coordinates on images

10. Number of points recommended for adjustment of scanner
block
There are some recommendations about number of GCP and check points used for
different methods adjustment of images included to scanner mono/stereoblocks.

For space scanner images it is possible to use only XYZ GCP (with X, Y, Z coordinates).
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Fig. 114. Number of points recommended for adjustment of scanner block by rigorous method

If a monoblock contains images with triple or quadruple overlap area, it is recommended to
measure several points in this area.

Number of GCP could be decreased due to tie points measured in triple or quadruple overlap.
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Fig. 115. Number of points recommended for adjustment of scanner block by RPC method

Number of GCP could be decreased due to tie points measured in quadruple overlap.
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Fig. 116. Number of points recommended for adjustment of scanner block by generic method

Recommended number of check points on images is not absolute and in many cases is determ-
ined by the customer requirements to specific project. Nevertheless, it is necessary to have
check points available for objective estimation of adjustment accuracy.
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